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Preface a

The last 10 years have seen a radical change in the way that music and
sound are recorded. A decade ago, the world of high-fidelity multi-
track recording and sync-to-picture belonged solely to record compa-
nies, post houses and commercial ventures. Independents were
considered extremely lucky to have access to a low-quality four-track.

For the individual, the process of taking a project from concept to
completion was extremely arduous. It required many redundant steps
and cost quite a bit of money. An idea began as a poor-quality
‘scratch’ version, and was eventually re-recorded on better equipment
in a studio that charged by the hour. After all the time and expense,
the ‘energy” of the original idea was often lost in the re-recording
process, while control of the project fell to the outside sources respon-
sible for funding it. It was nearly impossible to produce an indepen-
dent product that matched the quality of high-budget productions.

In 1988, Digidesign's Sound Tools system finally broke this barrier by
offering a CD-quality digital stereo recording environment that could
capture any audio signal at extremely high fidelity. But this still didn’t
solve every problem. Using a Macintosh, musicians and sound
designers could now record mono or stereo digital masters, but it was
still impossible to record one track while listening to another, and
there was no way to play back MIDI sequences simultaneously with
audio.

In 1990 OSC released DECK to fill this void. DECK was the first
Macintosh software that allowed true four-track recording and simul-
taneous MIDI file playback, and that year it won the MacUser Eddy
award for Best Music Product. DECK's simple interface was based on
the integrated 'portable studio' metaphor, and required no knowledge
of MIDL It looked and functioned like a four track cassette mixer/
recorder, but it turned any Macintosh with a Digidesign NuBus™ card
into a CD-quality production environment. Version 1.0x of DECK has
been used extensively over the last few years to produce albums and
CDs, and for basic commercial sync work.
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Since DECK's original release, OSC spent extensive time designing the
next generation of digital workstation software for Digidesign. Re-
leased in 1993, DECK Il represented the culmination of this work and
it again won the MacUser Eddy for Best New Music and Sound
Product.

DECK Il offers a host of features that original DECK lacked, and it
really represents the least expensive full-function workstation technol-
ogy available. Here are just a few of the functions that differentiate
DECK II from original DECK:

* Non-destructive multitrack visual waveform editing with track
and region slip

Unlimited virtual tracks

True SMPTE resynchronization

Playback of multitrack audio in the background

Synchronized QuickTime™ video-from-disk in a window

24-bit moving fader automation with visual editing

Support of simultaneous MIDI file playback from compatible MIDI
sequencers running on the sante Macintosh

OSC has continued to improve DECK II. The release of version 2.1 of
DECK II includes the following powerful new features:

* Support of Macintosh 840 AV (8 tracks) and 660 AV (6 tracks), and
the Spectral Innovations NuMedia card

¢ Eight-track upgrades available for Pro Tools and supported
hardware

e MIDI file playback from within DECK II

* Virtual Track mixing

* Region Library window for tracking source material

DECK Il uses a variety of hardware systems that turn a Macintosh
computer into a true multitrack digital audio workstation. DECK II
offers a host of high-end synchronization, editing, mixing and audio
processing functions previously available only on extremely expensive
professional systems. And DECK Il drives full-featured MIDI se-
quencers (like OSC's METRO sequencer) in the background keeping
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them synchronized to any audio tracks you might record or create.
And perhaps best of all, the audio quality of all DECK tracks and d
processing matches the fidelity of a compact disc.

This is what DECK Il means to the individual: You can record your

basic ideas digitally from the very beginning. Then, over time, add

and edit digital audio and MIDI tracks to your composition and

synchronize your elements to video decks or QuickTime video. You

can then use DECK II to create a fully digital stereo audio master. If

you wish, transfer that master digitally to a digital audio tape (DAT),

and press your CDs digitally, directly from the DAT master. Or you

can print your stereo master directly to timecoded DAT or center track

for delivery. Finally, every step in multitrack production of digital

audio is in the hands of the individual.

Who uses DECK 11?7

DECK 11is intended for a variety of users. Musicians can use it as a
composition environment, and produce CDs or CD-quality demos
from the original tracks. Video post production sound designers can
use it for typical audio sweetening and layback tasks. Multimedia
producers can use it as a self-contained QuickTime post production
environment. MIDI studios can use it to record final audio tracks over
existing MIDI tracks. Anyone with an interest in audio and a capable
Mac system can benefit from DECK II.

To use DECK II, you will need hardware that supports 16-bit audio
recording and playback. You can use a Macintosh AV machine right
out of the box. You will need to plug in stereo miniplugs (1/8") into
the input and output jacks on the back of your computer. You can also
use Digidesign’s Audiomedia or Audiomedia II card, Sound Tools II
system, or Pro Tools system. You install the Digidesign cards in one of
your Macintosh's slots. The Audiomedia cards have standard RCA-
type audio input and output jacks on the back. You plug monophonic
inputs into the input jacks, and amplified speakers or headphones into
the output jacks. You can plug a high-impedance microphone directly
into the Audiomedia’s mic jack. The Audiomedia II has no mic jack,
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but offers digital input/output connections in SPDIF format. The
Sound Accelerator II card connects to an external Audio Interface box.
The Audio Interface box has standard balanced +4 XLR audio input
and output jacks on its back. You plug monophonic inputs into the
input jacks, and monophonic outputs or amplified speakers into the
output jack. The Sound Tools II and Pro Tools systems have better
signal-to-noise ratios, which means that their audio fidelity exceeds
that of the Audiomedia cards’. You may also use the Spectral Innova-
tions NuMedia card or RasterOps MediaTime card. The NuMedia
card has a high-impedance mic jack, stereo miniplug line in/output as
well as digital in/output in optical format. The MediaTime card has
standard RCA-type audio input and output jacks on a break-out box
which plugs into the card on the back of your computer.

Hardware Requirements
In order to install and use DECK II, you will need:
1) A Macintosh 840AV or 660 AV.

Or, if you do not have an 840AV or 660AV:

a) A Macintosh IIx, cx, ci, vx, LC II, LCIII, Quadra, Performa 400/
600 or Centris 650 running System 7.1 or higher and QuickTime 1.5
or higher.

If you wish to run DECK II on a Ilfx, you will need to obtain
Apple’s Ilfx Serial Switch CDEV. The serial switch CDEV is a
control panel device document that goes in your System folder. It
allows you to set your IIfx to run in “faster” mode or in “compat-
ibility” mode. DECK II requires that your IIfx be set to “compat-
ibility” mode. Unfortunately, Apple ships all IIfx machines set to
“faster” mode, and does not include the switch CDEV as a part of
the System software. Contact Apple or Digidesign for more
information.
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AND: a

b) Digidesign’s Audiomedia, Audiomedia II, or Sound Tools II or
Pro Tools system or RasterOps' MediaTime system or Spectral
Innovations' NuMedia system.

2) Four megabytes of RAM allocated to the program. More is recom-
mended.

3) Ahard disk with an average access time of 27ms or better, and a
throughput comparable to the drives covered in the Appendix. A
large hard disk is recommended, since audio and QuickTime video
require quite a bit of disk space.

Individual manufacturers are not always the best source for speed
information about their drives. Digidesign has encountered many
instances where actual hard drive access and throughput varied
considerably from the manufacturers specification sheet. To be
sure that you are getting a capable hard drive, see About Hard
Disks in the appendix of this manual.

To record and play back tracks you will also need:

1) ToRecord: A line-level sound source (mixing board, electronic
instrument, CD player, turntable, cassette player, etc.).

2) ToPlay Back: A stereo amplifier and speakers or powered
speakers.

0SC’s Update and Support Policy

As a new DECK II owner, the first action you should take is to send in
your registration card. You must be a registered owner if you want to
receive telephone support, program updates, or new product informa-
tion.
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Once you are a registered owner, program updates will be made
available to you free, or for a minimal charge (depending on the nature
of the update).

OSC is serious about customer support , and is strongly committed to
a continuing relationship with you after your purchase.

Please feel free to contact OSC directly with any questions or prob-
lems. A DECK II consultant will be standing by to help you during
business hours (Monday to Friday, 8:00AM fo 4:00PM PST). For DECK
II customer service, call (617) 969-0754 or FAX (617) 928-0038. Remem-
ber to have your DECK II master disk handy when you call or FAX.

You may also contact us through CompuServe. You will find us in the
MIDI Vendors C forum (Type "GO MIDIL.")

OSC is made up of people who are very interested in audio, sound
design, and the recording process as a whole. Become one of our
registered owners and participate in the creative process.

Eight-Track Tool Owners

If you have purchased the Eight-Track Tool from OSC for use with
your supported hardware (ProTools Systems), be sure to install it
according to instructions. Whenever you read "four active playback
tracks” in this manual, remember that you have eight active playback
tracks.

How to Use This Manual

This DECK Il manual has been designed to give you basic background,
operational information, production ideas, and a reference source for
using DECK II.

If your immediate interest is getting a better picture of what DECK II
does, install the hardware and software as described in Chapter 2, and
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skip right to the ‘Using’ chapters of the manual (Chapters 4, 5, 6 and 7).

These chapters give you step-by-step directions for accomplishing all

of the different DECK II recording, editing, MIDI, synchronization,

and mixing functions. q

DECK Il is an advanced multitrack digital recording and editing
system that is really very easy to use. Because recording and wave-
form editing are at the base of most DECK II functions, it will be very
helpful if you understand the basic principles of recording and sound
waves before you start. If you are not experienced in digital recording
and waveform editing, make sure to read through the recording and
mixing information in Chapter 3.

Important: Watch for notes in the margin throughout this manual. You will find
that they usually contain additional information and important hints.

This DECK II manual is divided into ten chapters (including Appendix
and Index). Here are short explanations of what you'll find in the each
of the chapters:

Chapter 2: Getting Started

Chapter 2 contains all of the information you will need to install the
DECK I software. It also explains how to configure your software and
set up the audio inputs and outputs so you can record multiple tracks,
and hear them play back.

Chapter 3: Digital Recording, Editing and Mixing Basics

Chapter 3 offers the basic background information you will need to
understand what DECK Il is doing, and how you can get the most out
of digital multitracking. It explains in rudimentary fashion how sound
is recorded, what a waveform is, how the digital mixing board works,
and what fader automation means. The chapter is intended for people
who have no digital recording experience and little computer experi-
ence, but who have an interest in recording, editing and mixing
concepts.

Chapter 4: Creating and Recording Sessions

This chapter offers in-depth explanations of every process you will use
to create a new Session, record tracks, punch in new tracks and save
your work. Use this chapter to learn about starting a project with
DECK IL.
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Chapter 5: Visual Waveform Editing - The Track Window

This is perhaps the most important chapter in the manual. It offers in-
depth explanations of every process you will use to create and edit
waveform regions, slip tracks, spot regions to picture, create and edit
visual automation envelopes, and much more. Whenever you need to
know how to accomplish a visual editing tack in the Track window,
consult Chapter 5.

Chapter 6: Using MIDI

Chapter 6 focuses on all MIDI functions, from setup to synchroniza-
tion. Consult this chapter if you plan to synchronize to SMPTE
timecode, import a MIDI file, or use DECK in conjunction with the
METRO sequencer.

Chapter 7: Sychronizing, Mixing and Mastering

Chapter 6 focuses on the specific setup you will need to do sync work,
and on the final tasks in most audio recording processes: Mixing and
mastering. All aspects associated with real-time fader automation
recording, audio bouncing and submixing, virtual mixing, and creat-
ing of a final mono or stereo master file are discussed at length.

Chapter 8: DECK II Reference

This chapter contains specific reference information about the DECK II
windows, controls, indicators, and menu commands. You will use it
when you are trying to figure out what a particular control or function
does, and how it works. The chapter begins with a simple explanation
of the DECK II Mixer, Track windows, Transport and QuickTime
windows, and continues on to detailed information about each DECK
I command and function.

Appendix

The Appendix contains tips for fine-tuning your system, a list of
recommended hard disks, and a list of suggested reading.
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Installing and Configuring the Hardware and Software

Before you can begin using DECK II, you will need to configure your
hardware and the DECK II software on your computer. The hardware
consists of the internal DSP chip if you own a Macintosh AV or a single
card that fits into any slot in your Mac, along with an external interface
box (if you have Sound Tools II or Pro Tools). The software consists of
the protected DECK II application. Since the software relies on the
hardware, its best to install the hardware first. Here’s how to do it:

If you own a Macintosh AV:

1) Open up the Sound Control panel from the Apple menu.
2) Select Effects. Be sure to set effects to "None."

3) You are ready to install the software.

To install the Audiomedia (or similar) card in your Mac:

1) Turn off your Macintosh and unplug it. Take your monitor off of
the central processing unit (CPU), if you keep it there.

2) Open the top of the CPU box as shown in this diagram:

Installing Your Card

| Cover nf-lgme buttons

“%% Audmmedna 1T card

Ny

&‘ "»
W -
4&5 >
—
Mac TT-style CPU h ” |
i N ! i
Stereo cutputs*  Digital 1/O

* Sound Tools 11, l’m Tools and MediaTime cards connect via computer cable
to an external I/0
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3) Remove any one of the plastic slot covers on the back of the Mac.
This will be the slot for your audio card. (Any slot can be used.)

4) Touch the Macintosh’s power supply to discharge your body’s
residual static charge.

5) Make sure that your hands are clean and dry. Unwrap the
Audiomedia card and bring it over to the CPU.

Handle the audio card by its edges only. Do not touch the compo-
nents on the card front or the lines (traces) on the card’s back.
Touching these areas may damage the card.

6) Face the part of the card that has the jacks toward the back of the
Mac. Carefully press down on the top edge of the card to seat it in
the NuBus™ slot. Don't force it. If it doesn’t slide in relatively
easily, take it out and try again.

7) Make sure that the card is seated firmly, and that the metal ear at
the top back edge of the card rests in its housing.

On some Macintosh CPUs, there is no “ear” at the top back edge.
The card will simply rest firmly in the slot.

8) Carefully snap the Mac case closed, plug in the computer, and start
it up.

You are now ready to install the DECK II software, which is the last

major step before you can begin recording and editing sound. Here's

how to install the software:

To install the DECK II software on your hard disk:

1) Restart your Macintosh while holding the Shift key down. This
will prevent your System Extensions (INITs) from booting and
possibly interfering with the installation process.

2) Putthe DECK II Program disk into any drive.

An open diskette window will appear on your Desktop.

o —————
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3)

5)

6)

8)

Create a folder (using the New Folder command on the File menu)
and drag the DECK II application to the new folder.

After a few moments a copy of the DECK II application will
appear in the destination folder.

Put the DECK II Extras disk into any drive.
An open diskette window will appear on your Desktop.

Drag the DECK II Resources document to the same folder that
contains the DECK II application.

After a few moments a copy of the DECK II Resources will appear
in the destination folder. DECK II only runs when you have the
DECK II application and Resources document in the same folder.

If you have a Digidesign card, drag the DigiSystem INIT to your
System folder.

The DigiSystem INIT will automatically be placed in the Exten-
sions folder within your system folder. Install this INIT only if
you have a Digidesign audio card installed in your Macintosh.

Drag the QuickTime™ INIT to your System folder.
The QuickTime™ INIT will automatically be placed in the Exten-

sions folder within your system folder. DECK II required
QuickTime, so please make sure that this extension is installed.

Insert the DECK Il Program disk again and double-click on the
DECK Il application icon. This dialog will appear:

You are running DECK 11™ from the master diskette,
Authorized coples can run on your hard disk without
requiring this master diskette.

Select Setup to install or remove authorization for
any available hard disk. Dtherise select Quit
because this application is compressed and can't run
from the floppy master diskette.

Quit ll Setup... j
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9) Click on the Setup button. This dialog appears:

Oz

DECK 11™ will run on any authorized hard disk without
requiring the moster diskette. You have a remaoining
aulhorizalion count of 2.

Select Authorize to install authorization to a hard disk or
Deauthorize to remove authorization. Select Quit to quit.

[ Buthorize | [Desuthorize) ﬁ

DECK II uses a new, more friendly copy protection scheme.
Rather than requiring the typical software install /deinstall pro-
cess, the DECK II protection allows you to 'authorize’ up to 2 hard
disks. You can run your DECK II software on any authorized hard
disk, and you can move your DECK II software between any
authorized hard disks. Authorized hard disks can be optimized
with no risk to the software. You can also 'deauthorize’ any hard
disk using your DECK master diskette, in order to return to your
original authorization count. Then you are free to authorize other

drives.

10) Click on the Authorize button. This dialog appears:

ﬂuthorize:l — ProStore VI

Click OK to authorize DECK 1™ to run on the selected
hard disk. If successful, your authorization count
will be decremented.

11) Use the Authorize pop-up to select the hard disk you wish to
authorize. Then click on OK.

o ———
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The authorization process is now complete. Eject your DECK II
Program disk and store it in a safe place.

12) Restart your Macintosh. a

Important: When you have restarted your Mac, you can run DECK II. Please note,
however, that DECK II is compressed. It will automatically decom-
press the first time you run it. Once DECK Il is decompressed, it will
never need to be decompressed again.

WARNING: Like many CPU-intensive programs, DECK II does not run well with
File Sharing turned on. Although DECK II will run with File Sharing
on, its performance will be greatly degraded. For better results, make
sure file sharing is turned off before you begin your DECK II Session.

Your hardware and software is now installed, and you're ready to
begin working with sound. The only thing you still need to do is hook
up audio inputs and outputs. The next section tells you how to do
this.

Hooking Up the Audio Inputs and Outputs

DECK II basically turns your Mac into a multitrack digital workstation,
but like any recorder/editor, you will need to hook it up so signal can
be routed into the inputs, and the outputs can be amplified for listen-
ing in some way.

Here is a diagram that shows a very simple audio setup:
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| Hooking Up Audio Input and Qutput

Sound source
{mixer or keyboard, for examgle) Diggital 1O

Lk spezker
* The Sond Toob 11, Pro Teob and Medb Tiee syetenms us external bowes for
it and cutput, = e aoe o inguts on te hack of these cendo.

As you can see from the diagram, the output from the source you wish
to record are fed into the left and right audio card (Audiomedia) or
audio interface inputs (Sound Tools Il or Pro Tools), and the audio
card or audio interface outputs are then fed to an amplifier attached to
speakers or headphones.

The extra mic input on the original Audiomedia card is for high-
impedance microphones, which are very inexpensive, and can be
plugged directly into the card. This extra input has a built-in micro-
phone preamplifier, so use it only with a high-impedance mic.

AV Users: It is most likely you will be converting 1/4" jacks coming from your
audio source to the 1/8" stereo miniplugs that fit in the back of your
computer. Warning: Use standard 1/8" adapters for the input. The
longer .75" miniplug (like the one on the Apple Microphone) will touch
a 5mV power supply, which is used to power the microphone preamp.
For true stereo input, simply use a standard 1/4"-to-1/8" stereo mini
plug adapter. The same standard 1/8" adapter will work just fine for
the audio going out to your amplifier.

o—
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Important: If you are using the NuMedia card the above information also applies.
Also, make sure you understand how to navigate the Sound Control
Panel to switch inputs. Be sure that you have selected 16-bit stereo
audio and a sample rate that is the same as your session (44100 Hz, for
example) using the Sound Control Panel. q

Hooking Up an External Mixing Board

DECK ILis designed to function properly with a wide range of instru-
ments, but for serious projects, you will probably want to consider
using a small mixing board to route signal to and from the audio card
or audio interface box. This allows you to adjust your input signals
over a wider range, facilitates the use of external effects, and prevents
you from constantly plugging and unplugging inputs and outputs.
Here is a diagram illustrating one way to hook up DECK 1T and your
system using a small mixing board:

F Using DECK with a Simple Mixing Board

Stereo return from Mac

’ Instrument input

Mac ll-style CPU

[MINE 4

Sub outs to Mac*

Stereo out to amplifier

* The Sound Tools IT, Pro Tools and MediaTime systems use an external box for input and
cutput, so there are no I/0 connections on the back of these cards.
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This is a very simple but flexible setup. It allows you to play and
monitor every source, and provides routing for processing DECK 11
tracks externally and re-recording them. Remember, as with any
flexible system, you must take care not to set up a feedback loop.
Specifically, do not route the stereo return from DECK II back into DECK 11,
unless you are re-processing a DECK II track. Depending on your mixing
board, you may have other options for sending DECK II its own
submix, and monitoring DECK II using dedicated returns. The most
flexible setup will depend on your particular board.

If you are not using a component amplifier and speakers for audio
playback, it is also possible to hook the Sound Tools and Audiomedia
output jacks directly to powered speakers, such as AR Powered
Partners™! or Bose Roommates™. For more information, consult your
Digidesign or RasterOps manual.

Important: Connect and disconnect audio jacks ONLY with all signal generators
and amplifiers turned down or off.

On the back of the original Audiomedia card you will find a 1/4-inch
pre-amplified microphone input. This input is always 'on' in DECK II,
and you can use it to mix in a third input while recording. Note,
however, that it does not have a separate input level control, so you
will be responsible for matching signal levels.

Remember, DECK II allows you to record CD-quality audio, but it will
only sound as good as your playback system allows. Tiny low-
powered speakers will greatly diminish the quality of your audio
playback.

Once you have DECK II and your hardware system hooked up as

illustrated, you are ready to begin recording, editing, and mixing
digital hard disk audio.
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Introduction

Although DECK II uses complex technologies to accomplish its
recording, editing and mixing tasks, it is based on two familiar pieces
of equipment — the tape deck and the multichannel mixing board.

Macintosh screen as the mixing board and editing table. Anyone who

DECK I uses your hard disk as the multichannel tape deck, and your a

has used a portable four-track recorder will find the DECK II program
‘look” very familiar, and since DECK II operates your hard disk as
tape, it also takes care of the standard tape deck tasks. However, since
DECK Il adheres closely to the tape deck metaphor, it is important to
remember that a basic understanding of multitrack recording concepts
is essential for you to get the most out of the program. Also, since
‘waveforms’ are used to represent sound for visual editing, a simple
familiarity with these sound wave representations is very helpful.

This chapter is devoted to explaining the digital recording and mixing
concepts you will need in order to understand DECK 11, and illustrat-
ing the simple ideas behind waveforms. If you are an experienced
sampler and you have operated a multichannel board and recorder,
feel free to skip to the next chapter. However, if you are new to
multitrack recording and editing (or interested in a review), this
chapter will give you the background knowledge you need to produce
high-quality digital multitrack recordings.

Basic Sampling Concepts

DECK Il accomplishes its direct-to-disk recording tasks using a
method called sampling. Unlike normal magnetic tape recording,
which records an audio signal as a continuous charge on magnetic
tape, a sampler converts an audio signal to discrete numbers which are
then stored on a digital storage medium (a hard disk, for example).

Digital sampling of audio tracks is generally superior to the standard
analog recording methods — not only because it offers extremely high
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fidelity, but because it avoids the standard tape generation and ‘play-
back degradation” problems. Because sampled audio is stored as a set
of numbers, there is no loss of fidelity when you copy those numbers,
regardless of how many ‘copies of copies’ you make. Also, because the
disk medium is not physically strained by playback (as is a reel of
analog tape when it is pulled across the playback heads), repeated
playback of a digital track will not alter or degrade that track in any
way. For these reasons (among others), digital recording of audio
tracks has become the method of preference for many contemporary
producers.

The process of digital recording (or sampling) is really quite simple:
An audio signal is fed into a computer (or dedicated sampling device).
That signal is run through an analog-to-digital converter (ADC),
which measures the amplitude (volume) of the signal at regular
intervals and passes these measurements or ‘samples’ on to a storage
medium. When the recorded track or tracks need to be played back,
the samples are retrieved from the storage medium and run through a
digital-to-analog converter (DAC), which converts those samples back
into a continuous wave. The signal that comes out of the DAC is the
output signal, and it is a nearly exact image of the signal that was fed
into the ADC. Here is a diagram illustrating the way in which samples
of an incoming audio signal are taken:

Taking Samples of a Sound Wave

//-\-,‘ + = oow samgle

Amplitude

Time ————»

As you can see, the incoming audio wave is approximated by a series
of discrete points that describe that wave. The physical representation
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of this wave is called a 'waveform.' The nature of this process illus-
trates one of central questions of digital recording: How accurate is the

digital representation of the original analog signal? To determine this
you will need to understand the concept of sample rate.

Sample rate is the number of samples of a waveform that you take in a
single second, and it has a very strong influence upon the quality of
the recording you make. At best, a collection of samples is an ex-
tremely good approximation of the original input signal. By taking
many samples of an audio signal, you end up with a more accurate

depiction of the wave ~ fewer samples yield a less accurate, ‘grainy”
depiction. Here's an illustration:

Why Sample Rate Affects Fidelity

Amplitude
Amplitude

Time T | e

Higher Sample Rate Lower Sample Rate

Notice how a higher sample rate yields a more accurate, and therefore
higher-fidelity recording. Unfortunately each sample requires storage
space. Since a higher sample rate takes more samples per second, it
will require more disk storage space for each second of audio than a
lower rate. DECK II uses set sample rates of 44,100 Hz or 48,000 Hz. A

Chapter 3: Digital Recording and Mixing Basics



sample rate of 44,100 Hz means DECK II takes 44,100 samples every
second and puts them on your hard disk. This is the same rate used by
compact discs, and it allows you to record frequencies up to 22,050 Hz
accurately. Since normal human hearing ranges approximately from
20 Hz to 17,000 Hz, the sample rate of 44.1 kHz generally offers more
than enough fidelity. DECK II also offers a sample rate of 48,000 Hz,
which is the basic rate used by many digital audio tape (DAT) record-
ers. This higher sample rate actually allows you to record frequencies
up to 24,000 Hz, but since these frequencies are outside the audible
range for most humans, it is generally unnecessary to use this higher
rate for fidelity purposes.

MIDI and Hard Disk Audio

Music and sound on the personal computer has changed radically over
the last ten years. Most people in the audio industry are very aware of
these changes, particularly due to the development of the MIDI
standard in the early eighties. MIDI, which stands for Musical Instru-
ment Digital Interface became the accepted communications standard
for electronic musical instruments, and it can now be found on virtu-
ally every electronic keyboard, drum machine, trigger device, tone
generator and effects unit.

MIDI was originally conceived as a ‘remote control’ standard that
would allow musicians to control multiple instruments from a single
keyboard, but it rapidly developed into an audio network environ-
ment. The creation of MIDI sequencers is perhaps responsible for the
importance that MIDI holds today.

MIDI sequencers opened the door to personal audio recording by
offering an inexpensive way to record and play back multiple-track
compositions without a tape deck. However, MIDI sequencers do not
accomplish this feat by recording an actual audio signal. You can
think of a MIDI sequence as a player piano roll. The MIDI sequencer
records events that occur at your keyboard — what key you pressed,
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how hard you pressed it, how hard you're holding it down, and when
you let go. These little pieces of information, called MIDI events, are
picked up and remembered by the sequencer as a sequence. To play
the sequence, the sequencer sends the recorded events back to the
keyboard, essentially playing the keyboard every time the sequence is
played back.

Sequencing offers some new possibilities. For example, you can a
change the sound that is on a certain track by loading a different sound

onto the keyboard. The sequencer is just playing notes, and it pays no
attention to what sound it is playing. You can also change the tempo
of a recorded MIDI sequence without changing the pitch of the notes
(unlike tape, which changes pitch when playback speed is changed).

But the concept of MIDI has some inherent weaknesses that can be a
great cause of frustration. For example, how do you record a guitar
track, or a vocal track, or a sax? These entities are purely audio signals
— they have no natural place in the MIDI world. This is where DECK I
comes in. Although DECK ILis a full-function digital multi-track
recorder, it both supports and augments MIDI. By running DECK II
alone or OSC's METRO sequencer (or any other supporting sequencer)
on your Mac along with DECK II, you can add full synchronized MIDI
functionality to any audio session. If you have an existing MIDI
sequence, you can import it into DECK II and record multiple audio
tracks over it. If you wish to save disk space, you can use METRO to
add MIDI tracks to your DECK Il multitrack audio recordings. DECK
Il and METRO provide an environment where full-functioned MIDI
and synchronized digital audio coexist.

Digital Multitracking and the Mixing Board Metaphor

There are perhaps two characteristics of the Macintosh that have made
it the machine it is today: An enforced standard interface and a visual
environment that lends itself easily to metaphors. Most of the popular
Macintosh programs offer an interface that mimics something familiar.
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By doing so, a software developer makes it easy for users to immedi-
ately understand what a program does and how it works.

DECK II'is an example of this principle. The DECK II interface looks
like a simple four track mixer with some additional controls and
surfaces. If you have used a portable multitrack device, then you
should find recording and mixing with DECK II will be very intuitive.
If you haven't, then some background may be very helpful.

Take a look at this illustration of the DECK II Mixer and Transport
windows:

The mixing board consists of four vertical input/output modules, each
with VU meters that register signal level. The input/output modules

——— e
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all look the same because they each represent one of DECK II's four
digital record /playback tracks. (Remember that DECK II allows you
to create an unlimited number of tracks, but only four of those tracks
play at one time.) Each of the input/output modules has two modes —
record and play. Record allows you to feed a signal into your audio
card, set its monitor level, and record it to your hard disk. Once a
track is recorded, play mode lets you play that track back, adjust its

playback levels, and run automate its level or pan (placement in the

stereo field).

The buttons in the Transport window function just as they would on a
normal tape recorder. They allow you to rewind, fast forward, play,
stop, and record DECK II's four digital tracks. They also offer controls
for storing location times, punch times, mixer states, and for adjusting
playback pitch.

Recording from Scratch

The production lifecycle of a DECK II project might progress like this:
You record a first track on track 1. Then you play back track 1 to make
sure you like it and set its volume level. Next, record track 2 while
listening to track 1. Now play both tracks back while recording track
3. Follow this same procedure to record track 4. (Remember, you can
also record 2 or 4 tracks at once, depending on hardware.) Then listen
and mix levels and pan on all four tracks. If abrupt or smooth volume
level or stereo pan setting changes are required, you can automate
these changes. When you are satisfied, you may choose to mix to a
master stereo file for pressing a CD or album, or for playback from
within a QuickTime movie, HyperCard™, SuperCard™, Director™,

etc.

The process detailed above is essentially the same one you would
follow if you were using an analog multi-track tape deck and mixing
board. However, DECK Il is a digital recorder, so there are some
special points you will wish to consider.
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The Input Signal: The input signal is the audio signal that you wish to
record. It must be plugged into one of the audio inputs on the audio
card or audio interface box. The left and right inputs of the Audiome-
dia and Audiomedia II cards are unbalanced -10dBU ‘line level’
inputs. That means they expect something like a keyboard or small
mixer to be plugged in directly. If you plug a microphone or electric
guitar into the left or right input you will have trouble making it loud
enough. This is because sources with low level signals like mics and
guitars are generally run through a pre-amplifier, which allows you to
adjust their levels over a wider range.

The Sound Tools Il and Pro Tools system audio interface boxes offer
inputs that are +4dBU balanced line level inputs. These inputs do not
expect you to plug in a keyboard or semi-pro mixer directly. In order
to get the most out of these systems, you should make sure that all
signals routed to the inputs are truly balanced and brought to the
correct level using a pre-amplifier or professional mixer.

The original Audiomedia card has a small built-in pre-amp connected
to its Mic input, and you can plug a microphone or electric guitar
directly into this input. However, to get the most out of your DECK II
system, you may wish to place a small mixing board between your
sound sources and your original Audiomedia card. This would allow
you to plug all of your instruments, CD players, and microphones into
a single device, and use that device to choose what is routed to DECK
II. You could also use the mixing board to monitor the DECK II
outputs.

Digital Distortion: When you feed a signal into any recorder, includ-
ing DECK II, you always need to adjust the input level so that you are
optimizing your dynamic range. Essentially this means that your
mput signal should register as high as possible on your input meter
without turning on the clip light. If the input level is too low, the
recorded track will be noisy. If the signal is too high, it will be clipped.

Clipping is a situation that results when you feed a signal to a recorder
or mixer if that signal is louder or “hotter’ than the device allows. On
many analog tape decks, a little clipping seems to add warmth to the
sound — often by increasing use of the noise reduction circuitry (Dolby
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B or C, for example). In digital recording, clipping is to be avoided at
all costs. It causes digital distortion, which almost always sounds truly
terrible.

Automated Punching In and Out: Automated punching in and
punching out are extremely important concepts in multitrack record-
ing. To understand the need for these functions, picture this situation:

finish the track and listen to it playing back. During playback you

You are recording the last track of a five minute multitrack piece. You a

realize that the track is perfect, except for a tiny mistake near the end.

Punch in and punch out are functions designed to cope with this
problem. To fix the bad section, you would set a punch-in point just
before it and a punch-out point just after it. Then you would re-record
the track. During the recording process you would hear the original
track right up to the punch-in point. At that moment the recording
deck switches to record mode and you would play over the mistake.
When the punch-out point is reached, the recording deck automati-
cally switches out of record mode. This automated punch-in and
punch-out have made it possible for you to re-record only a small
portion of a track, without requiring that you operate the tape trans-
ports.

Bouncing Tracks and Virtual Mixing: One of the basic problems
inherent in multitrack recording has always been the limited number
of tracks. What do you do in a four track environment if you have five
separate instruments to record? There are two answers to this ques-
tion.

One way to squeeze extra material into a multitrack environment is to
mix incoming signals together and record them on a single track
(multiple vocal tracks, for example). This method offers a high-fidelity
solution, but it has a few serious drawbacks. Specifically, the relative
level and tone of the different signals cannot be changed indepen-
dently after they are recorded. Using the vocal example, you can’t
turn up one voice without turning up the other.

Bouncing, the other solution to the track limitation problem, offers
more flexibility but hurts the overall fidelity of analog tracks. In a four
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track environment you might bounce tracks like this: Record three
separate tracks and mix them with the relative level and EQ you want.
Then record the three mixed tracks to the fourth track. Since the three
source tracks now exist as a single track, you are free to replace the
originals with new tracks. In the analog world this method increases
the number of recordable tracks, but each bounced track ends up being
a “recording of a recording,” and the overall fidelity deteriorates.

DECK II offers the same track mix and track bounce capabilities you
find in analog recording, but with some major improvements. The
most important difference is that DECK II bounces tracks with no loss
of fidelity. Since all DECK II tracks are digital, no noise is added
during a bounce and no high frequencies are lost. DECK II also allows
you to save your original digital source tracks on an archiving medium
(a large hard drive, removable drive, or tape backup). This makes it
possible to retrieve and ‘re-bounce’ tracks long after they would have
been erased in analog multitrack recording.

If you have a large hard drive you may want to consider using DECK
IT's virtual mixing feature instead of bouncing tracks. Virtual mixing is
a concept that really is not available in the analog world. Analog
mixers are physically limited to the number of tracks that can be
recorded. By using a Macintosh digital workstation, you are not
hindered by the limitations of the analog world. DECK I does not do
its mixing in real-time, so there is no limit to the amount of audio it can
mix at one time except hard disk space. DECK II allows you to record
as many tracks as you like and mix them all together during the final
mixing process. Virtual mixing is explained at length in Chapter 7.

Audio File Formats and the DECK Il “Session” file

A DECK II Session is a Macintosh document that contains a ‘map’ of a
specific recording project. This diagram should give you a better idea
of how a DECK II Session is organized:

@
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Structure of a DECK II Session

* Crossfode files are created and managed by DECK T They should not be edsted ar altered.

A Session file may contain any number of audio regions and playlists.
Each audio playlist contains a list of audio regions that are located on
your hard disk(s). An audio playlist is a like a playback direction
sheet. It tells DECK IT what pieces of what audio files to play, and
when to play them. Audio playlists make it possible to play any audio
file regions in any order, and they oversee this playback in a non-
destructive fashion: If you want to repeat something ten times, the
same disk region is played ten times in a row. If you want ten minutes
of silence, no disk region is played. A DECK II Session is able to play
back four of these playlists simultaneously — the top four tracks (the
four tracks represented in the Mixer window) are your playback
tracks. They contain the playlists that will play at any one time.

A DECK 1I Session also remembers all mixer states (snapshots) and
autolocation settings, and all fader settings and window configura-
tions. When you double-click on a Session, the Session window
appears exactly as it was saved, and the associated audio playlists and
automation data are loaded automatically.
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New Audio Files: When you create a new DECK II Session, no audio
files exist for that Session. At any time you have the ability to load
existing monophonic Sound Designer II or Audio Interchange File
Format (AIFF) audio files into the Track window, and to construct
from those audio files an audio playlist than you can play. You can
also create a new audio file by recording a new track. Whenever you
record a new track in DECK 11, that track is saved in a new audio file
named with the name of the track’s playlist. These audio files are
placed in the Audio Files folder (which is in the same folder as the
Session document). You will always create a new audio file every time
you record onto a new playlist. When you punch in on an existing
playlist (or after the end of an existing playlist) that audio is always
added to end of that playlist's audio file in the Session’s Audio Files
folder.

Support of different audio file formats: DECK II supports Sound
Designer II, AIFF, Sound Resource and QuickTime audio files, but the
native playback and record format is Sound Designer Il mono. When
you select and add any files that are not in Sound Designer I mono
form, DECK II will automatically make a Sound Designer II mono
copy of those files in the Sessions Audio Files folder. If you select a
stereo file, two mono files will be created. Since non-Sound Designer II
mono files need to be converted in this fashion, adding them to your
Session will require more disk space, and may take a few moments.

Note: If you move an audio file that is referenced by a Session to a new place
on the hard disk (or to another hard disk), DECK I will always prompt

you to find those missing audio files when you next open the Session.

What is ‘Non-destructive' Recording?

DECK II uses ‘non-destructive' recording technologies, which are far
more powerful than original DECK's simple linear erase recording,. It
is very important to understand the concept of non-destructive record-
ing if you are going to get the most out of DECK IL
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In the world of analog audio, there is only one kind of recording:
Destructive. Whenever you record onto a track of analog tape, the
new signal permanently replaces whatever was on that track before. If
you record something on track 1, and then record something else over
the same time, the original recording is erased and replaced with the
new audio. Such is the nature of magnetic tape.

different options. You can think of your DECK II Session document as
a kind of 'audio database.' It keeps track of all the audio regions you
have recorded and added, and it plays then back according to how you
recorded or placed them. Because of this, DECK Il is capable of
keeping track of many more soundfiles and audio regions than you are
using, and DECK uses this capability to allows non-destructive record-
mg.

Because DECK II runs on a computer, it offers you many new and a

DECK I recording is non-destructive because the process of recording
never replaces or deletes any audio file data. Instead, new data is
always recorded and 'mapped in' to the position of the old data. If, for
example, you record a track, and then punch-in a replacement take
over one bar in the middle of that track. When the new take is re-
corded, it is simply added as new data to the drive, and this new data
region appears over the old take. Because nothing was erased, you
can return to your original take at any time. You could even record
ten new takes and chose between them later. The benefits of this
scheme are obvious: You never have to risk erasing a section of audio
just because you want to try another take or audition another region in
the same place. Because of this scheme, you can also bounce four
tracks to one track without erasing the destination track, and you can
always go back to your original tracks and ‘re-bounce’ them for a new
submix. These facts make non-destructive recording one of the most
powerful features associated with digital audio workstations.

There is, however, one drawback to non-destructive recording. Since
younever delete old audio by recording new audio over it, your hard
disk will have a tendency to fill up more quickly, especially if you are
recording multiple long takes. DECK II offers you a tool for dealing
with all of this data. Its called the Compact Session command. This
command automatically looks at the current Session and finds all of
the audio in your source audio files that is not used on any track, in

Chapter 3: Digital Recording and Mixing Basics a



any form. Then it deletes all of the unused audio. Executing this
command does not take very long, and it will free up all of the disk
space that had been occupied by unwanted audio. The combination of
non-destructive recording and the Compact Session command make it
possible for you to make sure that you have the greatest flexibility, and
still consume the minimum hard drive space. For more information,
read about the Compact Session command in the Reference chapter of
this manual. Make sure you understand how Compact Session works
before you use it.

Fader Automation

After you have recorded all of the tracks of a multitrack project, you
are ready to begin the mixdown process. It is called ‘mixdown’
because you will be combining all of the monophonic tracks to create a
stereo master. You will use the stereo master to make your final
product — whether that is a compact disc, album, cassette, DAT, 1/4"
tape, or a disk file for multimedia purposes.

In the typical home recording environment, final mixdown is accom-
plished by playing back the multitrack source repeatedly. During each
playback pass you set levels, and practice moving the faders to fade
the audio in and out, change levels, change send settings, etc. When
you have practiced the mix enough to feel confident, you attempt to
‘perform” it as you record it to a mastering deck. This is usually a very
touchy process that is both inconsistent and inaccurate.

Professional recording studios get around this problem by using
mixing consoles that ‘automate’ the movement of all faders. Mixing
boards that support fader automation often allow the engineer to set
up board ‘states’ where the position of every fader is recorded, and
assign those states to particular times during the recording. Some of
the more advanced automated mixing consoles even record the
physical motion of each fader and replicate that motion on every
playback run. The major drawbacks of this type of automation are
expense and complexity. Generally the cost of moving fader automa-
tion puts it outside the reach of the individual.
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DECK II gets around these problems by offering moving fader auto-
mation as a software entity, rather than a piece of hardware. After you
have recorded digital tracks, you can use DECK II to record any
adjustment you make to volume and pan. You can also capture fader
states for all DECK II faders and assign those states to specific times in
the recording. You can view and edit all of these control adjustments
in a visual fashion. These tools allow you to build up a mix slowly and
save that mix as one of a series of different mixes. When it comes time
to create a stereo master, you can be assured of exactly the same level
settings and fader transitions every time.

Synchronizing Sound to Picture

For many people, sound editing tasks are aimed specifically at enhanc-
ing or complementing visuals. These tasks, typically referred to as
‘audio post-production’ or ‘sweetening' put very specific requirements
on audio technology. Generally the sound editor begins with finished
picture (in video or film form) and perhaps some rough guide tracks
on video tape, audio tape, or magnetic film. The post-production
process then consists of editing the existing audio, adding new dialog,
effects, ambiences and /or music. Then the editor would automate a
mix of all sound components, and create a stereo (or more-track)
master, which is again recorded back to the video master or to another
time-referenced master (timecoded digital audio tape or center track
1/4" tape, for example.)

DECK 1I offers all of the basic audio functions you will need to create
sound tracks, synchronize those sound tracks to picture, automate
your mix, and create a CD-quality digital stereo master.

DECK II differs from conventional analog systems in a number of
ways. Particularly important is the fact that DECK II records, bounces,
processes, and mixes your audio completely in the digital domain.
This guarantees you the maximum editing control with little or no
added processing or generation noise. Also, since all the computer is
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used as the platform for control, you are free to use the synchroniza-
tion method of your choice. This makes it possible for you to use
SMPTE timecode as your sync source, or to work entirely off your hard
disk by using QuickTime video picture as the sync source. For more
information about these methods, see Chapter 7 of this manual.

Final Stereo Mixdown

Generally speaking, final stereo mixdown is the last step in any
multitrack production. In order to distribute any audio project, you
will need to put it into a form that is available everywhere. That
means compact disc, CD ROM, digital or analog cassette tape, video
tape or vinyl. Unfortunately, of these media only analog cassette tapes
and video tapes can be recorded cheaply at home, and these formats
generally do not offer optimal fidelity.

In the professional recording world, the final stereo master has tradi-
tionally been recorded on analog two track reel-to-reel tape. This tape
is then used as the image for duplicating albums, CDs, videos, films, or
cassettes. Although this is the status quo, quality reel-to-reel master-
ing machines are quite expensive to own or use, and a number of high-
fidelity, affordable new options are appearing.

Perhaps the most promising of the new mastering media is digital
audio tape (DAT). Coupled with DECK II and your Macintosh, DAT
mastering offers a relatively inexpensive, extremely high-fidelity
solution that can be used directly for producing CDs, albums or
cassettes. If you own an audio card that offers only analog outputs,
you can hook the analog audio outputs of the card to the analog inputs
of a DAT recorder and create a final digital stereo master that rivals the
quality of most studios. Using a timecoding DAT machine even makes
it possible to create time-referenced masters.

If you are an Audiomedia II, Sound Tools I or Pro Tools owner, an
even more advanced method is possible. You can use DECK II to
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create a full-digital stereo master on your hard disk. Then, using your
S/PDIF or AES/EBU output, you can transfer the digital master
directly to digital audio tape, withou! a single analog step. Basically, this
offers mastering fidelity that rivals high-end studios, and it runs right
on the Mac desktop.

Archiving Suggestions a

Audio is a complex phenomenon, and you need quite a bit of data to
describe it. Recording audio to your hard disk will use a very notice-
able amount of disk space ~ approximately 5 megabytes per track
minute of one track audio. For this reason itis a good idea to have
some type of archiving medium for keeping master and backup copies
of your recordings. Here are some devices that are very useful for
archiving purposes:

Erasable Optical Drives: These drives store 128 megabytes, 600 mega-
bytes, or more on a single removable cartridge. Since the medium is
magneto-optical (a combination of magnetics and laser technology),
the cartridges have few moving parts and a relatively long storage life.
Unfortunately they have not yet proved fast enough for reliable four
track recording. They are generally quite useful (although expensive)
as a medium for archiving and exchange.

Removable Platter Drives: These drives store 44 or 88 megabytes on a
removable magnetic platter cartridge. Although some implementa-
tions of the mechanism are fast enough for four track recording and
playback, most are not. Generally speaking, the standard 44 or 88
megabyte Syquest removable drives are not extremely useful as a
recording or archiving medium, because they hold less than 15 single-
track minutes of audio at full fidelity.

WORM Drives: WORM drives can record data once and will contain
that data from that point on. They are extremely high-capacity (900
megabytes or more), but they cannot be erased or rewritten. They
have a very long storage life, and are useful as a long-lasting master
archive. They are not fast enough for four track recording or playback.
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Streaming Tape Drives: Streaming tape drives are generally the least
expensive data backup devices. They store data on magnetic tape
(8mm, DAT, or 4mm tape, for example) in sequential fashion, so they
tend to be relatively slow, but the media costs are minimal. Because
these mechanisms are built for backing up data, they provide a great
deal of data integrity and verification, and they allows you to back up
any document (unlike simple audio DAT backup). For many situation,
these drives offer the best price/performance ratio.

DAT Recording Decks: If you are an Audiomedia II, Sound Tools II or
Pro Tools owner, you can use your AES/EBU or SPDIF digital outputs
to transfer soundfiles to a digital audio tape recorder for storage and
retrieval. This is perhaps the best backup alternative for audio profes-
sionals, because DAT recorders are also full-function digital tape decks
that allow you to listen directly to any stored audio file.
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Introduction

This chapter of the DECK II manual focuses on the specific tasks you'll
need to understand, in order to get the most out of DECK II. As you
have probably observed, DECK I generally looks and acts just like a
portable four track mixer and recorder. In most cases DECK II is very
similar to its analog counterpart - it allows you to record tracks,
monitor them while recording other tracks, adjust the level of what
you've recorded, and mix down your recording to a master. However,
DECK Il also offers many features you would not find on a portable
multitrack recorder, including advanced visual waveform editing,
non-degrading track bounce, multi-point autolocation, moving-fader
automation, and CD-quality 16-bit audio. If you want to understand
more about DECK II's most powerful functions or if you have a
specific task in mind, this chapter is for you. For specific information
about menu commands or screen controls, see the Reference chapter of
this manual.

Starting DECK Il and Creating a New Session

Before you can start using DECK II for multitrack recording, you will
need to install both the DECK II software and vour hardware. If you
have not done so already, then read through the Getting Started
chapter of this manual. If your software and hardware are already

installed, then you're ready to begin.
To start up DECK II and create a new Session:

¢ Double-click on the DECK I icon. After a few moments the DECK i
menu bar appears.

* Choose the New command on the File menu. This dialog appears:
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= Sessions ¥ <= ProStore

Name new session
[Barney Must Die |

0 Durstlay | Lient

CJ Dino-boy —

1 Wailing Wall

C Weight
O Yeninko —

Session sample rate: & 44100 kW7
2 48000 kHz

This is DECK II's New file dialog. Use it to choose the sample rate of
the Session you will be creating and set the name and destination
folder for your audio files. Generally you will use the 44.1 kHz
sample rate - it is the CD standard rate. If you are recording from
DAT, and that DAT has a sample rate of 48 klz, then you will
choose the 48 kHz rate. See the Basic Sampling Concepts in the
previous chapter for more information about sample rates.

* You have now created a new Session. Choose the Mixer command
and then the Transport command on the Windows menu.

The Mixer and Transport windows will appear on your screen. They
look like this:

Lurimnlldopes *dinm
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Note: You can change the default position of all DECK Il windows (used
when a new Session is created) using the Save Settings as Template
command on the Preferences submenu.

The DECK IT Mixer window is one simple window you will use for
control of audio recording and playback. However, before you go
much farther, make sure you understand the DECK TI “Session’ con-
cept. Itis explained in the previous chapter.

Using DECK Il to Open, Save, and Close Sessions

Unlike most Macintosh documents, a DECK 11 Session is both a file
and a ‘map’ that keeps track of other files. For this reason, you will
need to pay extra attention to standard Mac file maintenance tasks.
Here are directions for opening, saving and closing DECK II Sessions:

To open an existing DECK II Session:
* Start up the program and wait until the DECK II menu bar appears.

* Choose the Open Session command on the File menu. This dialog
appears:

[ Barney Must bie ¥ = ProStore
= | £inci
3 Barney Must Die cross-fades '~—]
[ Desktop _‘!

‘[_onen '

This is DECK II's Open dialog. Use it to highlight the name of the
Session you wish to open. Remember, Session files keep track of the
associated soundfiles, and they contain automation and other
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important data. You cannot use the Open Session command to open
a soundfile. Instead, you must create a new session and add or load
an existing soundfile.

To save a DECK II Session:
e Choose the Save command on the File menu.

This saves the current Session file and its automation and other data.
Audio edits and changes to automation or location times are not
saved to disk until you choose the Save command. Remember,
however, that hard disk audio files are recorded directly to disk.
Therefore they are saved the moment that they are recorded. If you
wish to save the current Session under a new name, choose the Save
a Copy as command. For more information, see the Reference
chapter of this manual.

To close a DECK II Session:
e Choose the Close command on the File menu.

If you have already saved the Session, the Session will be closed and
the Session window will disappear. If you attempt to close a DECK
11 Session without saving it, a dialog box will appear and offer you a
last chance to save before closing. If you choose No, your Session
changes will be lost.

Adding Existing Soundfiles

Since DECK 11 is a hard disk recording program, it is compatible with a
range of hard disk soundfile formats. This is a particularly important
feature for producers who wish to record multiple tracks over existing
mono or stereo disk-based soundfiles. DECK II offers a simple method
for bringing in existing hard disk tracks as DECK 1l tracks. You use
the Add Audio to Clipboard command, and paste that audio at the
desired location the Track window. The Regions window keeps track
of all source material added to the Session in this manner. DECKII
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uses monophonic soundfiles in the Sound Designer II format. If you
add any other type of hard disk soundfile, DECK II will automatically
copy the soundfile and convert the copy to the correct format.

Note: DECK II does not convert all sample rates automatically. If you wish
to add a soundfile to the current Session, that soundfile's sample rate
must be an integer multiple of the Session sample rate. (For example,
if the Session sample rate is 44100 Hz, then DECK II will convert a
sound file that was sampled at 11025 Hz or 22050 Hz, but not one that
was sampled at 13436 Hz.) If it is not at the correct sample rate, use

Sound Designer II to convert it to the correct rate. q
To add a soundfile or soundfile region:
* Make sure you have a DECK II Session open. Then choose the Add

Audio to Clipboard command on the File menu. This dialog box

appears:

I@ Sound FR ¥ | < 660A1 Regions in FH Jor W Delay

0O FH Jar W Delay aiq
D FH Lo Brk Drm Chorus
D FH Motor/RAlarm

0 FH Pipebel

D FH Robot Arm

D FH Spaciness

[0 FHt Steam 1

Show:[SD | (350 11 [DAIFF

Eisct

Desktop

Done

Cancel

Show: []Regions E}Looﬁ
sample Rate: 44100 tipes) fiegion Length: 1.00

Channels: 1 [] Loop Rudition

Bit Depth: 16 = Cf}r:_ent Playlist
C nts: aoy hghod *Js F}i Spaciness -.;_)3
This filc needs ta be fidd Region | |oT¢ FA Fast Police Siren | |
converted.

Note: Mewa marked with “oTe*
will 2o tranglded to a compatible Remove
format. This will gee exira dick
dpace, and Moy 1ake 3 monment

i R

* Use this open dialog to highlight the soundfile you wish to load (or
the soundfile that contains the region you wish to load).
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When you highlight the soundfile, you will see a list of the regions
within that soundfile in the regions list in the upper right-hand
corner of the window. The top region always represents the entire
file.

* In the regions list, click to highlight the region you wish to add.

You can audition the highlighted region at any time by clicking on
the Play Region button. If you wish to hear what a loop will sound
like, check the Loop Audition box.

* If you wish to add the selected region to the current playlist, click on
the Add Region button.

The added regions appear in the lower right-hand side of the dialog,
in the Current Playlist area. This is the list of regions that will be
placed on the Clipboard. Remember, at any time you can remove
regions from the current playlist by selecting the region you wish to
remove and clicking on the Remove button.

* Continue the above process until you have added all of the regions
you desire, then click on the Done button.

All of the regions you selected are now on the Macintosh Clipboard,
and you will be returned to the DECK II Track window. The Track
window is where all of DECK II's audio editing occurs. See Chapters
5 and 8 for specific instructions and extensive information about the
Track window.

¢ Click once on any track to place the cursor at the location where you
wish the audio regions to appear. Then choose the Paste At or Paste
After command.

Hint: All audio added to your Session in this manner will appear in the
Regions window. Use the Regions window to spot individual regions

to specific points.

The Clipboard regions appear on the selected track or tracks. Re-
member, if some of the selected regions or files were stereo re-
gions, make sure to select two tracks before you paste.
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You have now added existing audio to the current Session. To play
it back, just click on the Play button in the DECK II Transport
window. (You can also simply click the cursor in the Track window
at the point where you wish playback to start and then press the
space bar. Press the space bar again to stop playback.) If you wish
to verify which soundfiles are being used in the current Session, see
the Session Info command on the File menu.

Recording the First Track

The first step in most multitrack recording projects is recording the
first track. In many ways the first track is the most important, because
it often becomes the framework upon which other tracks are built. If
the basic timing of the first track is sloppy, the entire production will
be affected, so record your first track with care.

If you plan to integrate MIDI into a DECK II Session, it is a good idea
to plan for this from the very beginning. If you have an existing MIDI
sequence and you wish to record audio over that sequence, then make
sure to load the MIDI file into DECK II's MIDI window before record-
ing any audio. If you wish to record audio first and then lay in MIDI
tracks, you may wish to record the audio tracks in time to a MIDI
metronome, which can be supplied in real-time from the METRO
software running in the background; you can also accomplish this by
recording a simple MIDI click file and importing it into your Session.
Doing this assures you that your recorded MIDI tracks will be easy to
edit in any sequencing program after they are recorded. To learn more
about the integration of MIDI and audio, see the Using MIDI chapter
of this manual.

To record your first track in DECK II:

* Make sure you have a DECK II Session open, and that a sound
source is hooked up to the audio card inputs. To hear what you are
recording, you should also hook up the audio card outputs to an
amplifier with speakers or a headphone amp.
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¢ Click and drag on the Input selector near the top of the track to select
the audio card input from which you wish to record.

* Record-enable the track (or tracks) upon which you wish to record
by clicking on its Rec button. This will turn the Rec button red, and
the Track VU will now be an input level VU. This is how the chan-
nel should look:

* Begin playback of your source signal. Set the input level so that the
channel VU meter registers a high signal level, with no clipping. The
incoming signal should keep the VU meter as close to the top
without turning the clip light on. The clip light indicates that audio
recorded at this level will be distorted. Turn off the clip light by
clicking on it, and adjust your signal.

Note: Multiple tracks can be recorded at once, but no two record tracks

cannot be set to the same input. If you attempt to do this, DECK will
warn you and prevent you from putting the track into record.
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Important: If you have an AV machine, Audiomedia card or MediaTime card, you
will set the input level by using the Input Level pop-up on the Options
menu. If you have any other audio card, you will need to adjust the
level of your signal source to the correct volume.

* Adjust the monitor level of the track you're recording by sliding the
channel fader up or down.

When you have a track record-enabled, the track volume fader
adjusts the volume level for monitoring the track. It does not change
the record level. (When the track is not record-enabled, the track
volume fader adjusts the output level of any audio that is already on

the track. This volume can be set to a different level than the input q
monitor volume, which is useful during punch-in recording.) You

should use the track faders to adjust playback volume to your liking,

but always make sure that the input level is set so that the channel

VU meter registers a high signal level, with no clipping.

* When you are ready to record the track, click on the tape transport’s
Record button, and then on the tape transport’s Play button. Both
will be highlighted:

As soon as you click on the Play button, DECK IT begins recording.
DECK I will record until you hit the tape transport’s Stop button (or
until you run out of hard disk space).

* When you are done recording, click on the tape transport's Stop

button.

You have recorded the first track. You are now free to rerecord it,
punch in on it, record another track, or edit the recorded track in the
Track window.
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To hear the track you just recorded:

* Click on the tape transport’s Return-to-zero button, and then on the
Play button.

Your recorded track is now being played back, and you should see
DECK IT's track VU registering audio level. To adjust the output
level of your recorded track, slide its volume fader up (louder) or
down (quieter). To pan the track left or right in the stereo image,
adjust the track’s pan fader.

If you are satisfied with the track you just recorded, you can now go
on to recording the next track. If you wish to re-record the track,
repeat the procedure you just used. If you wish to re-record only a
few select areas of the track, see the information about punch in/
punch out recording, later in this chapter.

You are now ready to record your second track.

Recording the Second, Third, and Fourth Tracks

The steps you follow to record your second, third, and fourth tracks
are exactly the same as those you followed for the first track. The only
real difference is that you will be recording these tracks while listening
to other tracks you've already recorded. For this reason, there are
some extra steps you'll need to take to set the playback levels of the
previously recorded tracks.

To record your second, third, and fourth audio tracks in DECK II:

* Record-enable the track upon which you wish to record by clicking
on its Rec button. This will highlight the track's Rec button.
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* Begin playback of your source signal (your instrument, microphone,
etc.). Set the input level so that the track VU meter registers a high
signal level, with no clipping.

Important: If you have an Audiomedia or MediaTime card, you will set the input
level by using the Input Level pop-up on the Options menu. If you
have any other audio card, you will need to adjust the level of your
signal source to the correct volume.

* Adjust the relative monitor levels of the all tracks by sliding their
volume faders up or down.

The track fader adjusts the volume level for monitoring each track,
including the track you are about to record. It does not change any
record level. You should use the track faders to adjust the playback
volumes of every track to your liking. If you wish to make a dry run
through the material in order to set the relative volumes of the
recorded tracks (and the track you are about to record), you can click
on the tape transport’s Play button. This will play all recorded
tracks, and allow you to audition the track you are about to record
(without recording it). This is the best way to set the monitor levels
of the different tracks before recording.

* When you are ready to record the new track, click on the tape
fransport’s Record button, and then on the tape transport’s Play
button. Both will be highlighted.

As soon as you click on the Play button, DECK II begins recording.
During the recording process you will hear a mixture of all recorded
tracks and the track you are recording. DECK II will record until

you hit the tape transport’s Stop button (or until you run out of hard
disk space).

* When you are done recording, click on the tape transport’s Stop
button.

To hear the tracks you have recorded:
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* Click on the tape transport’s Return-to-Zero button, and then on the
Play button.

Your recorded track is now being played back, and you should see
DECK II's track VU meters registering audio level. To adjust the
output levels of your recorded tracks, slide the track faders up
(louder) or down (quieter). To pan the tracks left or right in the
stereo image, adjust the tracks” pan faders.

Important: If you are running OSC's METRO sequencer, you can record MIDI
and digital audio simultaneously. To do so, simply record enable
your DECK track and press the record button in the DECK II Transport
window. Then switch to METRO and record your MIDI track. DECK
I will automatically record in the background, and when you return to
DECK you will see your new tracks in the Track window. For more
information, see the Using MIDI chapter of this manual.

A Note about Bouncing Tracks and Virtual Mixing

By nature, multitrack recording imposes certain limitations on the
producer. All tape recorders have a fixed number of available tracks,
and at some point those tracks will be full. In traditional tape record-
ing, one remedy for this problem has always been ‘bouncing,” or
mixing together of existing tracks to open up more recording tracks.
Like analog tape machines, DECK II offers you the ability to bounce
tracks, but DECK II’s bounce functions differ from tape in three major
ways: DECK I accomplished all of its bouncing in the digital realm
(introducing no noise or signal degradation), DECK I allows you to
maintain an unlimited number of source tracks, and DECK II can
bounce four tracks to one or two tracks (so you don't need to keep a
destination track open for the bounce). DECK II bouncing functions
are handled in the Track window, where visual marking and control
greatly speed the process. For specific information about bouncing
tracks, see the Bounce to Clipboard commands explained in Chapter
5 and in the Reference chapter of this manual.

One of the advantages of using a digital workstation is that you are not
limited to a fixed number of tracks. While DECK II is limited by
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computer speed and data access rate to four play tracks, you can
record an infinite amount of tracks and move them to work tracks.
Work tracks store all information including automation for each track.
You can use the virtual mix feature to mix work tracks and play tracks
together. Your only limit to the number of tracks is hard disk space.
For specific information about virtual mixing, see the Virtual Mix
command explained in Chapter 7 and in the Reference chapter of
this manual.

Location Times

On the right-hand side of the DECK II Transport window you see two
sets of six pop-up menus. The six pop-ups on the left are DECK IIs
Location Time buttons. The Location Time pop-ups look like this:

For those familiar with multitrack recording devices, these are the
DECK II's “autolocate memories.” Each of these six pop-up menus
gives you access to the full list of all location times you have ever
stored. The arrows directly to the left of each menu are the controls
that you will use to record and playback location times. To use the
location time menus and buttons, follow these steps:

To set location times using the Location Time arrow buttons:

* Hold down the command key and click on the arrow button directly
to the left of the position that should hold that time.
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You have now recorded a location point. Note that you can record
location positions while a Session is playing, or you can scrub or
play the Session to a particular spot and record the time button while
playback is halted.

Hint: You can automatically record Location Times simply by pressing the
Enter key on your Mac keyboard. All location times are added to the
Location Times pop-up, and may be loaded onto any location position.

To recall location times using the Location Time arrow buttons:

* Click on the arrow button directly to the left of the position to which
DECK II should locate.

You are immediately located to that position. Whenever you click
on that arrow button (or select a location on the pop-up) you will
immediately be ‘popped’ to its time. This is true whether DECK II is
playing back or stopped. Note that you can pop to locate positions
while a Session is playing or while playback is halted.

Hint: All locations times also store the current loop/punch Start and End
times. To recall a location time with its Begin and End times, just
hold down the control key when you click on a Location Time arrow
button.

Hint: As with most pop-up menus in DECK II, you can rename the item that
is currently visible in the pop-up by holding down the command key
and clicking on that pop-up. When you do this, a dialog will appear
that allows you to type in a new name for the location time.

Loop (Rehearse) Mode

Most quality multitrack decks have a special ‘rehearse’ or ‘loop’ mode
that lets you define a section of your recording, and automatically loop
playback of that section over and over. This is particularly useful for
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practicing along with a short section of a session in preparation for
recording a track, or for evaluating potential loops for arrangement

purposes.
DECK I also has a loop mode designed just for these purposes, but
unlike a tape machine, DECK II loops from loop end to loop beginning

seamlessly, with no rewind time. Although there are many ways to
use DECK's loop mode, here are basic instructions:

To set loop begin and end times, and turn on loop play:

* Scrub the small ‘begin’ tape counter to the desired loop start point.

You can scrub the counter by clicking and holding down the mouse
over the counter. When the cursor changes to right/left arrows,
drag to the right (forward) or left (backward) to set the exact point in
the recording. Scrubbing this way will play audio as the counter
moves. If you wish to slide the counter value without hearing audio
hold down the shift key. Then click and drag the mouse over the
‘begin’ tape counter. To set the punch time with the keyboard, hold
down the command key and click on the begin counter. Then use
the ensuing dialog to set your time.

’

Hint: You can also click on the ‘begin->" and ‘end->" buttons to pick up the
current master counter time. This is useful if you wish to set the loop
begin and end times while a Session is playing back. After the times
have been picked up, you can fine tune them by using the scrubbing
procedure described in the previous paragraph.

Hint: Command click on the ‘begin->’ and ‘end->’ buttons to transfer their
times to the Transport window's master counter.

* Scrub the small ‘end’ tape counter to the desired loop end point.

You have now set the begin and end times of the loop.
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Hint: All locations times also store the current loop /punch Start and End
times. To recall a location time with its Begin and End times, just
hold down the control key when you click on a Location Time arrow
button.

* Click on the Loop button to highlight it.

Loop mode is now turned on, and the portion of the Session between
the begin and end times will play back repeatedly.

Note: Loops may not be shorter that 0.5 seconds. If you try to set a loop that
is shorter that half a second, DECK II will automatically turn off the
loop.

* Click on the tape transport’s Play button to play back the loop. Click
on the Stop button to halt playback.

Hint: There are a number of tools that greatly enhance the usability of Loop
mode. You can automatically move the selection range (in the Track
window) to the begin and end counters using the Set Punch Times
From command on the Option menu'’s Display Tools submenu (or
move the other direction using the Set from Punch Time command).
You can also use other commands on this submenu to select automati-
cally the waveform range between the begin and end times indicated
in the Transport window. (See the Reference chapter of this manual
for more information.) Finally, when the Track window is open, you
can press the 'C' key at any time. This issues a Cue command, which
automatically sets the Transport window's start and end times to
match the current selection and turns on Loop mode.

Hint: Remember, Location Times store the loop begin and end times as well
as the main counter time. To recall a location time with its loop begin
and end times, hold down the control key when you recall that loca-
tion.
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Automated Punch In/Punch Out

Although sometimes a recorded track is perfect after the first try, in
most situations at least part of the track will need to be recorded again.
Picture, for example, a five-minute vocal track that has only a single
line with a mistake. As the engineer on this session, you would wish
to make one more recording pass and replace only a small piece of the
recorded track. In traditional recording, this process of piecemeal
replacement is called “punch-in’ recording.

To punch in a small section of a track, a second person used to be
required. This person would watch the time on the track, and physi-
cally punch the record button at the start of the section to be replaced.
When the end of the replacement section was reached, the person
would punch the record button out to prevent erasing any section of
the track that should be kept. This was a risky process, and an unclean
punch often damaged good sections of the track. For this reason, high-
end multitrack recording decks began to offer automated punch-in and
punch-out points. These points could be set carefully and stored, and
at the time of replacement recording, the punch in and punch out
points were handled automatically.

DECK II offers automated punch-in/punch-out recording for the same
reasons. Here’s how it works:

To punch-in and punch-out a track section automatically:

* Scrub the small ‘begin” tape counter to the desired punch-in point.
This will be the point where replacement recording automatically

begins.
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You can scrub the counter by clicking and holding down the mouse
over the counter. When the cursor changes to right/left arrows,
drag to the right (forward) or left (backward) to set the exact point in
the recording. Scrubbing this way will play audio as the counter
moves. If you wish to slide the counter value without hearing audio,
hold down the shift key. Then click and drag the mouse over the
‘begin’ tape counter. To set the punch time with the keyboard, hold
down the command key and click on the begin counter. Then use
the ensuing dialog to set your time.

Hint: You can also click on the ‘begin->" and ‘end->’ buttons to pick up the
current master counter time. This is useful if you wish to set the loop
begin and end times while a Session is playing back. After the times
have been picked up, you can fine tune them by using the scrubbing
procedure described in the previous paragraph.

* Scrub the small ‘end” tape counter to the desired punch-out point.
This will be the point where replacement recording automatically
ends.

You have now set your punch-in (begin) and punch-out (end) times.

* Click on the Punch button to highlight it.

Punch mode is now turned on, and the portion of the Session
between the begin and end times will be recorded automatically on
the record-enabled track on your next recording pass. No other
section of the track will be replaced.

¢ Click on the tape transport’s Play button.
* As the existing track plays, monitor (play) your new source signal

(your instrument, microphone, etc.). Set the input level (or the

source level if you have Pro Tools or Sound Tools II) so that the
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replacement signal meter level approximately matches the meter
level of the signal on the track.

Important: When you are punching in, you can set the monitor level of the existing
track to a different level than the monifor level of the incoming signal.
(Remember, monitor level is how loud you hear it, while input level is
how loud it is actually recorded.) When a track is not record-enabled,
the track’s volume fader adjusts the playback (monitor) level of that
track. When a track is record-enabled, the track’s volume fader
adjusts the playback (monitor) level of the incoming signal. Switch
record enable on and off to match these two levels.

* Adjust the relative monitor levels of the other tracks by sliding their
volume faders up or down.

* When you are ready to punch into the track, click on the tape
transport’s Record button, and then on the tape transport’s Play
button. Both will be highlighted.

DECK II begins playback, and you will hear both the existing track
and your new input signal. Remember, however, that only the track
section between the counter’s begin and end times will be recorded. When
playback hits the punch begin point, recording will start automati-
cally and you will no longer hear the original audio track. Recording
will continue until the punch end point, at which time you will hear
the original audio track again. Once you have reached the punch-
out point (end), your punch-in record run is complete.

* When you are done, click on the tape transport’s Stop button. Next
click on the tape transport’s Return-to-zero button, and then on the
Play button to hear what you recorded.

Important: Remember, DECK Il is a non-destructive recorder, so when you
punch-in new material, the old material is not deleted. This means
you can open the Track window after you have punched-in and view
your newly recorded range. If you don't like the new take, you can
delete it and stretch the old region to reveal the original take. (See the
Visual Waveform Editing chapter of this manual for more informa-
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tion). After you have made your final decisions regarding takes, you
can automatically delete the unused takes using the Compact Session
command on the file menu. Before you compact your Session, make
sure you understand how Compact Session functions. For more
information, see the Reference chapter of this manual.

A Note About 'Disk Too Slow' Messages

If you are running DECK II with multiple slave programs on a single
Macintosh, or if your Macintosh or hard disk is slow or older, you may
encounter the 'Disk Too Slow' message in DECK II. This is not the
kiss of death for your system. There are a number of simple adjust-
ments you can make that will generally remedy this problem:

Increase the size of your disk buffers: Often you will get this mes-
sage because your disk is really a bit slow. To compensate for a slow
disk, you can increase the size of your disk buffers. This decreases the
number of disk reads that need to be made, thereby decreasing the
total number of seeks required. Larger sections of audio are loaded
during disk reads, and overall strain on your hard disk is reduced.
The only drawback may be a slight increase in the delay between
pushing the play button and begin of playback. To increase the size of
your disk buffers, choose the Memory & Storage command on the File
menu's Preferences submenu. This dialog appears:

— Memory & Storage &=
Pre-allocate entire record drive:

@ Never

O Rlways

() When recording 2 or more tracks

Disk buffer size: Kbgtes
Automation event RAM: (64 |Kbytes

lu | Cancel |
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Use this dialog to enter a larger disk buffer size. Try 256K first, then
increase it if that doesn't improve disk performance sufficiently.
Remember, when you increase your disk buffer size, you should also
increase the amount of RAM allocated to the DECK Il application by
four times the size of the buffer size increase (there are four disk
buffers). For example, if you increase your disk buffer size from 256K
to 512K, you should allocate 1000K more RAM to DECK II. (To do
this, select the DECK IT application in the Finder and choose the Get
Info command on the File menu).
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Decrease the update speed setting for background programs: DECK
Il offers a special 'Update speed during playback' preference available
under General on the File menu’s Preferences submenu. This prefer-
ence allows you to set how much time is available for other programs
to update in the background behind DECK II audio playback. A
setting of '1" allows the background program to update as often as
possible. This setting makes it easier to see screen activity in back-
ground programs. A setting of '10' prevents background programs
from updating during playback, allowing DECK II to monopolize your
display. This setting does not affect the performance of the back-
ground program at all. It only affects screen drawing. A setting of '5'
is suggested. If you are running METRO in the background, and you
experience ‘Disk Too Slow’ messages, you may want to set this to '8' or
10" to decrease the background strain on your Macintosh CPU.
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Turn off the 'Stop playback if disk is too slow' preference: This is a
particularly useful preference available under General on the File
menu's Preferences submenu. The 'Stop playback if disk is too slow’
preference allows you to set how carefully DECK II checks to see if
your drive is too slow. If you attempt to play four tracks from a very
slow drive, DECK may not be able to play them without a small hack'
or 'skip' in playback. Usually this skip is so subtle, you will not be able
to hear it. When this preference is turned on, DECK Il will put up a
warning dialog and immediately stop playback any time disk perfor-
mance might cause a playback skip. When this preference is turned
off, DECK II will continue to play back, even if a slight skip is possible.

Hint: If you are mixing live directly to DAT or a mastering medium, then
turn this on. It guarantees that audio playback will be supervised and
stopped before any skip might occur. If you are simply editing sound
and you plan to mix to disk (which is the suggested way to use DECK
II), then leave this preference turned off. Almost all skips will not be
audible, and even if you do hear one, it will not appear in the master .
file that results from a mix-to-disk.

This concludes the Creating and Recording chapter. For information

about specific waveform editing tasks, see the Chapter 5 of this

manual. To learn about synchronizing, mixing and mastering, see <
Chapter 7. For exact information about DECK II's windows and menu
commands, see the Reference chapter of the manual.
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VISUAL WAVEFORM EDITING -
THE TRACK WINDOW
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Introduction

This chapter of the DECK II manual focuses on the specific tasks you'll
need to understand, in order to get the most out of DECK IT's visual
waveform editing environment: the Track window. The Track
window offers access to the heart of DECK II's editing features. You
will use the Track window to slip tracks, arrange audio, redefine
regions, place existing audio, create and edit visual automation
envelopes, spot sound to picture, bounce tracks, create work tracks
and more. The Track window is really where you will find DECK II's
workstation power, and although you do not need to use the Track
window to record and mix tracks, you will miss most of DECK II's new

features if you don't understand how DECK IT's Track window works. a
It is always time consuming to learn a new interface, but the DECK II

Track window interface is simple to grasp, and very open-ended in its

possible applications. It is not designed for music alone — there are an

equal number of tools available for audio post-production and

QuickTime sync. Time spent learning the DECK 1T Track window will

be well worth it.

Placing Existing Audio Files and Regions

The simplest task you will generally need to perform involves placing
audio files that already exist, and organizing them for playback. In
this way, you can think of the Track window as a 'page layout’ pro-
gram for sound. It lets you take any audio file (or region within a file)
and stick it anywhere in time. There are an unlimited number of
tracks, so there is no limit to the number of tracks you can build.
(Although only the top four tracks play, you can always bounce four
tracks to one or use virtual mixing, allowing you to create mixes that
are hundreds of tracks deep.)

Important: DECK II makes extensive use of the Clipboard, and you will use the
Clipboard to add new audio to the Track window. Remember, DECK
only uses the Clipboard to keep track of the files you are adding or
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editing, it does not put the actual audio data on the Clipboard. This

means that you will not need large amounts of RAM to add audio files
to the Track window, and it will not take long.

To add existing audio to a track:

* Creale a new Session or open an existing Session.

This will be the Session to which you are adding audio.

e Choose the Add Audio to Clipboard command on the File menu.

This dialog appears:

I‘F_\.l Sound FH VI

D FH Jar W Delay

0 FH Lo Brk Drm Chorus
D FH Motor/Alarm

0 FH Pipebell

0O FH Robot Arm

D) FH Spaciness

D FH Steam 1

g
v \.!

:

Sample Rate: 44100

Show: ISD 1 S0 11 [ AIFF

o 660AL

i £inct ]

Desktop

] dpoen —]

[Play Region)

Channels: |

Bit Depth: 16
Comments:
This file needs to be
converted.

Rote: Memz marked with "eTe”
will be translated 10 5 compatible
format. This will use extra cisk

fpace, and may take 3 moment

q Add Region !

Regions in FH Jar W Delay
*Fe FH Jar W Delay

Show: [J Regions Loops
Region Length: 1.00
[JLoop Audition

Current Playlist

*T+ FH Spaciness o
=T FH Fast Police Siren

+T+ FH Jar W Delay

» Use the file selector box in the upper left corner of this dialog to find
and select the soundfile you want.

When you select a soundfile, you will see the pertinent information
about it, including the sample rate, number of channels and bit depth.
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DECK IT supports mono and stereo 8- and 16-bit Sound Designer,
Sound Designer 11, and AIFF soundfiles. If you select a soundfile that
is not supported, you will see a message stating "This soundfile cannot
be converted" in the comments area. DECK II does not yet allow you
to add soundfiles with sample rates other than 11.025, 12, 22.050, 24,
44.1 or 48 kHz.

Note: QuickTime movies that contain audio at most sample rates can be
imported using the Import Movie command on the QuickTime menu
(although the best results will be achieved when the QuickTime audio
is at 22050 Hz or 11025 Hz). This command makes it possible to bring
QuickTime movie audio directly into the DECK TI Track window.

* Use the file region box in the upper right corner of this dialog to
highlight the desired region within the current soundfile.

Once you select a soundfile in the left-hand selector list, you will see a
list of the audio regions and loops that are in that soundfile. An audio
region marked with a *F¢ represents the entire soundfile. Regions
marked with eRe are simple audio regions, and those marked with
*Le are loops (AIFF files only). You can audition any file, region or
loop by selecting it and clicking on the dialog's Play button. You can
hear the audio looped by checking the loop audition box.

* To add the highlighted region, click on the dialog’s Add Region
button.

This will add the selected region to the Current Playlist in the lower
right hand corner of the dialog. At any time you can remove items
from the current playlist by selecting them and clicking on the Remove
button.

* Continue selecting the files, regions and loops you wish to add.
Then click on the Done button.

This will add all of the items in the current playlist to the Macintosh

Clipboard for pasting into DECK II's Track window. Remember, all
files, regions or loops which are not mono or do not match the current
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Session's sample rate and bit depth will be converted to match. This
may take some time and disk space, because DECK 1II is making copies
of this data.

After a moment you will be returned to the DECK II Track window:.

* To place one newly added sound at a specific place in time, click at
that time in the Track window waveform area (to put down an
insertion point) and choose one of the Paste commands. The regions
will be pasted into the track window at that point.

If you are adding stereo or more-channel regions, make sure that your
insertion point or selection range covers two or more channels. Then
when you paste, all regions that contained more than one channel will
be pasted into the Track window with all of their channels in phase.

* To place the newly added sounds on new tracks, make sure that no
insertion point or range is selected, then choose one of the Paste
commands.

You can use the Edit menu's Deselect command to make sure nothing
is selected. After the paste, you will see one (mono) or two (stereo)
new playlists located on tracks 1 (and 2). They will be called "Clip-
board 1" (and "Clipboard 2"). All existing audio playlists will be
pushed downwards. For example, in the case of the stereo add de-
scribed above, the playlists formerly loaded on tracks 1 and 2 will now
be pushed down to positions 3 and 4. Playlists formerly loaded on
tracks 3 and 4 will now be pushed down to the work track area.

¢ To place multiple added sounds at different points in time, open
the Regions window. Move the window to a spot where you can see
both it and the Track window. Click and hold on the region you
wish to spot. The cursor will change to a left arrow. Drag the cursor
to the spot where the audio should be and let go of the mouse. You
can spot audio exactly by observing the current time in the Track
window. Repeat this process until you have placed all audio.

Hint: You can also use the Load Audio File command on the File menu to
load an existing Sound Designer II mono audio file directly onto a new

.
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track, but this command offers no real options for file and region
importing. For most tasks, the Add Audio to Clipboard is a much
more useful command. The Load Audio File is most useful for
owners of DECK 1.0x. The Load Audio File command offers a one-
step solution for loading tracks from DECK 1.0x Sessions directly into
DECK IL

Moving and Renaming Track Playlists

The DECK II track window uses track position to determine which
playlists will play back. There are four play tracks, which are num-
bered 1-4 in their Track Label / Drag areas. All other tracks (there is no
maximum number) are work tracks, as indicated by the letter "W"
which appears in their Track Label/Drag areas. Playlists on work
tracks do not play back. In order to play back a playlist that is on a
work track, you must move the playlist to a play track. For this reason,
it is important that you understand how to change the position of the
different tracks.

There are a number of easy solutions for selecting and manipulating
tracks on the 'whole track’ level.

To move a track playlist from one track to another:

DECK II offers two methods of moving a track playlist from one track
to another. The simplest method uses the Playlist Pop-up menu.

* Click and hold on the playlist name of the destination track. You
will see a pop-up listing all playlists currently in your Session. Select
the new playlist. When you let go of the mouse, the new playlist will
appear on that track.

The playlist pop-up functions exactly like the pop-up at the bottom of
each mixer module in the Mixer window. You may also change
playlist position manually using the following method:

¢ Click on the track’s Label /Drag area to select the track.
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The track will be highlighted to indicate that it is selected. When a
track is selected in this fashion, any Edit menu command can be
executed on the track. When track 1 is selected, for example, it should
look something like this:

¢ Click and hold on the Label /Drag area for the selected track. The
mouse cursor changes to a left-facing arrow.

¢ Drag the selected track upward or downward to its new position,
then let go of the mouse.

As you drag the track, you will see a bright horizontal line highlight-
ing the destination spot. This line will appear underneath the arrow
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cursor between any two existing tracks as you drag the mouse up and
down. When you let go of the mouse, the track will be inserted exactly
where the highlight line appeared.

Hint: If you are using this method to move tracks from position to position
in the Track window, you may find it easier to accomplish your tasks
when the tracks are set to 'short' height. Click on the Track Size button
to toggle between track display modes.

To cut, copy and paste entire track playlists:
* Click on the track’s Label /Drag area to select the track.
The track will be highlighted to indicate that it is selected. When a

track is selected in this fashion, any Edit menu command can be
executed on the track.

* Choose the Cut or Copy command on the Edit menu.

If you choose Cut, the entire track's playlist will be removed and
placed on the Clipboard for pasting into another track position. If you
choose Copy, a copy of the entire track’s playlist will be placed on the
Clipboard for pasting into another track position.

* Click on any track's Label /Drag area to select the track as the
destination.

Track playlists are never replaced when you use DECK II's Paste
command. The pasted track playlist is always placed on the track
below the selected destination track.

To rename a playlist:

* Click on the track's Label /Drag area to select the track.

The track will be highlighted to indicate that it is selected. When a

track is selected in this fashion, any Edit menu command can be
executed on the track.
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* Choose the Rename command on the Edit menu. This dialog will
appear:

Piagnata s

¢ Type in a new name for the playlist, then click on OK.

The Track window will appear immediately showing the playlist with
the new name.

Shortcut: You can also rename track playlists by holding down the command
key and clicking on the Track Playlist pop-up. This method offers a
simple way to change the name of the current item in most of DECK
II's list pop-ups. The same shortcut works with Location Times and
Mixer States in the DECK II Transport window.

Track Window Navigation

Before you can really edit audio regions and waveforms, you will need
a basic understanding of the tools you will use to navigate within the
Track window and configure the waveform display area.

To change the waveform display magnification:

* To magnify (zoom in on) the current waveform display, click on the

Magnify button:
9

The waveform display will be stretched outward (to the right) as you
zoom into the left edge of the display. Click on the button again to
zoom in more,

—
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¢ To demagnify (zoom out on) the current waveform display, click on
the Demagnify button:

G¢

The waveform display will be squeezed inward (to the left) as you
zoom out on the left edge of the display. Click on the button again to
zoom oul more.

Hint: Hold down the command key and click on the Magnify or Demagnify
button to zoom all the way in or all the way out, respectively. Use the
option key with these buttons to (de)magnify 2X and both the shift and
option keys to (de)magnify 4X.

* To auto-zoom to show the only the current selection, first select a
range or region.

¢ Click on the Fit Selection button:

* :#

The waveform range or region you had selected is auto-zoomed to fill
the display. This is a particularly useful tool for display manipulation
when accurate waveform editing is required.

Hint: Option click on the Fit Selection button to center the display on the
beginning of the selected range or region. Command click on the Fit
Selection button to center the display on the end of the selected range
or region.

To magnify the vertical display of waveforms:

e (Click on the up arrow button to magnify low-level signal:
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This will only magnify the display of the waveform, not the actual
audio data. If you wish to alter the disk data to increase the actual
level of the audio, use the Normalize command explained in the
Destructive Effects section below.

* Click on the down arrow to return the display to its normal resolu-
tion.

To store view memories:

* Set the waveform display so that you are viewing the range you
desire at the magnification you wish.

¢ Hold down the command key and click on any of the four View
Memory buttons:

304

You have now stored the current waveform view on that view
memory.

* To recall the stored view, simply click once on the view memory
button.

This immediately recalls the view you stored on that button. Remem-
ber, view memories are saved with the Session, and will be present the
next time the Session is opened.

Important: The DECK TI magnify and Fit Selection tools allow you to zoom in and
out in steps that are smaller than the steps between display resolu-
tions. If you are not paying attention, you may end up with the
display adjusted to an odd resolution. To pop back to the resolution of
your choice, select that resolution on the Axis Resolution pop-up as
described later in this chapter.

o
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To toggle track size, waveform drawing, and text labels:

* Click on the Track Size Button, Waveform Draw Button, or Track
Text Button to toggle track size, waveform drawing, or text labels on

and off respectively:

The Track Size button toggles the waveform display between three
display modes. Tall display is best for locating zero points in a wave-
form, while medium display is best for waveform range or region
editing, and short is quite useful for track shuffling. The Waveform
Drawing button toggles the drawing of waveform data on and off.
You will want to have the waveform drawing turned on when you are
editing audio ranges, but it is often helpful to turn waveform drawing
off if you are recording tracks, or arranging large numbers of regions.
(Screen redrawing is faster when the waveforms are not drawn, and
overviews for newly-recorded tracks are not built unless Waveform
drawing is turned on.) The Track Text button allows you to turn the
region name labels on and off. Turning them off sometimes helps to
‘unclutter’ the display when you are zoomed way out.

Recording Directly into the Track Window

DECK IT's Track window allows you to record directly into any of the
four playback tracks. The process you will follow to accomplish this is
quite simple, but in most situations you will also need to look at the
DECK II Mixer window VU meters to view the level of the incoming

signal.
To record directly into the Track window:

* Make sure you have a DECK II Session open, and that a sound
source is hooked up to the audio inputs. To hear what you are
recording, you should also hook up the audio outputs to an ampli-
fier with speakers or a headphone amp.
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* Click and drag on the Input selector pop-up to the right of the
playlist name to select the audio input from which you wish to
record.

* Record-enable the track upon which you wish to record by clicking
on its R (Record) button. This will turn the R button red.

* Choose the Mixer command on the Windows menu to bring the
Mixer window to the front.

The Track VUs will now be input level VUs. This is how the track
should look:

O
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* Begin playback of your source signal. Set the output level of your
source so that the track VU meter registers a high signal level, with
no clipping. The incoming signal should keep the VU meter as close
to the top without turning on the clip light.

Important: If you have an AV machine or an Audiomedia or MediaTime card, you
will set the input level by using the Input Level pop-up on the Options
menu. If you have any other audio card, you will need to adjust the
level of your signal source to the correct volume.

* Adjust the monitor level of the track you're recording by sliding its
Mixer window track fader up or down.

When you have a track record-enabled, the track volume fader
adjusts the volume level for monitoring the track. It does not change
the record level. (When the track is not record-enabled, the track
volume fader adjusts the output level of any audio that is already on q
the track. This volume can be set to a different level than the input
monitor volume, which is useful during punch-in recording.) You
should use the track faders to adjust playback volume to your liking,
but always make sure that the input level is set so that the channel
VU meter registers a high signal level, with no clipping. Now that
you have set the level of the incoming signal, you can close the Mixer
window and record that same signal again without watching the VU
meters.

* Choose the Track command on the Windows menu to bring the
Track window to the front.

* When you are ready to record the track, click on the tape transport’s
Record button, and then on the tape transport’s Play button. Both
will be highlighted:

As soon as you click on the Play button, DECK II begins recording.
DECK Il will record until you hit the tape transport’s Stop button (or
until you run out of hard disk space).
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* When you are done recording, click on the tape transport’s Stop

button.

You have recorded the track directly into the Track window. After a
moment, the waveform overview will be built and you will see the
new audio. You are now free to rerecord it, punch in on it, record
another track, or edit the recorded waveform.

Hint: There is a simple shortcut for punch-in recording (and loop rehearsal)
directly from the Track window. To punch-in on a track in the track
window, just select the range you wish to re-record, then choose the
"Set Punch Time From" command on the Option menu's Selection
Tools submenu (or hold down the command key and press R). Your
selected range is automatically transferred to the Transport window.
To punch-record the range, just click on the Punch mode icon in the
Transport window, and record the track.

Basic Range Mode and Object Mode Editing

DECK II's Track window has two fundamental editing modes: Range
mode and Object mode. Range mode allows you to select waveform
ranges by dragging the mouse across those ranges. Selected waveform
ranges can be edited in a number of ways. Most of the edits you
would perform in Range mode pertain to defining pieces of an audio
track as regions, cutting and pasting small portions of longer audio
regions, and fading or crossfading sections of audio regions. Object
mode is designed for wholesale arrangement of existing regions, and
general trimming and placement functions. On a simple level you can
think of Range mode like Macintosh 'painting’ and Object mode like
Macintosh 'drawing.’ Range mode lets you grab any piece of any
waveform on any track, and slice or copy that piece to create or alter a
region. Object mode lets you select groups of regions and move those
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regions for the purposes of songwriting, effects spotting, or general
organization. You can't select anything smaller than one region in
Object mode.

Range and Object mode are at the heart of the DECK II Track window
editing functions. All editing you perform will be done in one of these
modes. Here are basic instructions for using the two modes. Don't
forget to review the key command information immediately following
this section, because key commands play a major role in expanding the
power of the DECK 1I edit modes.

To select and edit a waveform range:

* Choose the Track command on the Windows menu to open the a
Track window.

* Click on the Mode Selection icon to make sure you are in Range
mode. It should look like this:

The Mode Selection icon toggles between Object mode (the hand) and
Range mode (the selected waveform).
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¢ Click and drag the mouse over any waveform area. Then let go of
the mouse button. Your Track window should look something like
this:

i SurrealScape: Tracks BNy
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You have now selected a waveform range. Note that it can cover any
number of tracks and any amount of time. You can now edit the
selected range in a number of ways. If you click and drag anywhere
within the selection, you can 'tear off’ the selected range and place it on
any track at any time. You can accomplish the same thing by choosing
the Cut command on the Edit menu, and then placing an insertion
point anywhere in the Track window to paste the selection. You can
also delete the selected range simply by hitting the Delete key on your
Macintosh keyboard. If you just want to define the selected range as a
new audio region (for later arrangement in Object mode), you can
select the Slice command on the Edit menu. This will create new
regions out of the selected range 'in place,’ so no overall change in
timing or audio placement occurs. You can also perform destructive
effects on audio ranges.

Hint: There are a number of key commands that greatly enhance the Range
mode ‘drag-edit’ functions. Read about them in the next section.
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To object-select and edit a region:

* Choose the Track command on the Windows menu to open the
Track window.

* Click on the Mode Selection icon to make sure you are in Object
mode. It should look like this:

The Mode Selection icon toggles between Object mode (the hand) and
Range mode (the selected waveform).

* Click the mouse on any single waveform region. The region upon
which you clicked in the Track window should look something like
this:

You have now selected a waveform region. You can hold down the
shift key and click on another region to add that region to the selection.
Note that DECK II allows you to have discontiguous (non-touching)
regions selected, which can be very useful for ‘checkerboard-style'
editing and destructive processing. You can now edit the selected
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region in a number of ways. If you click and drag anywhere within
the region, you can drag and place it on any track at any time. You can
accomplish the same thing by choosing the Cut command on the Edit
menu, and then placing an insertion point anywhere in the Track
window to paste the selection. You can also delete the selected range
simply by hitting the Delete key on your Macintosh keyboard. You
can also use the Edit menu's Copy and Paste commands to paste
multiple copies of the region end-to-end (or in any other desired
arrangement). You can also execute destructive effects on all of the
selected regions. To do so, see the Destructive Effects submenu on the
Process menu.

Hint: Note that when you move a region, the data indicator boxes in the
upper right corner of the Track window update to show you the
duration of the region and the start, stop, and current (mouse) posi-
tions. Use these numbers to aid in placing audio at the desired frame,
beat or second. There are also a number of key commands that greatly
enhance the Object mode 'drag-edit' functions. Read about them in the
next section.

Important Key Commands for Advanced Range and
Object Mode Editing

DECK II was designed to allow you to make a vast number of different
edits without changing endlessly from one edit mode to the next.

Most of these types of edits take place with the help of 'modifier keys'
like the command, option and control (ctrl) keys. These keys make it
possible to drag copies; 'stick’ regions to previous regions (or the
carliest possible time); place regions while shuffling subsequent
regions later in time; expand, contract and rotate the selection; and
many other functions. Take the time to learn these functions. If you
plan to edit substantial amounts of audio in DECK II, you will need

these keys.
Space bar: Start and stop playback.
Shift+space bar: Audition the selection only.
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Tilde key (): Switch between Object and Range mode.

Shift+drag: When dragging regions, shift after beginning to drag to constrain the
region to its original start time. This is very useful for editing regions
and keeping them in phase with their original positions.

Option+drag: When dragging regions, drag a new copy and leave the original.
P & gging regy g PY

Command+drag: When dragging regions, hold down the command key before you let
o to 'stick’ the region onto the end of the previous region on the track
(shuffle).

Control+drag;: When dragging regions, hold down the control key before you let go to

slide all regions after the current region later in time by exactly the
length of the current region (shove). G

Arrow keys: In Object mode, these keys shift the current selection in the direction of
the arrow by one region. In Range mode, these keys shift the current
selection in the direction of the arrow by one grid unit.

Shift+arrow keys: In Range mode, hold down the shift key and press the right and left
arrows to expand the selected range later or earlier by one grid unit.

Command
+arrow keys: Physically move the selected object or range left one unit, right one
: unit, up one track or down one track. This is very useful for editing

regions and keeping them in phase with their original positions.

Command+option

+arrow keys: Create a copy of the selected object or range one unit to the left, one
unit to the right, one track above or one track below.

Command+control

+arrow keys: Physically move the selected object or range left one unit, right one
unit, up one track or down one track AND push all later regions on the
destination track later by the length of the region or edit.

+ key: Nudge the selected range or object later by one SMPTE frame.

- key: Nudge the selected range or object earlier by one SMPTE frame.
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Of course, most other standard Macintosh editing key combinations
also apply, and most of the above key commands can be used in any
combination.

Selecting Track Window Time Units and
Managing the Grid

DECK II allows you to adjust any Session to show you all time and
waveforms in seconds, samples, SMPTE frames, or in bars and beats.
You are free to set these units based on the type of editing you plan to
do, and you can reset them at any time without worrying about
altering the timing of your tracks. The different units can be very
helpful, and it is important to understand them, because many Track
window edit functions are unit-oriented. One major reason for this is
the Track window grid, which is extremely useful for many arrange-
ment tasks.

DECK II's smart grid is like an invisible template that automatically
pops your edits to the nearest applicable unit. It's called a 'smart grid’
because it automatically adjusts to the most reasonable units for the
current display resolution. For example, if you have chosen Seconds
as your units, the Track window grid can automatically switch be-
tween minutes, 10 seconds, 1 second, centiseconds, milliseconds and
sample, based on how far in you zoom. The DECK II grid is a particu-
larly important tool for musical arrangement, because it allows you to
do 'drum machine-style' editing of audio regions, and edit general
audio regions to specific tempos. Although you are free to turn off the
grid at any time, it will be worth your while to learn its basic functions.

To select time units for viewing the Session:
® Choose the Track command on the Windows menu.

This brings the Track window to the front.

O — e

DECK Il



* Click and hold on the Axis Units pop-up near the top left of the
Track window. It will look something like this:

Drag to select the units of your choice. Then let go of the mouse
button to make your selection. You have now chosen and set the time
units for the current Session. These units will be saved as a part of the
Session, and when the Session is next opened, it will show all time in
these units. Remember, you can change your chosen units at any time
without affecting the placement of any audio regions.

Note: If you are working in Beat mode, there is a circumstance in which you
may wish to have audio regions stick to their bar and beat placement -
when tempo is changed. If you are using DECK II as a virtual drum
machine (playing individual drum sounds back as regions), then you
will often want to make sure that any tempo changes will adjust audio
region placement to make sure that the regions still start at their
original bar and beat locations. In this situation, changing tempo will
alter where bar and beat boundaries occur in relation to real-time, and
bar /beat start times are considered to be 'relative times' rather than
absolute times." DECK offers a special preference for this type of
editing. If you wish the regions to stick to their bar and beat locations
whenever tempo is changed (in Beat mode), then see the Change
region start times with BPM change preference (under General
preferences on the File menu's Preferences submenu). When this
option is turned on, tempo changes in Beat mode will adjust the
placement of audio regions so that they retain their bar and beat
locations. See Chapter 7 of this manual for more information.
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To turn the Grid on and off:
¢ Choose the Snap to Grid command on the Options menu.
This command allows you to toggle the grid on and off. Note also that

you can toggle the grid on and off by clicking on the Grid button
directly to the left of the Axis Units pop-up:

Click on this button again to turn th d back on.

To jump to a specific display resolution:

¢ Choose the Track command on the Windows menu.
This brings the Track window to the front.

¢ Click and hold on the Axis Resolution pop-up to the right of the Axis
Units pop-up. It will look something like this:

Half Note
ii{ Quarter Note
i Eighth Note
Sizteenth Note |—
32nd Note
.t  64th Note
""" ] 128th Note
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Drag to select the resolution of your choice. Then let go of the mouse
button to make your selection. The Track window waveform area will
immediately adjust to the resolution you selected. This is the fastest
and most accurate way to set the waveform display area to show the
resolution you want. You can now proceed with any edits that should
be based on the current units. Remember, you can use any of the four
Track window view memories to store your current waveform view.

Note: When the resolution is changed, the waveform area is zoomed in or
out at its left side. This may pop the display to an area that no longer
shows the current selection (or shows its center, but makes it impos-
sible to see the start or end of the selection). Remember, regardless of
resolution, you can immediately center the waveform display on the
beginning or end of the current selection. To do so, use the Position at
Beginning (command+[) or Position at End (command+]) commands
on the Option menu's Selection Tools submenu.

Important: The DECK II magnify (zoom) tools allow you to zoom in and out in
steps that are smaller than the steps between display resolutions. If
you are not paying attention, you may end up with the display ad-
justed to an odd resolution. To pop back to the resolution of your
choice, select that resolution on the Axis Resolution pop-up as de-
scribed above.

Hint: To locate to a specific point in the Session, simply click on the time axis
label to jump to that point.

Redefining Regions

Audio regions are the building block of any DECK Session, and the
skills involved in creating and defining regions are some of the most
Important ones to develop. As described earlier in this chapter, a
region can be created in a number of simple ways, from simply 'tearing
off' a waveform range to ‘slicing’ the range on place. Once you have
created an audio region, there is a very simple method to edit the start
and end points of that region. It requires no special mode, and can be
done very quickly.
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To resize an audio region:

¢ Choose the Track command on the Windows menu to open the
Track window.

* Click on the Mode Selection icon to make sure you are in Object
mode. It should look like this:

¢ Click the mouse on any single waveform region. The region upon
which you clicked in the Track window should look something like
this:
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You have now selected the region.
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* Toresize the region, click and hold on any of the four drag tabs to
increase or decrease the size of the region:

While you do this, a square marquis highlights to show you the size of
the region as you change it. You can look at the numeric display in the
upper right corner of Track window to see the current size of the
region. Remember, if you are editing region size with the grid turned

on, the size will automatically be constrained to the grid. q

Note: Remember, an audio region is like a tiny window into the source
soundfile. You can adjust that window to show any part of the sound-
file, but there is no way to make an audio region reveal more data than
is contained in the source soundfile. When you drag a region tab to
resize the region, but the region refuses to grow any larger, this means
you have reached the end of the source soundfile data.

Using Play Tracks and Work Tracks

While DECK II looks like a simple four-track audio recorder and
editor, the concept of 'virtual tracks’ allows you to create mixes that are
many layers deep without bouncing tracks.  You can think of it like
this: DECK allows you to record and arrange an unlimited number of
tracks, but at any time you can choose which four of those tracks will
play. All tracks other than the top four 'play tracks’ in the Track
window are called Work Tracks. Work tracks do not play back - but
they can be mixed together with the play tracks if you have the Virtual
Mix command enabled. Work Tracks store all information about a
playlist, including automation. If you do not have the Virtual Mix
command enabled, you can use work tracks as a visual database of
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potential playback tracks, arrangements, and premix sources. Work
tracks are one of the features that make DECK II powerful.

To move tracks from Play tracks to Work tracks and back:

* Click and hold on the playlist name of the destination track. You
will see a pop-up listing all playlists currently in your Session. Select
the new playlist. When you let go of the mouse, the new playlist and
all associated information will appear on that track.

Note: You can also move tracks manually as described above in the Moving
Playlists section.

Fast Cueing and Auditioning

The DECK II Track window offers a number of shortcut features you
can use to audition specific selections and 'autocue’ a range for loop
evaluation. Here's how they work:

To audition any waveform range or region:

* Open the Track window. Then select the waveform range (Range
mode) or region (Object mode) you wish to audition.

You can select a range or regions on multiple tracks, if you wish.

® Choose the Audition command on the Process menu (or hold down
the command key and press T, or the shift key and press the space
bar).

Your selected range or region(s) will play back. All audio will be
center panned, and automation will be ignored. Note that the
Audition command will play back work track audio, if you have
that audio selected.

Hint: You can set DECK II's Audition command to loop the selected range or
region automatically, or to play the selection a single time. (DECK can
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only loop ranges and regions that are longer than 0.5 seconds.) To
configure the Audition function, see the Loop Audition item in the
General preferences (available on the File menu's Preferences sub-
menu).

To 'autocue' a Session range for loop evaluation:

* Open the Track window. Then select the waveform range or regions
that constitute the portion of the Session you wish to hear in loop
playback.

Regardless of which tracks contain the selection, all tracks will play
back when you begin the cue loop.

* Press the 'C' key on your Macintosh keyboard.

The current selection range is automatically transferred to the
Transport window's begin and end times, and Loop mode is turned
on. You are now ready to hear the loop.

* Press the Play button in the Transport window or the space bar on
your Macintosh keyboard to hear the loop.

The loop will play back repeatedly until you press the Stop button in
the Transport window or press the space bar on your Macintosh
keyboard. To turn off the loop, click on the Loop mode icon in
Transport window (or press Option+C).

Constructive Fades and Crossfades

The DECK 11 Track window offers all of the standard constructive fade
and crossfade functions you would expect in an audio workstation.
Unlike automation envelopes (which physically control the volume or
pan faders) fades and crossfades create new audio data, and place that
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audio data on top of the selected range, without deleting the original
audio data. Crossfades in particular are extremely important sound
design tools, because they let you overlap two audio regions on the
same track, and edit the transition between the two regions so that the
first one fades out as the second one fades in. Normally, this would
require two tracks, but crossfades make it possible to accomplish this
on a single track. This is the kind of range selection you might make to
generate a crossfade between two regions:

If you executed a crossfade in this selection, you would get the follow-
ing results: Region 1 will begin fading out at the beginning of the
selected range, and will be fully faded by the end of the selected range.
Region 2 will begin fading in at the beginning of the selected range,
and will be at full volume by the end of the selected range. The result
of this crossfade would look like this:

Fades and crossfades are usually based on the current selection, but
DECK offers a number of different fade in and fade out shapes, which
also have a great effect on the outcome of any fade or crossfade. Here
is a list of the different shapes, some basic information about their uses,
and some suggestions for combining them.

Important: As you can see above, crossfades are based on audio data that is after
the end of region 1 and other data that is before the beginning of
region 2 in the source soundfiles. If you attempt to create a crossfade
using regions which reference soundfiles that contain no data after the
end of region 1 or before the beginning of region 2, DECK will warn
you that there is no data. You will still be allowed to create the cross-
fade, but DECK will use silence as the surrogate data.
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Fade Out Shapes

=

This curve keeps Region 1 at full volume throughout the crossfade and
then immediately fades it out at the very end of the selection.

)

This curve fades out Region 1 relatively slowly, keeping the amplitude
fairly high. Towards the end of the crossfade, the amplitude drops off
sharply.

"\

Y

This curve fades out Region 1 slightly faster, with the amplitude
slightly lower than the previous envelope. This curve is the same as
the “equal power” curve found in Sound Designer IL

My

This envelope fades out Region 1 with a linear fade curve. It creates a
smooth, even fade out. It is the default curve.

\

A

This curve fades out the amplitude of Region 1 relatively quickly at the
beginning of the crossfade.

7

This curve drops the amplitude of Region 1 even more quickly at the
beginning of the crossfade.
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5

This envelope silences Region 1 at the beginning of the crossfade.

Fade In Shapes

=

This curve brings up Region 2 at full volume immediately at the very
beginning of the crossfade and keeps it there throughout the crossfade.

7

This curve fades in Region 2 quickly in the beginning, reaching full
amplitude fairly early in the crossfade.

>

This curve fades in Region 2 at a moderately fast rate with slightly
lower overall amplitude.

U

This curve fades in Region 2 with a linear fade curve. Itis slightly
slower, with an even amplitude throughout the crossfade. This is the
default envelope.

4

This curve fades in Region 2 slowly at the beginning of the crossfade.
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i

This curve fades in Region 2 even more slowly than the previous
curve.

.

This curve silences Region 2 until the end of the crossfade.

Possible Envelope Combinations:

Here are some combinations of Fade Out and Fade In envelopes that
you may wish to try.

Bordar of Region 1 and 2

Reglon 1

Region 2

LLCETEE (RIS

Selection range Cfassus both regions

Linear Crossfade. A good general purpose crossfade with a smooth,
even transition between Region 1 and Region 2. If volume drops
across the center of the crossfade, try the equal power crossfade.

e

Equal Power crossfade. A good general purpose crossfade, useful in
cases where a linear crossfade seems to create an overall drop in
volume across the splice point.
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o |

Overlap Fade. This combination of curves keeps both regions at full
amplitude throughout the crossfade: Region 2 “jumps in” at the
beginning and Region 1 “jumps out” at the end.

| | (Selection same as above)

Silence. Choosing these two curves will create silence for the duration
of the crossfade. This combination is not particularly useful for most
applications.

Borger of Region 1 and 2

Region 1

Region 2

.

s

Linear Pre-crossfade. This combination of curves creates a crossfade
before the splice point. This will let you maintain the amplitude of the
very beginning of Region 2 instead of fading across it. This is useful,
for example, if there is a strong percussive downbeat at the beginning
of Region 2, that you want to retain.

Selection range extends just up to benin'ninu of Region 2

Selection range t;egins just after end of Region 1
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Linear Post-crossfade. This combination generates the crossfade after
the splice point. It's useful if you want to maintain the amplitude of
Region 1 until it’s very end; in cases where want to keep a strong
upbeat that occurs at the end of Region 1, for example.

To fade or crossfade the current selection:

* Open the Track window and select the waveform range you wish to
fade or crossfade.

This range must cross at least one region boundary. If it only crosses
over the beginning of a region, a fade in is generated. If it only
crosses over the end of a region, a fade out is generated. If it only
crosses over the border between two touching regions, a crossfade in is
generated.

Note: Remember, fades in always begin at the beginning of the region and
fades out always end at the end of the region. This is true even when
you select from well before the beginning or up to well after the end.
This makes it possible to generate fades in and fades out without
requiring that you select exactly from the start or to the end.

¢ Choose the Fade Selection command on the Process menu.

After a few moments, your crossfade will be complete and you will see
itin the Track window. Remember, if there is no audio data in the
source file after the end of region 1 or before the beginning of region 2,
DECK will warn you that no data is available. However, DECK will
allow you to execute the fade anyway, using silence as the missing
crossfade source data.

To set the default fade/crossfade:

* Choose the Set Default Fade command on the Process menu. This
dialog appears:
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Crossfade Out Shapes: Before Splice:
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Crosstade In Shapes:
= s
r— f/'l'/./ _,-} __l After Splice:
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The default fade is the basic fade in and fade out shapes (along with
default durations) that are used when you choose the Fade Selection
command or the Default Fade command. The Fade Selection com-
mand always uses the default fade curves, but creates the fade or
crossfade according to the current waveform selection. The Default
Fade command always executes the fade or crossfade using the default
fade shapes and the default fade durations. This is a very useful
command when you want to create tiny ‘smoothing’ fades or cross-
fades, but you don't want to zoom all the way in to select a tiny range.
The Default Fade command lets you make large waveform selections
that are capable of creating very subtle fades. Whenever you want to
create a fade or crossfade that doesn't use the default fade shapes, use
the Custom Fade command. This command works just like the Fade
Selection command, except it always prompts you to choose your fade
shapes before it creates the fade.

* Set your fade in and fade out shapes, and enter time durations that
will be used by the Default Fade command. Then click on the OK
button.

You have now set your default fade information. Remember, DECK II
allows you to execute fades and crossfades on any number of regions
at one time. When you select multiple regions and choose the Default
Fade command, all selected regions are faded or crossfaded using the
default fade shapes and durations. When you select multiple regions
and choose the Fade Selection command, all selected regions are faded
or crossfaded using the default fade shapes and their whole duration
as the fade durations.

; WSTR C SOU T S ——
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To execute the default fade/crossfade:

* Make sure you have set your default fade information as described
above.

* Open the Track window and select the waveform range you wish to
fade or crossfade (Range mode) or any region or regions (Object
mode) you wish to fade or crossfade.

* Choose the Default Fade command on the Process menu.
If you have a great number of regions selected, this process may take a

while. After a few moments, the DECK II track window will reappear
and all of your fades and crossfades will be in place.

Hint: If you are editing music, dialog, or effects, you can use the Default
Fade command as an 'auto pop-filter’ for correcting the clicks and DC
offset you may have across region boundaries. To do this, set the
default fade shapes to equal power and the default fade durations to a
short period (60 ms, for example). Then select all regions and choose
the Default Fade command. All regions will be faded in, faded out
and/or crossfaded, guaranteeing you that no region transitions will be
abrupt.

To create a custom fade or crossfade:

* Open the Track window and select the waveform range you wish to
fade or crossfade.

This range must cross at least one region boundary. If it only crosses
over the beginning of a region, a fade in is generated. If it only
crosses over the end of a region, a fade out is generated. If it only
crosses over the border between two touching regions, a crossfade in is
generated.

Note: Remember, fades in always begin at the beginning of the region and
fades out always end at the end of the region. This is true even when
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you select from well before the beginning or up to well after the end.
This makes it possible to generate fades in and fades out without
requiring that you select exactly from the start or to the end.

® Choose the Custom Fade command on the Process menu. This
dialog appears:

Crossfade Out Shapes: Before Splice:

R NN

Crossfade In Shapes:

705 msS

r-f/—///.]_, After Splice:
Lo ) Cowe )

* Choose your fade out shape and fade in shape, then click on the OK
button.

After a few moments, your crossfade will be complete and you will see
it in the Track window. Remember, if there is no audio data in the
source file after the end of region 1 or before the beginning of region 2,
DECK will warn you that no data is available. However, DECK will
allow you to execute the fade anyway, using silence as the missing
crossfade source data.

Note: If you have selected a waveform range that only covers a region
beginning or a region end, you will see only one set of fade shapes,
rather than two, because you are executing a fade, not a crossfade.

To delete crossfades:

* Open the Track window and select a waveform range that touches
any crossfade or regions that contain any crossfades.

@—_—_
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* Choose the Delete Fade command on the Process menu.

All fades in any regions touched by the current selection will be
deleted. Note that fades and crossfades are small audio files that are
generated automatically by DECK and placed in the current Session's
crossfades folder. When you delete fades, they will be deleted from
your hard disk, however the crossfades are not physically deleted until
you save the current Session. When you do so, the disk space occu-
pied by the deleted fades will become available.

Note: When you move regions that are connected by a crossfade, that
crossfade will be deleted automatically. Any crossfade is related

specifically to the two regions it bridges. The crossfade loses all G

meaning when the regions are separated.

Hint: As mentioned above, fades and crossfades are generated by DECK
from the original source soundfiles. DECK always keeps track of the
source soundfiles, and can recreate the crossfades automatically if you
delete any of them from your drive. If you ever want to free up disk
space consumed by a Session's Crossfades folder, you can simply
throw that folder away. The crossfades will be rebuilt automatically
when you next open the Session.

WARNING: When you are dealing with crossfades, you must pay special attention
to your use of the Compact Session and Compact Audio commands.
Both of these commands offer an adjustment called "Handle Size,"
which allows you to choose how much source audio before each
region's start and after each region's end will be retained when the
source soundfiles are compacted. It is possible to compact a Session or
soundfile with smaller handles than you would need to recreate
Session crossfades. (Remember, crossfades are built from the sound
data before the beginning and after the end of the regions.) Compact-
ing with such a small handle size will not alter your current cross-
fades. However, if you delete crossfades or perform edits that delete
crossfades after you have compacted with a small handle size, there
may not be enough data to recreate the deleted crossfades.
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Destructive Signal Processing

DECK IT'is primarily a digital recorder, arranger and mixer, and as
such it concentrates on non-destructive creation and editing of audio
tracks. DECK II offers you many ways to alter the overall level and
arrangement of a track without changing the actual hard disk data that
makes up that track. However, there are certain cases where a pro-
ducer might want to change the actual audio data in destructive
manner.

If you have recorded a voiceover, for example, and the take is perfect,
but the overall level is slightly low (the waveform seems a bit 'short'),
you would definitely want to increase the level of the track to its
maximum.

For this reason (and other similar purposes), DECK II offers a number
of constructive/destructive signal processing. Three processes are
available under Destructive Effects on the Process menu: Normalize,
Reverse, and Invert. The Normalize function looks at an audio region
(or group of regions) and automatically adjusts amplitude (volume) to
the maximum allowable level. This allows you to bring up low-level
signals to a reasonable level, which uses all of the amplitude resolution
available on your system. The Group Normalize command functions
in the same manner, except that it finds the peak over a group of
regions and adjusts each region the same amount. Reverse does what
you would expect: It takes the selected audio region (or group of
regions) and turns them around so they are backwards. This is quite
useful for specialty effects and 'pre-processing' effects (pre-echo, etc.).
Invert automatically flips the audio region (or group of regions)
upside-down, which does not alter the sound of the region(s), but can
be very useful for looping and general sound design tasks. The
Duplicate command will duplicate the range or region(s). For more
specific information about how these process work, see the Destructive
Signal Processing information at the end of the Reference chapter if
this manual.

Important: DECK Il allows you to perform all destructive processes destructively
or constructively. Whenever you perform a destructive effect, DECK II
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DECK 1T



will ask you if the process should be executed on a copy. Signal
processing permanently changes audio data, and it can’t be undone, so
keep backup files and use destructive processing with care.

To normalize, reverse, or invert a region or group of region:

* Make sure that the Track window is open and that you have located
the region or regions you plan to normalize, reverse or invert.

¢ Select the range or region(s) you wish to process.

* Choose the desired command from the Options menu's Destructive
Effects submenu. The following dialog appears:

IWARNING!
This process will permanently aiter disk dato.
Do you want te continue?

{ o | [ Concer ) [Make o copy]

This dialog gives you the choice of processing the original source
data or creating a copy and processing the copy. Whenever possible,
itis better to make a copy, because this leaves the original data
untouched. Remember, if you do choose to process the original, all
instances of that original that are present in the current Session
will also be altered. This is true because they are just references to
the same audio data. When vou choose the Make a Copy option,
you are creating a new copy of the original, and hence the two copies
are no longer related.

Hint: Double-click on a track (in the Track Label/ Drag area) to select all of
the audio on that track (for Destructive Effects processing, for ex-
ample).

* Click on the button that represents your processing choice. The
Make a Copy option is recommended.
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After a few moments the Track window will reappear and your
processed audio will be present. If you chose Make a Copy, the copy
has been placed in the position of the original data region. Remem-
ber, that original region has not been altered.

Visual Automation Envelopes

The control of volume and movement within the stereo image over
time is a very important concept in the audio world. This type of
control is the essence of a 'mix." DECK II allows you to control the
volume or pan of any playback track in real-time, and also makes it
possible for you to record volume and pan fader motion as you
perform it. This live performance' idea is very traditional in the audio,
and it is one way to automate a mix. This method is explained at
length in Chapter 6 of this manual.

With the dawn of the digital audio workstation, many other methods
for creating automated mixes have surfaced. The most interesting and
powerful of these is the simple visual editing of a line graph (envelope)
describing the current position of a control. DECK II allows you to
create and edit all automation data in this fashion.

For example, assume you had a region of audio and you wanted it to
come in loud, decrease in volume for about half its duration, and then
increase slowly back to full volume. In the analog world you would
play back your tape deck and use your automated mixing board to
record yourself making the physical fader motion. In DECK I, you
could simply open up the Track window, find the audio region, and
create this volume envelope:

The volume in this illustration is controlled (and indicated) by the
thick horizontal line. The lower the line goes, the lower the volume ~
the top of the track is full volume and the bottom is no volume. If you

e
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look closely, you will see a number of break points in the line where
the angle of the line changes. Creating these points (which are auto-
matically connected by lines) is the simplest method you can use to
automate a mix. Adding and editing these points allows you to alter
the mix in very exact ways. And these automation envelopes can be
edited using the same basic Track window functions you use to edit
the waveforms.

To create an automation envelope:

* Open the Track window and make sure you are in Object mode.

* Use the Track Automation View pop-up to choose the type of
automation envelope you plan to create or edit. (Note that the

Automation Status pop-up automatically pops to the Play’ position,
showing that automation is set to play on that track).

The track audio data will dim to light gray which indicates that you
cannot edit audio data at the same time as automation. When you
have the Track Automation View pop-up set to None, then you will be
viewing and editing only normal audio waveform data in the wave-
form area. When the pop-up is set to Volume, waveform data will still
be shown, but only volume envelopes can be created and edited on the
track. In this situation up is full volume and down is no volume.
When the pop-up is set to Pan, waveform data will still be shown, but
only stereo pan envelopes can be created and edited on the track. In
this situation up is left channel and down is right channel.
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Shortcut: You can set all Track Automation View pop-ups and Automation
Status pop-ups to the same setting by option-clicking on that pop-up.

Hint: You can view the exact setting of any volume or pan envelope break
point by looking at the level or pan indicator on that track as you move
the point. The exact current value will be shown as you adjust any

point.

* To create an automation point, hold down the command key and
click the mouse at that point.

As you do so, an automation break point appears, along with the
associated flat automation line. You have now set a single level
setting.

* Continue command-clicking anywhere over the waveform to create
more automation points and develop the general envelope shape
you wish. To insert a break point with the same vertical value as the
previous, hold down the control and command keys and click in the
new location.

Atany time you can play back the audio using the Transport window
controls (or the space bar) to hear the new automation. If you open the
Mixer window, you can also see the new automation moves.

* To adjust a break point, just click on the point and drag it to a new
position. To constrain the time, hold down the shift key while
dragging.

* To delete a break point, hold down the option key and click on that

point.

* When you are done, you can set the Track Automation View pop-up
to None to hide the automation envelope.

You can now continue editing audio waveform ranges and regions, if
you wish. As long as the Automation Status pop-up is set to the Play’
position, all automation on the track will play back.

o
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To edit automation envelopes:

* Use the Track Automation View pop-up to choose the type of
automation envelope you plan to edit.

You will immediately see the envelope you wish to edit.

* To adjust a break point, just click on the point and drag it to a new
position.

* To delete a break point, hold down the option key and click on that
point.

* To edit automation envelope ranges, drag to select groups of
breakpoints and shift them by holding down the Command key and
pressing the arrow keys. Or click on the Edit Mode button to switch
the Track window to Range mode. Select any automation envelope
range and edit it as if it were a waveform.

All of the standard copy and paste commands will function just as they
do with audio data. Of particular interest is the fact that you can also
use the Track window range and region dragging functions and arrow
key manipulations to drag, nudge and copy automation ranges on a
track, or between tracks. For a list of all automation shortcuts, see the
end of the Track window section of the Reference chapter.

To mute or delete automation envelopes:

* Choose the track upon which you wish to mute or delete automa-
tion.

* Click and hold on that track's Automation Status pop-up. It should
look like this:
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Record Volume

Record Pan
Record AN

Erase Dolume
Erase Pon
Erase All

* To mute all automation on that track, choose the Off command.
Then let go of the mouse.

This mutes all of the automation on the current track. That automation
is not deleted, it is simply turned off. To turn it back on, just set the
track's Automation Status pop-up to Play.

* To delete automation on that track, choose the Erase Volume, Erase
Pan or Erase All command. Then let go of the mouse.

The automation type you choose will be permanently deleted from the
track.

Note: At any time you can use a track’s Automation View pop-up to show or
hide automation envelopes on that track. Even when you have hidden
the current automation envelopes, the functions on the Automation
Status pop-up (play, off, erase, etc.) will still function. You do not need
to see an automation envelope to have it play.

Note: You cannot edit audio regions on a track when that track is set to view
pan or volume automation envelopes. To edit audio, set the track's
Automation Status pop-up back to None."
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Bouncing Tracks to the Clipboard

Bouncing is the process of creating a submix of multiple playback
tracks in order to free up those tracks so you can record more tracks.
By recording multiple tracks and bouncing them down, you can create
finished mixes in DECK 1l that are hundreds of tracks deep. (The ideas
behind this process are explained at length in Chapter 3 of this
manual.) Many people also use the bounce process for basic sound
design tasks. By arranging a number of audio regions with automa-
tion, and then bouncing to the Clipboard, you have a one-step solution
for creating mono and stereo soundfiles for loading to samplers or
playback from within DECK.

DECK Il makes the process of bouncing very simple and visual. Here's
how it works:

To bounce tracks:

* Open the Session that contains the tracks or regions you wish to
bounce.

* Bring the Track window to the front by choosing the Tracks com-
mand on the Windows menu.

¢ Switch to Range mode by clicking on the mode button:

Ci

* Drag to select the destination range for your bounced track(s). Your
screen should look something like this:
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Important: When you bounce in DECK II, all four or eight playback tracks are
always included in the bounce. For this reason, it really doesn't
matter upon which track you choose to select the range. Because of
this, you can use the shortcut of selecting the destination range instead
of the source range. This will return you to the Track window after the
bounce is complete, and require only that you choose the Paste At
command to finish the bounce and paste the new audio at the correct
point in time. Remember, you will want to select two destination
tracks if you are bouncing to stereo clipboard.

* Choose the Bounce All to Mono Clipboard or Bounce All to Stereo
Clipboard command on the Process menu to execute the bounce.
This progress dialog will appear:

o
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When the bounce is complete, you will be returned to the Track
window, and your originally-selected range will still be selected.

* Choose the Paste At command on the Edit menu to paste the newly-
bounced region at the correct place in time. The Track window
should now look something like this:

$44% 0000 2000
A 0:00'30:0

Important: You have now completed the bounce. This new region contains a mix
of all of the audio that was set to play in the selected range. All
volume levels, pan settings and automation envelopes are used to
create the bounced file, so it will sound exactly like the original source
tracks. You are now free to delete the regions that were used to create
the bounce. (In the case of this example, that would be the regions on
tracks 1 and 2.) Or, you can simply move the tracks used as source for
the bounce down to the Work Track area, where they will not play
back. This is the best option, because it allows you to go back to your
original source tracks if you desire.
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Hint: Bounce always bounces all of the play tracks in the selected time range,
regardless of which track contains the selection. If you want to make
sure that certain tracks are not used as source for a bounce, mute
those tracks. Mute and solo are taken into account when you bounce
to the clipboard.

Note: You may not need to bounce tracks if you are using the Virtual Mix
command. See Chapter 7 of this manual for more information about
mixing.

Understanding the Compact Session Command

The Compact Session command is one of the most important com-
mands available in DECK. Because DECK Il is a constructive recorder,
audio data is never deleted when new audio is recorder. Thisisa
very positive fact, because it means that no recording or editing
process actually changes, damages or deletes the original source files,
so you can always go back to previous takes and versions. The only
negative side effect of this characteristic is that unused takes and
throw-away regions stay on your hard disk, even after you stop using
them. If, for example, you record three voiceover takes and decide to
keep the second take, takes 1 and 3 remain on your drive even after
you remove them from the Session. To permanently delete all unused
audio associated with the current Session, you will use the Compact
Session command.

Compact Session automatically compacts all of the audio files in the
Session's Audio Files folder which are used in the current Session.
This is the command you will always use to get rid of unused audio
data (junk takes or unused solos, for example) in all soundfiles associ-
ated with the Session.

Files are compacted in the following way: DECK II looks at the list of
audio regions and loops in each audio file. It then looks through the
audio data in each file, and finds all audio data that is not used in any
region. After the unused audio has been found, it is permanently
deleted from the drive, and all region definitions are updated.
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Important: Compaction is a destructive process, so make sure you understand
what you're doing before you use it! It is particularly important that
you understand the Always Save Regions when Session is Saved and
Rewrite Regions preferences in the DECK II General Preferences
dialog. These preferences have strong effects on the compaction
process. Make sure to read about those preferences before you
compact audio files or Sessions.

Important: Compact Session only compacts audio files located in the current
Session's Audio Files folder. It will not compact audio files located
elsewhere on the drive, or on other drives. This safety valve has been
built into DECK II to prevent the accidental compaction of soundfiles
in a central sound effects library, or of soundfiles used in multiple
Sessions. Make sure you always keep sound library files and shared
soundfiles in a folders outside of the current Session's Audio Files
folder.

The product of the compaction process is generally an increase in the
available hard disk space.

To compact a Session:
* Open the Session you want to compact.

¢ Choose the Compact Session command from the Session menu.
When you choose this command, you get this Handle dialog:

Enter handle time:

2.000 fSeconds

(Cancer ) f ok}

The Handle Size setting allows you to keep a little bit of extra audio
data before every region start and after every region end, which will be
useful in the future if you plan to crossfade the regions. You will
probably want to set your handle size to at least 2 seconds for this

purpose.
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* [Enter your handle size and click on the OK button. The compaction
process may take a few minutes.

Note: If you use entire soundfiles your Session, you will find that there is no
unused audio data to delete from those files. In such cases, compac-
tion will not increase your available disk space.

WARNING: When your Session contains crossfades, you must pay special attention
to your use of the Compact Session and Compact Audio commands.
Both of these commands offer an adjustment called "Handle Size,"
which allows you to choose how much source audio before each
region's start and after each region's end will be retained when the
source soundfiles are compacted. It is possible to compact a Session or
soundfile with smaller handles than you would need to recreate
Session crossfades. (Remember, crossfades are built from the sound
data before the beginning and after the end of the regions.) Compact-
ing with such a small handle size will not alter your current cross-
fades. However, if you delete crossfades or perform edits that delete
crossfades after you have compacted with a small handle size, there
may not be enough data to recreate the deleted crossfades.

Spotting Audio Regions to Time Code

One of the most common tasks in the audio post-production process is
the placement (or 'spotting’) of sound to a particular SMPTE frame.
DECK II allows you to do this in a very simple way using the normal
editing tools.

To spot an audio region to a specific SMPTE frame:

¢ Open the Track window and set the units of the window to SMIPTE
using the Axis Units pop-up.
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* Add the audio region you wish to spot using the process described
at the beginning of the chapter.

* Click and hold on the audio region you wish to spot.
* Drag the region to the frame you desire.

As you drag the region, the numeric indicators near the upper right of
the Track window are updated to show the start time, end time,
current time, and duration of the selected range. The current time is
the time that is directly under the cursor.

Hint: The current time indicator is particularly useful when you want to spot
a sound by an internal sync point (a point other than the start of end of
the region). If, for example, you had a ‘car by’ with a skid sound half
way through, you could place the mouse at the skid sound and spot
the current time to the desired frame.

Hint: You do not have to drag the region to place it. You can also Copy or
Cut the region, click to place the insertion point at the correct frame,
and then choose the Paste At or Paste After command.

Important Hint: If you know the exact time you wish to spot a region, double-click on
the region, which brings up the Region Info dialog. You can change
the region’s start time by typing in the new time or capturing one. You
can also change the region's name by typing in a new name.
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Importing a QuickTime Movie

DECK Il is not only useful as a 16-bit audio workstation , it can also be
used as a QuickTime audio post-production tool. It is very easy to
import any existing QuickTime movie, and synchronize DECK II audio
and automation to that movie. (If you are using OSC's METRO
sequencer, you can also synchronize any MIDI to the same QuickTime
movie at the same time.) DECK II is capable of playing back four
tracks of 16-bit audio and a QuickTime movie (and that movie's 8-bit
audio) simultaneously from a single hard disk. (For more informa-
tion about synchronizing DECK II automation and audio to
QuickTime movies, see Chapter 7.)

To import a QuickTime movie into DECK II:

* Create a new Session or open the Session you wish to sync to a
QuickTime movie.

* Choose the Import Movie command on the QuickTime menu.

When you choose the Import Movie command, this dialog appears:

Jj DECK 11 Demo V' < ProStore
Preview £
' DECK 11 Demo audio files 17/ ETT

O Theology

| I I ; | Desktop |
. Cancel
[_Lrents ] [= i Import '

Movie Audio Handling:
 Put sudio on clipboard

O Put audio in new work track(s)
@ Leave audio in movie

* Use the file selector area to find and highlight the movie you want.

* Choose what you want to do with the selected movie's existing
audio (if there is any).
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You must select one of the following options:

Put audio on clipboard: This option is a conversion option. It auto-
matically removes the source audio from the QuickTime movie and
converts it to 16-bit monophonic Sound Designer 11 file(s). These files
are created in the Session's audio files folder, and then placed on your
Macintosh Clipboard for pasting into any track in the Track window.
To guarantee that the Clipboard file will sync to the imported movie,
you will need to drag or paste it so that it starts at the Session zero
time.

Hint: Remember, if the source audio was stereo, you will need to select two
tracks when you paste the audio.

Put audio in new work track(s): This option is a conversion option. It
automatically removes the source audio from the QuickTime movie
and converts it to 16-bit monophonic Sound Designer Il files. These
files are created in the Session’s audio files folder, and then placed onto
two new playlists on work tracks at the bottom of the Track window.
To play back these tracks, click on the track name area (s) to select the
track, then drag the track up to one of the play tracks. (You can also
use the playlist pop-up at the bottom of any track in the Mixer window
to move these new playlists up to playback tracks.) Choose this option
to make sure that the original QuickTime audio will be included in any
16-bit stereo mixdowns and in exported QuickTime movies,

Leave audio in movie: This option performs no file conversion. The
original audio remains in its source form, and is still associated with its
QuickTime picture. This audio will play back along with all DECK IT
16-bit tracks when you play back the Session. Note, however, that this
audio left in its movie will generally play back through your Macin-
tosh speaker or audio output. Choose this option if you wish to use
the original QuickTime audio as guide audio only. When you leave
your audio in the movie, you will get an extra track of playback, but
that track will be erased when you Export your finished QuickTime
movie with its new audio.

* Click on the Import button
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After a few moments the QuickTime movie will appear at its native
size in DECK II's QuickTime window. If you chose to add audio to the
Clipboard or to put audio on a work track, the conversion process may
take a few moments. If you added the audio to the Clipboard, you will
need to paste it onto a track (making sure that it begins at the Session
start). You are now ready to continue the process of recording, adding,
mixing and automating new audio for your movie. The QuickTime
movie will always play back in sync with the DECK Session, and the
movie will always open whenever the Session is opened.

Note: DECK II will allow you to import QuickTime movies that have audio
at unsupported sample rates. If you import a QuickTime movie with
sampled audio at a sample rate other than 48, 44.1, 24, 22.05, 12, or
11.025 kHz, and you choose to place that audio on the Clipboard or on
a Work Track, DECK II will import the audio as 16-bit, but the audio
will not sync correctly to the source QuickTime picture. If you are
doing sync work with QuickTime movies that contain audio at odd
sample rates, you will need to do one of the following things before
you import the audio into DECK: 1) Resample that audio (in Sound
Designer I, for example) to one of the supported rates, or 2) import
the movie and leave the audio in the movie itself. If you use option 2,
you can always route your Macintosh CPU audio output to the input
of your audio card and lift the QuickTime source audio in real-time.
Future versions of DECK will automatically sample rate-convert the
source audio at import time.

Hint: If you are using DECK II as a QuickTime audio post-production tool,
make sure to try the Chase Positioning command on the QuickTime
menu. This command turns on QuickTime chase mode, which auto-
matically pops the QuickTime window to show the current frame
when audio regions are moved. (The frame at the region's start time is
always shown.) This is an indispensable function for spotting music
and effects to specific frames.

Hint: QuickTime movies will generally not play back at 30 frames/second
on any off-the-shelf Macintosh. If you plan to use DECK II's
QuickTime movie window to play video guide tracks for tape-based

@—_

DECK 11



audio post-production, you may want to obtain a QuickTime accelera-
tor. For example, RasterOps' MediaTime board, coupled with their
MoviePack JPEG compression board will allow you to view full-
screen, 30 frame/second QuickTime movies from the hard disk as you
work within DECK. A second Macintosh color monitor is also prefer-
able in such a configuration.

Using the Tempo and Time Signature Settings

The DECK II Track window offers some simple tools that make it
possible to edit audio according to traditional bar and beat settings.
This is an absolute necessity when you are recording or arranging

music according to a MIDI tempo, click track, or MIDI sequencer track. q
When you run DECK II with OSC's METRO sequencer, the tempo

settings take on particular importance, because they allow you to

match bar and beat edits between the two programs. This really

makes DECK II and METRO function in a fashion that is useful for

songwriting. For more information on using DECK II with Metro, see

the Using MIDI chapter of this manual.

To set and use DECK II's tempo and time signature information:

* Open the Track window and set the units of the window to Beat
using the Axis Units pop-up.

* Click and drag on the Tempo selector to set a new tempo.
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Hint: You can also hold down the command key and click on the selector to
enter the new tempo or time signature as text. Then press the return
key on your Mac keyboard to apply the change.

* Click and drag on the time signature numerator selector to set the
number of beats to a measure.

* Click and drag on the time signature denominator selector to set the
value of the note that should be considered 'one beat.’

For example, setting this to 4 means that a quarter note is considered to
be one beat.

As mentioned, these values are very useful for song-oriented arrange-
ment. When you set these values, you are determining the units that
will be used by the beat mode axis markers, and the associated grid
settings. Note that the tempo and time signature values only effect the
way that DECK II's Track window time axis, grid and numeric indica-
tors function (and, of course, the Transport window's counter). The
tempo and time signature values to not alter the placement of any
audio regions unless you have configured DECK as described in the
Important message below.

Note: If you are using OSC's METRO sequencer, you will find that any
tempo and time signature changes you make in METRO will automati-
cally be made in DECK. Also, any current selection range in METRO's
Note Editor or Tracks window will automatically be selected when
you swilch to DECK. Note, however, that changes made to tempo and
time signature in DECK are not passed to METRO when you switch
(METRO is thought of as the tempo master), so you should change
your tempo and time signature information in METRO if you are
running both programs. Remember, DECK Il now supports tempo
maps, so METRO tempo maps will always be reflected on the DECK II
Track window axis markers (when you are in Beat mode).

o
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Important: If you are working in Beat mode, there is a circumstance in which you
may wish to have audio regions stick to their bar and beat placement
when tempo is changed. If you are using DECK II as a virtual drum
machine (playing individual drum sounds back as regions), then you
will often want to make sure that any tempo changes will adjust audio
region placement to make sure that the regions still start at their
original bar and beat locations. In this situation, changing tempo will
alter where bar and beat boundaries occur in relation to real-time, and
bar/beat start times are considered to be 'relative times' rather than
‘absolute times." DECK offers a special preference for this type of
editing. If you wish the regions to stick to their bar and beat locations
whenever tempo is changed (in Beat mode), then see the Change
region start times with BPM change preference (under General
preferences on the File menu's Preferences submenu). When this
option is turned on, tempo changes in Beat mode will adjust the
placement of audio regions so that they retain their bar and beat
locations. See Chapter 7 of this manual for more information.

This concludes the Track window section of this manual. To learn
about synchronization, mixing and mastering, see the next chapter. If
you have questions about specific DECK II commands, buttons, or
windows, see the Reference chapter (Chapter 8) of this manual.
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Introduction

DECK Il is primarily a multitrack hard disk recording, editing and
mixing environment, but DECK II offers the ability to augment your
system with the use of MIDI. This chapter of the DECK II manual
focuses on the specific tasks you'll need to understand, in order to get
the most out of DECK II's MIDI functions. Using the MIDI functions
will enable you to synchronize your Session to SMPTE timecode, use
DECK IT as a master timecode source, import a MIDI file for synchro-
nous playback with your Session, and control DECK II with an exter-
nal MIDI device. You can also use OSC's METRO sequencer (or any
other capable sequencer) to edit MIDI files and digital audio at the

same time.

MIDI Setup

Before you can use DECK II's MIDI functions, you will need to config-
ure your MIDI setup. This is accomplished with the MIDI Setup
command on the Options Menu. When you choose this command, the
MIDI setup dialog associated with your MIDI system will appear.

DECK II Internal MIDI Setup

If you do not have OMS or the MID] Manager installed, DECK II's

internal MIDI Setup dialog will appear:

Please configure the serial ports:

£ Modem Port

[] Printer Port

Speed: Speed:

0.5 MHz O 4.5 Mu2

®) 1.0 MHz @ 0.0 Mz

0 2.0 MHz O 2.0 mu2

() Fast Qrast
@) Generlc @ beneric
O MIDI Time Piece O MIBI Tirne Piecs
O Studio 5 O studka S

[Cancel ] | ok )
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You can use this dialog to configure DECK 1I for your basic MIDI
setup. If you are a serious MIDI user, OSC suggests you install OMS
(see below).

The Open Music System (OMS)

If you are an advanced MIDI user you are probably familiar with the
Open Music System (formerly the Opcode MIDI System). OMS
consists of a set of System documents that, along with the OMS Setup
application, allow you to create MIDI instruments and a general MIDI
setup that is shared by all OMS-compatible programs. OMS is an
excellent system, because it allows you to create a single MIDI system
configuration for your entire studio, and all OMS-friendly applications
will understand that configuration. One of the main benefits of this is
a set of ‘common instruments.' Once you have set up your OMS
environment, OMS-compatible applications can list all of your MIDI
instruments (including devices lime interfaces and controllers) by
name. This makes it possible to avoid defining and setting up your
MIDI environment in every MIDI-capable program. For advanced
MIDI users, OMS is highly recommended.

When you have OMS installed, configure DECK II as follows:
* Open any DECK II Session.

* Choose the MIDI Setup command on the Options menu. This dialog
appears:

OMS MID1 Setup

Compatibllity: Use Senal Ports:
O Use Apple MIRT Manages E Modem
@ Only OMS Applications O erinter

O Allow Non-0MS$ Applications

Only OMS Applications

0% sppthaations aan soentivne 1o send nd reoetre MDI whan By are et
active, al¥augh only are OPME 3ppHoation con 6o timing (use the MIDI Manager
1o synchronize multple spptications)

Crrors ) Coma) C% )

SRS o N —
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This is the standard OMS MIDI Setup dialog which is common to
most OMS-compatible programs. If you are running DECK II with
OMS-compatible slave programs (OSC's METRO sequencer, for
example) then set up the dialog to allow ‘Only OMS Applications.'
This will make it possible for you to switch between DECK II and the
slave program(s) during playback without forcing MIDI or audio
playback to stop. If you are running DECK IT with programs in the
background that are NOT OMS-compatible then select the "Allow
Non-OMS Applications' option. This will allow the ports to be
shared, but may stop MIDI and/or audio playback when you switch
between applications.

For more information about configuring and using OMS, see the
METRO manual or your OMS user guide.

Apple’s MIDI Manager

For many MIDI users, particularly those with MacProteus (or other q
MIDI playback) cards, or programs such as Master Tracks (which are
not OMS compatible), the Apple MIDI Manager and MIDI Driver have
become important software components. The MIDI Manager and
MIDI Driver are System documents that, along with Patch Bay applica-
tion, allow you to route MIDI between applications and the Mac serial
ports. For some applications the MIDI Manager is required. In most
situations, however, the MIDI Manager is unnecessary and actually
slows down MIDI operations on your Macintosh. Worse than that,
MIDI Manager's inefficiency may also cause multitrack hard disk
playback and recording to bog down, thereby decreasing the overall
power of your system.

DECK II functions both with and without the MIDI Manager, so if you
don’t need the MIDI manager, don’t use it. If you do use the MIDI
Manager, you will need to make sure that MIDI is routed correctly for
playback and recording. Also you may want to increase the size of
your disk buffers to up the performance of your Macintosh (see the
General preferences on the File menu's Preferences submenu for more
information).
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To set up the Apple MIDI manager:

* Make sure you've started up your Mac with the Apple MIDI Driver
and MIDI Manager documents in your System folder.

You will also need the Patch Bay application.
* Start up DECK IL
* Open the Patch Bay application. The PatchBay window appears.

The PatchBay window shows the current Patch Bay setup. You can
route MIDI from any source to any destination by dragging from any
output arrow to any input arrow. Once you have created a patch,
you can save it for later use.

* Double click on the Apple MIDI Driver icon in the Patch Bay. The
MIDI Setup window appears.

Use the MIDI Setup window to configure your MIDI ports. If you
are using DECK II with the MIDI Manager, make sure that you have
set up this window with all Time Code Output and Filter Time Code
options turned off. The MIDI Patchbay should be used as a router
only - not for any explicit timing tasks.

* Close the MIDI Patchbay window when you are done.
DECK I and the MIDI Manager are now ready for use.

Once again, the MIDI Manager is not designed ideally for real time
programs like DECK I, so if you don't need the MIDI Manager,
don't use it. For more specific information, see the Appendix of this
manual.

MIDI Preferences

The next step in configuring your system for MIDI is opening the MIDI
Preferences on the Preferences Submenu on the File Menu. When you
choose this command, the following dialog will appear:
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~ . — MIDI Preferences .-

[ Split channels on incoming MIDI files
Default output port: | Wavestati...v |

Timecode output port: | ADAT Input w |

mncel l ﬁ

Use this dialog to set the following characteristics for DECK I1:

Split channels on incoming MIDI files: When this preference is on,
DECK II will split the channels when you import a MIDI file. This is
useful when you are importing Type 0 MIDI files, which store all track
data in one channel.

Default Output Port: This pop-up lists your MIDI ports and uses the G
first one on the list as the default output port. To change the port,

simply select a different port using the pop-up menu.

Timecode Output Port: This pop-up controls through which port
outgoing MIDI Timecode is sent. To change the port, simply select a
different port using the pop-up menu.

Note: If you plan to import large MIDI files, you should first increase the
MIDI buffer size in the Memory and Storage Preferences. Remember,
whenever you increase the buffer size, you should also increase the
amount of RAM allocated to DECK II. For more information, see the
Memory and Storage Preferences in the Reference section of this
manual.

You have now finished configuring your MIDI setup and can use any
of DECK's MIDI functions.
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Sending MIDI Timecode

You can use DECK II as a timecode master very easily. Simply choose
the Send Timecode command on the Options menu. Deck IT will
automatically generate timecode and send it through the Timecode
OQutput Port you chose in the MIDI Preferences. To stop sending
Timecode, choose the command again. You can tell if DECK Il is
sending timecode by looking for a check next to the command. If the
command is checked, DECK II is sending Timecode.

MIDI Map Mode -
Controlling DECK Il with External MIDI Devices

The DECK II Mixer window contains a number of faders for control-
ling level and stereo pan, and real-time adjustment of those faders can
become very frustrating if you are only using the mouse. Although the
mouse is a very useful pointing device, it is limited in a mixing envi-
ronment because it only allows you to adjust a single fader at one time.
This is much more cumbersome than using your hands on a standard
mixing board (where you can move multiple faders at one time).

To cope with this problem, DECK II offers two advanced mixing tools:
Mixer state buttons (explained in Chapter 6 of this manual), and MIDI
fader mapping. DECK II's MIDI map mode allows you to map any
continuous MIDI controller to any volume or pan fader (or number of
faders). For example, you could map your keyboard modulation
wheel to control the smooth motion of track 1 and 2 volume faders.
Or, if you have a MIDI fader box (such as the J. L. Cooper Fader-
Master), you could map all of the track volume and pan faders so you
could control the entire mixing board from the external MIDI fader
controls.

To map DECK IF's faders to external MIDI controllers:

¢ Open the Session that contains the faders you wish to map.
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* Choose the MIDI Map Faders command on the Options menu.

You have now switched on MIDI Map mode. You will see a check
mark in front of the MIDI Map Faders command, and all of the
faders on the screen will automatically be highlighted in green.

* Make sure you have a MIDI controller source connected to your Mac
MIDI interface, and that the interface is connected and routed to
DECK IL

¢ Click to highlight the fader or faders you wish to map.

This fader(s) are now ready for automatic mapping to a MIDI
controller. They will be highlighted in yellow.

* Move the controller to send controller events.

When you move the controller (mod wheel or MIDI fader, for G
example), controller events are sent. When DECK I receives these

events, it knows their source, and automatically maps the currently

selected fader or faders to that source. You will know that the

fader(s) have been mapped, because they will be highlighted in red.

Hint: To create a fader group, simply map multiple faders to a single
external controller. Then, all of those DECK IT faders will move
whenever the controller is moved.

* Repeat this process until all of your desired faders are mapped.

* Choose the MIDI Map Faders command again to turn off map mode.
All of the faders will return to their original colors. You are free to
move all of the mapped faders with the mouse, but whenever you
move the source controller, you will see that the faders remain

mapped.

Note: You must turn off MIDI Map Faders mode before the mapped external
controllers will start moving Mixer window faders.
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* Move your external MIDI controllers to see how the mapped screen
faders move along with them.

This map configuration will automatically be saved with the Session,
and will be turned on whenever you open the Session.

Important: During playback, the DECK II screen may appear to move in a
‘chunky’ manner. The VUs and faders may seem to jump from posi-
tion to position. This occurs because DECK II's audio tasks must take
precedence over the screen display. This chunky movement is not
reflected in the audio. If you move a mapped fader smoothly during
playback, a smooth adjustment will be made to the audio, even if the
screen appears to jump.

To unmap a mapped fader:
* Open the Session that contains the faders you wish to unmap.

* Move your external MIDI controllers to see how the mapped screen
faders move along with them.

¢ Choose the MIDI Map Faders command on the Options menu.
You have now switched on MIDI Map mode. You will see a check
mark in front of the MIDI Map Faders command, and all of the
mapped faders on the screen will automatically be highlighted in
red. (Other faders will be highlighted in green.)

* Click once on any mapped (red) fader to unmap it.

The fader will be filled highlighted in green to indicate that it is no
longer mapped.

* Choose the MIDI Map Faders command again to turn off map mode.

You have now unmapped the fader. Remember to save the Session
if you wish to unmap the fader permanently.
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Using DECK with the METRO Sequencer
on a Single Macintosh

DECK II offers the ability to synchronize to OSC’s METRO sequencer
on a single Macintosh. When you use DECK II and METRO together,
you get the best of both worlds: A digital audio workstation with a
full-function high-end MIDI sequencer in an integrated environment.
You can write keyboard parts and record vocals at the same time. You
can edit and arrange full songs (consisting of MIDI and audio) by bar
and beat. You can also write and edit complex MIDI parts and print
them down to digital audio in a matter of seconds, and then layer and
submix those audio tracks while playing back more MIDI tracks.

Running DECK 1T and METRO together requires no special software or
complicated setup process. If the two programs are running simulta-
neously, they automatically connect to each other and stay synchro-
nized. You can edit, play and record from either program and the
other runs in sync. You can even switch between programs during
playback and edit without stopping. Each program can save and open
documents automatically in the other, and can start up and quit the
other. The level of cross-program control is up to you. Here are some
suggestions for configuring DECK and METRO to run together:

Setting the DECK Connections on the METRO Setup menu: METRO
offers a settings dialog that allows you to configure the level of interac-
tion between DECK Il and METRO. When you choose the DECK
Connections command in METRO, this dialog appears:

L DECK™ Congections Iy -

X switch without stopping MID1
For connecting to DECK™ 2.0:

X Connect
‘0pen documents
X:Launch
#:Duit
Iolerute@ errors before syncing

@ (Concei)
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If you are planning on running DECK with METRO in the back-
ground, you can set the preferences as shown in the above illustration.
This setup assumes that you will be starting DECK, and that you
always want METRO to be started up and connected in the back-
ground. To complete the configuration process, you will also want to
set up DECK II's Slave Settings, as explained below.

Setting the Slave Settings preference on the DECK File menu: DECK
offers a settings dialog that allows you to configure the level of interac-
tion between DECK II and any compatible slave program (MIDI
SEQUENCER, etc.). When you choose the Slave Settings preference
on DECK II's Preferences submenu, this dialog appears:

Current Slave: METRO™ 2.4

[] Open slave documents
[] Quit slave when quitting
[ Save slave’s document when saving

I ox | [concel)

When you are running DECK with METRO in the background, you
can set the slave settings as shown in the above illustration. This setup
assumes that you will be starting DECK, and that you always want
METRO to be started up and connected in the background. When you
open a Session document with DECK TI configured in this fashion,
DECK IT will automatically open the associated MIDI file in METRO.
Although you will not see METRO (unless you switch to it), playback
within DECK will automatically control playback from METRO (and
vice versa).

Important: When you are running DECK and METRO on a single Macintosh,
choose one of the two programs (the one you will usually run in the
foreground) and set only that program to 'open documents' in the
other program. If you generally plan to open METRO and work on
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MIDI first, then set METRO to open documents. If you usually lay
down audio before adding MID], then set DECK I to ‘open docu-

ments’ (see the Slave Settings preference on the DECK II Preferences
submenu).

Setting the screen update speed for METRO within DECK 1I: DECK
IT offers a special preference that allows you to set how often the
METRO screens update when they are in the background. (It also
controls how often the DECK II screens update when they are running
in the background behind METRQ.)

ISR Genera)l e

[<] Autostop at end of Session
] Always save regions when Session is saved

[ Rewrite region list
[ Stop audio playback if the drive is too slow
[J Change region start times with BPM change

[X] Loop audition

Update speed during playback (1-10): i

SMPTE Preroll Time: Seconds

Sound Editor signature: Sd2a Set

Transport key equivalents
RTZ | Rewind | Stop | Play FF
<> <> 2> <» <>

Set Set) | [Set) | [set) | [set
Cancel |

To update the screen of METRO (or any other background program) as
often as possible, set the 'Update speed during playback’ to '1.” This
will allow the background program to update as smoothly as possible,
and is suggested if you are using METRO. If you wish to lock out the
screen updates of background programs during playback, set the
'Update speed during playback’ to '10."
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Note: DECK Il and METRO have the ability to exchange the base tempo of
any documents. If you set tempo within METRO, that tempo will be
reflected automatically in DECK II. If you set tempo within DECK II,
that tempo will be reflected automatically in METRO.

Setting Up DECK Il with a MIDI or Audio Click

DECK Il is primarily an audio program, so it has no internal MIDI
metronome. If you wish to use a click or metronome, you will need to
use OSC’'s METRO sequencer (or another compatible slave sequencer)
running in the background on your Mac. You can also create a click
track in a different sequencer and import the file to play with your
Session (see Importing MIDI files below.)

To set up and run DECK IT with MIDI or audio metronome:
¢ Make sure that DECK II and METRO are configured to run together.
The programs are set at the factory to run correctly together, but you

can review these settings by reading through the DECK and METRO
configuration information earlier in this chapter.

e Create a new Session in DECK 11, then switch to METRO and create a
new METRO document.

You can accomplish this by using the New command on the File
menu in both programs.

¢ Click and drag the mouse on the Bars setting on any track in the
METRO Tracks window to set the number of click bars you want.
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You can set this to any number you desire. You can use a short
setting as a basic count in. Set the bars count to a high number (600,
for example) if you want a long period of click.

* Click on the dialog door in the lower right-hand corner of the
METRO tempo setting area in the Bridge window.

This opens the following dialog:

L Tempo / ‘
set lempo
@10 beats per minute

O So selection & ends at
Orits to

Hour: Min.: SOE Frame:Bit
(| N N [ O [

* Use the METRO tempo dialog to enter the tempo you desire. Then
click on the OK button.

You have now set the tempo of the click (and the start tempo of the
METRO MIDI file as a whole). Now you just need to turn the
metronome on.

* Click on the METRO Metronome icon in the Bridge window to turn

on the MIDI click.
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The click is now on. It can be set to trigger any MIDI device, or to
play a number of sounds via your Macintosh speaker or CPU audio
output. Whenever the click is turned on, it will automatically play
when you hit your DECK 1I play button. For more information
about editing and configuring the METRO metronome, consult your
METRO user's guide.

Important: DECK I and METRO share a common tempo setting and exchange
tempo maps. To change the shared tempo, set the tempo in METRO as
described above. Changing the tempo in DECK II will not automati-
cally change the tempo in METRO, but METRO will change the tempo
in DECK II. Note that DECK II does support MIDI file playback in
tenths of a BPM, but does not yet allow entry in tenths.

Hint: Remember, the METRO Transport window can be set to two different
sizes. If you can't find the tempo and metronome setting areas, click
on the Transport window's grow box to reveal all of the transport
controls.

Importing MIDI Files

If you do not own METRO but would like to hear a MIDI file that you
have created in a sequencer play back with your Session, you can use
DECK II to import the MIDI file. First, open up the MIDI window
(choose MIDI from the Windows Menu.) It will look like this:

Click on the Import Button. This will bring up a standard file dialog
asking you to pick a file to import. When you have opened the file,
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DECK II will take a few moments to translate the file. When DECK II
is finished importing the file, the MIDI window will look something
like this:

You can change the MIDI file that is played with the Session by
clicking on the Import button again and choosing a new file. DECK II
will erase the previous MIDI data to make room for the new file.

MIDI files are imported with their tempo maps, and DECK I will
play back those tempo maps AND display audio bar/beat data
according to those tempo maps. To view audio waveforms visually
adjusted to tempo-accurate bar /beat display, just choose Beat on the
Option menu’s Time Mode submenu.

Important: DECK II's tempo indicator only shows you the first tempo of any MIDI
file. The display is not updated to show each new tempo. Entering a
new tempo will clear out the existing tempo map and set the Session to
that single new tempo.
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Note: You can also use the Import MIDI File command on the File Menu to
bring up the same dialog. You can use the Dispose MIDI File com-
mand on the same menu to erase the current MIDI file without import-
ing new data.

If you plan to make changes to your current MIDI file, you can turn on
the subscribe button. This will enable DECK 11 to reflect those changes
in your Session. For more information on the Import and Subscribe
functions see the Reference section of this manual.

MIDI Thru

Another of DECK II's MIDI functions is MIDI thru. To use MIDI thru,
open up the MIDI window, and press the button on the Thru track. It
will look something like this:

Deck IT will take all MIDI events coming into the in port and send
them back out the port you choose on this track. You can change the
port by clicking on it and selecting a new port using the pop-up menu.

This concludes the Using MIDI chapter. For information about SMPTE
Sychronization, see Chapter 7 of this manual. For exact information
about DECK II's MIDI window, see the Reference chapter of the
manual.
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Introduction

This chapter of the DECK II manual focuses on the methods you will
employ to synchronize DECK II to a video or audio deck, and the steps
you will follow to automate a final mix and create a digital master or
master file. Synchronization is the key function you will need in order
to add audio to video or film picture, or extend the tracks of your
multitrack with synchronized hard disk audio tracks. Mixing and
mastering are generally the final steps in any audio post-production
process. They generate the 'finished product' which you will publish
or deliver to clients. When you have finished this chapter, you will
have all of the knowledge necessary to take a DECK II audio project
from start to finish, and produce a finished digital audio master, sync
sound track or QuickTime movie.

Synchronization a

One of the most important features of DECK 11 is that it provides a true
non-linear multitrack synchronization environment. DECK II makes it
possible for your Macintosh hard disk audio to operate seamlessly in
sync to video and other audio sources. The task of synchronizing
picture and sound is fully done by DECK II, which runs as a slave to
your SMPTE source. All you need to do is route the SMPTE signal
from your video or audio source to a compatible Macintosh MIDI
interface (Opcode’s Studio 5 or MotU's MIDI TimePiece, for example).
Then, when you select the applicable SMPTE frame rate in DECK II,
and put DECK 1I online, the current Session will automatically syn-
chronize to the external time code source.

If you plan to use DECK I in a sync environment, you should start
with a basic understanding of SMPTE time code. If you are already
familiar with time code, you are ready to use the system. If you have
never used SMPTE time code, it would probably be wise to read
through one of the publications listed in the appendix of this manual.
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An Important Note About Trigger Synchronization

In the world of computer-based audio synchronization, most systems
differentiate between 'continuous resynchronization’ and 'trigger sync.’

Continuous resynchronization refers to systems that measure the
playback speed stability of the of a master timing (SMPTE) source, and
constantly adjust slave playback speed to match the master device's
fluctuation. Trigger sync simply waits for a start frame and triggers
playback. In this case, slave playback speed is not altered, regardless
of master speed fluctuation.

DECK II offers both continuous resync (the native mode) and trigger
syne. Itis important to note, however, that DECK II only offers
continuous resync on playback. This makes DECK II very useful for
audio post-production tasks, but it makes it difficult to use DECK I as
a recording slave with older analog multitrack decks and low-end
VCRs. Whenever you record, DECK II must use trigger sync, because
it is impossible to accomplish the multiple sample rate conversions
necessary for continuous record resync using software alone. (Pro
Tools and Sound Tools II offer the option in hardware using the
SMPTE slave driver, and DECK II supports this configuration.) There
are a number of elegant ways for dealing with this situation:

Make sure all devices are locked to house sync: For the best possible
results, you should make sure all of your devices are plugged into a
central sync reference signal, and run DECK with Trigger Sync turned
on. By putting the burden of servo-accuracy on the shoulders of the
different analog devices (instead of making your Mac constantly
change the sample rate), you will always maintain the highest possible
audio fidelity. In most environments a ‘'video black’ signal, referred to
as 'black burst,' is used as the central reference. When the same signal
is supplied to all rooms and all devices, it is often called 'house sync.'
Many multitrack audio decks and all video decks can make use of
such a signal. Whenever possible, hook up all of your analog devices
to black burst.

g—mm
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Hint: If you are using an inexpensive consumer video deck, you can gener-
ally improve your record-sync accuracy by using the 'poor person's
black burst.” You can accomplish this by turning on any video camera
(a 'Handycam' will suffice), and hooking up the video out from the
camera into the video in on the VCR. This will force the VCR to gen-
lock to the camera, which usually supplies a much healthier sync
signal than the VCR alone, and forces the VCR to play back with fewer
time fluctuations.

Slave DECK I only to digital sources: When you slave DECK I to a
digital source, such as timecoded DAT or digital multitrack recorders,
you can usually avoid any synchronization problems. These devices
are very dependent on the time accuracy of their playback, and usually
will not fluctuate playback speed. If you are slaving DECK II to such a
device, you should put DECK into Trigger Sync mode, then proceed as
usual. This is one of the best possible configurations for DECK II use.

Use a SMPTE Slave Driver: If you have a Sound Tools II or Pro Tools
system, you can make use of Digidesign’s SMPTE Slave Driver. The
SMPTE Slave Driver is a single rack-space box that converts analog d
SMPTE signal into digital slave clock and word clock. The Slave
Driver measures speed fluctuations in the source SMPTE signal and
continuously changes the record AND playback sample rate of the
Sound Tools II or Pro Tools hardware. This solution offers the best
system performance and audio fidelity, because all hard disk audio
recording and playback speeds are adjusted directly at the hardware,
thereby avoiding the degradation of the audio signal often caused by
software-based real-time sample rate conversion.

Important: There is one thing you must remember: You will seldom, if ever,
achieve positive results if you are trying to use DECK II with an
Audiomedia or MediaTime card to extend your old analog tape
machine by recording tracks on-line, editing those tracks, and then
playing those tracks on-line to re-record them back onto the analog
deck. Because DECK II cannot perform continuous resync on record,
and because older analog multitracks seldom play back twice at the
same speed, you will achieve inconsistent results. This is caused by
the fact that the analog device is inconsistent, and DECK II can only
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control for these inconsistencies on playback. Although you may
succeed in using this using DECK II in this fashion, there is no way to
rely on this method time after time.

You are ready to begin synchronizing DECK to SMPTE.

To synchronize DECK II recording or playback to time code:

* Make sure that you have your SMPTE source hooked up to a MIDI
interface that is capable of SMPTE-to-MIDI Time Code conversion.

Opcode's Studio 5 and Mark of the Unicorn's MIDI TimePiece are
recommended examples of such devices.

¢ Open the Session you wish to synchronize to time code.

* Choose the MIDI Setup command on the Options menu. This dialog
appears:

Please configure the serial ports:
<] Modom Port [] printer Port
Speed: Speed:
0.5 MHz O 0.5 Mz
@ 1.0 MHz (@ 10 Miiz
(2.0 MHz O 2.6 mH2
O Fast Qlast
@ Generic ® Generic
O MIDI Time Piece O MIDI Time Piece
O Studio 5 O Studio 5

Use this dialog to make sure that you have the correct MIDI port
enabled, and that it is set to the correct speed. For most applications,
you can turn on both the Printer and Modem ports and set them to the
1.0 mHz, Generic settings.
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Important: If you are syncing to SMPTE and running OSC's METRO sequencer
in the background (or foreground), configure DECK II to receive sync
and use it to control synchronized playback. DO NOT set METRO to
sync to SMPTE. Set up METRO as for normal, simple playback.
DECK will handle all synchronization tasks, and will control METRO
playback directly.

* Choose the SMPTE Start Frame command on the Options menu.
This dialog appears:

Hour M™in. Sec. Fr. Subfr.

101 b ] o

¢ Type in the hour, minute, second, and frame number of the SMPTE a

frame that will be used as your Session zero time (the beginning of
your coded tape, or the scene you are working with). Then click on
the OK button.

Hint: You can click on the dialog's Capture button to lift the current time
code frame from your time code source. Note, however, that the
Capture button will not lift an accurate time unless you are syncing to
video tape using Vertical Interval Time Code (VITC). If you are using
standard Longitudinal Time Code (LTC), the Capture button will lift
the last frame that was received, but that frame can vary by one second
or more from the actual position. This situation is caused by the fact
that only VITC can be read at slow shuttle speeds and in still-frame /
pause mode. LTC frame addresses are unreadable at slow speeds and
in still-frame /pause.

The time you enter in the previous dialog will be your SMPTE start

time, and the return-to-zero button will always return you to this
point.
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¢ Choose the Online command on the Options menu. A check appears
in front of the command to indicate that the current Session is online.

* To play back audio in sync with incoming time code, press the Play
button in the transport to put the current Session in play-standby.

The status indicator in the Transport window now says ‘Standby' to
indicate that DECK Il is waiting for incoming time code. As soon as
any time code is present at the selected MIDI port, DECK II will
synchronize and begin playback.

* To record audio in sync with incoming time code, make sure you
have a DECK 1l track record-enabled (in the Mixer window) as
described in chapter 4 under 'Recording your first track.'

* Press the Record button and then the Play button in the transport to
put the current Session in record-standby.

12:00:31:15

e

The status indicator in the Transport window now says ‘Standby’ to
indicate that DECK II is waiting for incoming time code. As soon as
any time code is present at the selected MIDI port, DECK II will
synchronize and begin recording. Note that it may take a few seconds
for audio recording and playback to lock and begin.

Hint: The SMPTE synchronization pre-roll time is user-adjustable in the
General preferences on the File menu's Preferences submenu. This
setting is adjusted in seconds, and the time you enter will be the
amount of time DECK II takes between the first received SMPTE frame
and the beginning of playback. If you have a fast Macintosh and a fast
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drive, you can set this preference to 2 seconds or less. If you are
having trouble getting DECK II to sync (‘'missed in-point' messages),
then set this value to 6 or more seconds.

Hint: DECK II allows you to perform a host of frame-accurate visual edits of
audio waveforms. For more information about spotting effects and
editing audio to SMPTE frame, see the Visual Waveform Editing in
Chapter 5 of this manual.

Live Video

If your computer has video input capabilities (AV Macintoshes or a
MediaTime card, for example) you can monitor your video in the
QuickTime window. Simply choose the Live Video command from
the QuickTime menu. Deck I will display any video coming into the
computer through the video input. You may change the size of the
QuickTime window using the Size submenu on the QuickTime menu.
For more information on configuring Live Video, consult the Reference
section of this manual.

Synchronizing DECK Il to QuickTime Movies

DECK 11 is not only useful as a 16-bit audio workstation for syncing to
external devices. It can also be used as a QuickTime audio post-
production tool. It is very easy to import any existing QuickTime
movie, and synchronize DECK II audio and automation to that movie.
(If you are using OSC's METRO sequencer, you can also synchronize
any MIDI to the same QuickTime movie at the same time.) DECK II is
capable of playing back four tracks of 16-bit audio and a QuickTime
movie (and that movie's 8-bit audio) simultaneously from a single
hard disk. Only a single command is required in order to do this.

To import and synchronize a QuickTime movie in DECK II:

* Create a new Session or open the Session you wish to sync to a
QuickTime movie.
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* Choose the Import Movie command on the QuickTime menu.

When you choose the Import Movie command, this dialog appears:

€3 DECK 11 Demo v | —ProStore

£ DECK 11 Demo audio files k| [ ooy ] h

oSt i | Desktop |
ﬁ {

l Lreate | ’“ m

Movie Rudio Handling:

O Put audio on clipboard

) Put audio in new work track(s)
@ Leave audio in movie

Preview

* Use the file selector area to find and highlight the movie you want.

You will always see the poster frame of the selected movie in the
preview box. If the selected movie has no poster frame, click on the
Create button to create a preview frame.

¢ Choose what you want to do with the selected movie's existing
audio (if there is any).

You must select one of the following options:

Put audio on clipboard: This option is a conversion option. It auto-
matically removes the source audio from the QuickTime movie and
converts it to 16-bit monophonic Sound Designer II file(s). These files
are created in the Session’s audio files folder, and then placed on your
Macintosh Clipboard for pasting into any track in the Track window.
To guarantee that the Clipboard file will sync to the imported movie,
you will need to drag or paste it so that it starts at the Session zero
time.

— s
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Hint: Remember, if the source audio was stereo, vou will need to select two
tracks when you paste the audio.

Put audio in new work track(s): This option is a conversion option. It
automatically removes the source audio from the QuickTime movie
and converts it to 16-bit monophonic Sound Designer II files. These
files are created in the Session’s audio files folder, and then placed onto
two new playlists on work tracks at the bottom of the Track window.
To play back these tracks, click on the track name area(s) to select the
track, then drag the track up to one of the play tracks. (You can also
use the playlist pop-up at the bottom of any track in the Mixer window
to move these new playlists up to playback tracks.) Choose this option
to make sure that the original QuickTime audio will be included in any
16-bit stereo mixdowns and in exported QuickTime movies.

Leave audio in movie: This option performs no file conversion. The
original audio remains in its source form, and is still associated with its
QuickTime picture. This audio will play back along with all DECK II
16-bit tracks when you play back the Session. Note, however, that this

tosh speaker or audio output. Choose this option if you wish to use

audio left in its movie will generally play back through your Macin- a

the original QuickTime audio as guide audio only. When you leave

your audio in the movie, you will get an extra track of playback, but
that track will be erased when you Export your finished QuickTime

movie with its new audio.

® Click on the Import button

After a few moments the QuickTime movie will appear at its native
size in DECK II's QuickTime window. You can change the size of the
QuickTime window using the Size submenu on the QuickTime win-
dow. If you chose to add audio to the Clipboard or to put audio on a
work track, the conversion process may take a few moments. If you
added the audio to the Clipboard, you will need to paste it onto a track
(making sure that it begins at the Session start). You are now ready to
continue the process of recording, adding, mixing and automating new
audio for your movie. The QuickTime movie will always play back in
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sync with the DECK Session, and the movie will always open when-
ever the Session is opened.

Note: DECK II will allow you to import QuickTime movies that have audio
at unsupported sample rates. If you import a QuickTime movie with
sampled audio at a sample rate other than 48, 44.1, 24, 22.05, 12, or
11.025 kHz, and you choose to place that audio on the Clipboard or on
a Work Track, DECK II will import the audio as 16-bit, but the audio
will not sync correctly to the source QuickTime picture. If you are
doing sync work with QuickTime movies that contain audio at odd
sample rates, you will need to do one of the following things before
you import the audio into DECK: 1) Resample that audio (in Sound
Designer I, for example) to one of the supported rates, or 2) import
the movie and leave the audio in the movie itself. If you use option 2,
you can always route your Macintosh CPU audio output to the input
of your audio card and lift the QuickTime source audio in real-time.
Future versions of DECK will automatically sample rate-convert the
source audio at import time.

Hint: If you are using DECK II as a QuickTime audio post-production tool,
make sure to try the Chase Positioning command on the QuickTime
menu. This command turns on QuickTime chase mode, which auto-
matically pops the QuickTime window to show the current frame
when audio regions are moved. (The frame at the region’s start time is
always shown.) This is an indispensable function for spotting music
and effects to specific frames.

Hint: QuickTime movies will generally not play back at 30 frames/second
on any off-the-shelf Macintosh. If you plan to use DECK II's
QuickTime movie window to play video guide tracks for tape-based
audio post-production, you may want to obtain a QuickTime accelera-
tor. For example, RasterOps' MediaTime board, coupled with their
MoviePack JPEG compression board will allow you to view full-
screen, 30 frame/second QuickTime movies from the hard disk as you
work within DECK. A second Macintosh color monitor is also prefer-
able in such a configuration.
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Mixer-based Automation

The process of mixing down a multitrack recording to a stereo master
is always complicated by the level and stereo pan changes that must
occur during the mixdown process. Smooth fades in and out, instanta-
neous pan changes that are modulated to a specific rhythm - these
functions usually require quite a bit of physical coordination, and they
are difficult to repeat. This is why high-end mixing boards offer
automated mixdown capabilities.

DECK I allows you to create record mixer automation so you can fully
automate your mixdown process. Perhaps the simplest way to auto-
mate a mixdown is to create and edit visual volume and pan envelopes
in the DECK II Track window. DECK II offers this fully-visual way of
automating as the simplest method for accurate control of volume and
stereo pan controls. The process of creating and editing these visual

automation envelopes is explained at length in the Visual Waveform
Editing chapter (Chapter 5) of this manual. a

DECK II also offers more traditional real-time mixer automation that is
based on the idea of 'performing’ a mix, and recording the motion of
the faders during the 'performance.’ This mixer-based automation also
creates automation envelopes that can be edited visually in the Track
window. To accomplish mixer-based automation, DECK uses the
concepts of ‘real-time fader motion recording,” ‘mixer states,’ and
transition time. Real-time fader motion recording is the simple record-
ing of the actual movement of DECK II's mixer faders. This is one
simple way to create automation.

Mixer state automation is more scene-by-scene oriented. A mixer state
is like a picture of the current position of every fader on the mixer.
Each state is stored on DECK's mixer state pop-up (in the Transport
window), and each can be recalled at any time. A fixed transition time
can be set, and that time is always used to fade smoothly between each
mixer state.
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Although real-time recording of fader motion and mixer states may
seem bit cumbersome at first, you will find that it often allows simple,
one-step recording mixdown automation.

To record real-time fader motion:

* Open the Session that you wish to automate and open that Sessions
Mixer window by choosing the Mixer command on the Windows
menu.

* Decide which track volume and pan faders you wish to automate.

e Use the Automate pop-up on the tracks you wish to automate to
set (record-enable) which controls you will be recording.

Record Pan
Record All

Erase Uolume

Erase Pan
A Croe Al

-

You can choose "Record Volume," "Record Pan,” or "Record AlL" You
are free to choose your controls by track (for example volume on track
1 and pan on track 2), or you can use the Automation submenu on the
Options menu to record all volumes and pans by choosing the Record
All command.

O
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Hint: Although it is possible to record automation using the mouse as a
controller, you may find this cambersome. Remember, the mouse can
only move one control at a time. For the best possible results, use an
external MIDI controller (a J.L.Cooper FaderMaster, for example) to
control the mixer faders that will be recorded. For more information,
see the MIDI Map Faders section in Chapter 6 of this manual (or the
MIDI Map Faders command in the Reference chapter).

* Click on the Transport window's Record button, and then on the
Play button to begin recording automation.

¢ Perform your mix as desired. All motion of record-enabled faders
will be recorded.

Remember, all of DECK IT's recording functions work the same way
with automation. For example, you can use punch-in mode to replace
a segment of automation just as you would replace a segment of audio.

* Click on the Rewind-to-zero button in the Transport window, and

then on the Play button to see and hear your new automation.
You can erase the automation on any track by using the erase com- a
mands located on the track’s Automate pop-up. You can also use this

pop-up to mute the automation on any track by setting the pop-up to
Off.

Important Although DECK II's faders may appear to move in a ‘chunky’ manner,
do not be deceived by this. DECK II automation is always reproduced
with 24-bit accuracy (over 16 million values between full volume and
no volume). The updating of the screen has a lower priority that the
control of volume and pan level. Your automation will always be
smooth even when the faders appear to jump.'

To view the visual envelopes for the motion you have just recorded:

¢ Choose the Track window command on the Windows menu. The
Track window appears.

* Set the Display pop-up on the track that contains the automation you
wish to edit to Volume or Pan.
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You can now see and edit the automation envelope you created when
you recorded real-time fader motion. (In the illustration, track 1 is set
to display the volume envelope.) If you wish to edit these envelopes,
you will find it easier if you first choose the Automation Thin com-
mand from the Process menu. This command will look for straight
lines in your automation data and eliminate extraneous envelopes. For
more information about editing these volume and pan envelopes, see
the automation explanation in the Visual Waveform Editing chapter of
this manual (Chapter 5).

Using Mixer States

Although it is possible to automate an entire mix without using
DECK's mixer states, these 'snapshot-style’ states can be very useful
(especially for creating complex automation moves that should occur
at specific spots). The mixer states are also quite useful, because they
allow you to move all of the volume and pan faders in the Mixer
window with a single mouse click. In order to use a mixer state for
real-time automation, you will need to store it. Once a mixer state has
been stored, it can be recorded in the same way that any real-time

@*—
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automation is recorded. In fact, you can mix real-time fader motion
automation and mixer state automation. Both styles of automation
simply create automation envelopes that can be edited in the DECK ]I
Track window.

To store a mixer state:
* Open the Session that you wish to automate.

* While playing back the audio, set the volume and pan faders to your
liking.

You can also set these states when DECK I is not playing back.

* When the entire mixing board is set up the way you desire, hold

down the command key and click on arrow button next to the spot
where the mixer state should be stored.

You have now stored a Mixer State, and the arrow button next to that
state can be used at any time to recall, or ‘play’ that state back onto the
DECK II Mixer. Note that new states are created with the name "Snap”
followed by a number. You can rename any mixer state by holding
down the command key and clicking on the name of the mixer state.
When you do this, the following dialog appears:

s )
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Use this dialog to type in a new name, then click on OK.

Important: DECK 11 allows you to store an unlimited number of mixer states.
Every time you store one, it is added to the Mixer State pop-up, which
contains all of the mixer states you have ever created. Each of the six
current mixer states can be set to give you instant access to any other
mixer state. To select a different mixer state for instant access, just
click and hold on the mixer state pop-up in the mixer position you
desire. This pop-up appears:

New

snap 1
All Down
snap 3
Rl Up
snap 5
Transport 700 - snap 6

g = snap ?
snap 8
snap 9
snap 10
snap 11
snap 12
snap 13
snap 14
snap 15
snap 16

Simply use this pop-up to select the state you want. That state will be
placed at the current mixer state position for instant access.

To recall a mixer state:

* Click on the arrow button to the left of the desired mixer state.

That state is instantly recalled to the DECK II mixer.

-
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Important: All stored Mixer States are saved with the current Session, and will be
present just as you left them when you next open the Session.

To record mixer state automation:

* Open the Session that you wish to automate and open that Sessions
Mixer window by choosing the Mixer command on the Windows
menu.

* Decide which track volume and pan faders you wish to automate.

* Use the Automate pop-up on the tracks you wish to automate to set
(record-enable) which controls you will be recording.

You can choose "Record Volume," "Record Pan,” or "Record AlL" You
are free to choose your controls by track (for example volume on track
1 and pan on track 2), or you can use the Automation submenu on the

All command.

Options menu to record all volumes and pans by choosing the Record a

Hint: Option-click on a Mixer State arrow button to delete the currently-
loaded mixer state. Command-click on any Mixer State pop-up to
rename the currently-loaded mixer state.

Important: Even though you are recording mixer states, only those faders that are
set to record will be recorded from the states. This allows you to
isolate only portions of your mixer states for automation recording.
Remember, if you want to record all faders from your mixer states,
choose the Record All command on the Option menu's Automation
submenu. This will record-enable all volume and pan faders.

* Click on the Transport window's Record button, and then on the
Play button to begin recording automation.

* During playback, click on the mixer state arrows whenever you want
to record a mixer state.
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Note:

Important:

The mixer state will be recorded at the moment you click the arrow.
Don'’t worry about the exact timing accuracy of the state. All automa-
tion can be edited visually in the DECK II Track window (see Chapter
5 for more information).

Remember, all of DECK ITs recording functions work the same way
with automation. For example, you can use punch-in mode to replace
a segment of state automation just as you would replace a segment of
audio.

* Click on the Rewind-to-zero button in the Transport window, and
then on the Play button to see and hear your new state automation.

You can erase the automation on any track by using the erase com-
mands located on the track's Automate pop-up. You can also use this
POp-up to mute the automation on any track by setting the pop-up to
Off.

Although DECK II's faders may appear to move in a ‘chunky’ manner,
do not be deceived by this. DECK Il automation is always reproduced
with 24-bit accuracy (over 16 million values between full volume and
no volume). The updating of the screen has a lower priority that the
control of volume and pan level. Your automation will always be
smooth even when the faders appear to jump.'

To record mixer state automation with pre-programmed transition
fade times:

* Choose the State Transition Time command on the Options menu. A
dialog similar to this appears:

Hour Min. Sec. Fr. Subfr.

oomfo]- oo
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This is the dialog you would see if you had DECK IT's basic units set to
SMPTE frame. You can use this dialog to enter the fixed smooth fade
that will be generated any time you click on a Mixer State button.

* Enter the duration of the smooth transition fade you wish, then click
on OK.

This duration is the period of time that it will take to fade to the new
mixer state. Here's an example: Suppose you have a mixer state that
has all of the track volume faders at full volume, but all of the faders
are currently turned all the way down. You set the State Transition
Time to 2 seconds, and begin playback. After a few moments, you
click on your "All Up" mixer state. You will immediately see the faders
begin to move smoothly, and after 2 seconds, the faders will all be in
the full volume position. This has allows you to generate smooth
motion on four faders at once with a single mouse click.

* To record this motion in real-time, simply follow the same steps

explained carlier in this chapter for recording all real-time automa- a
tion.

To use Mixer States in the Track window:
* Set the tracks to be edited to pan or volume.

* In Range (Waveform) mode, make an insertion point at the point in
time where the automation should be.

* Click on the correct Mixer State in the Track window. The new
automation envelopes associated with the mixer state will be at the
desired location.

When you record mixer state automation with automated smooth
transitions, the resulting automation can be edited visually, just as all
automation can be edited, in the Tracks window. See Chapter 5 for
more information.

Chapter 7 Synchronizing, Mixing & Mastering H



Important: Remember, DECK II's automation follows the playlist. If you move a
playlist to a work track and record a new one, you will need to create
automation for the new track.

Bouncing Tracks in DECK Il

‘Bouncing' is the process of 'ping-ponging' or submixing multiple
tracks together to create one or two new tracks. The new track is then
used in place of the original source tracks, thereby freeing up for-
merly-occupied tracks for more recording. On most four- or eight-
track systems, bouncing presents the only solution to the limitations
caused by a low total track count. Although DECK II imposes no
restrictions on the number of tracks that can be mixed together (see
Virtual Mixing below,) DECK Il also allows bouncing. DECK II offers
two major improvements to analog bouncing: DECK bounces tracks
digitally, which doesn't degrade the sound quality of the source
tracks. Also, DECK allows you to keep all of your source tracks, so
you can always go back to the original tracks and ‘re-bounce’ for a new
submix. (Analog bouncing generally requires that the source tracks be
erased so that new tracks can be recorded.) The latter of these qualities
brings with it an added bonus: DECK II allows you to bounce four or
eight tracks to one or two tracks. An analog four-track requires an
open track as the destination, so there is no way to bounce four to one
or four to two. The best analog result is three tracks bounced to one
track.

These are not the only reasons that make DECK II's track-bouncing
capabilities so superior. Perhaps the most important concept is that
DECK 11 allows you to bounce tracks in a purely visual fashion. To
bounce tracks in DECK, you simply need to select a range of time in
the Track window and choose one of the Bounce to Clipboard com-
mands. Your bounce takes place immediately, and the resulting track
or region can be placed anywhere you desire. Here are exact instruc-
tions for bouncing tracks in DECK II:

To bounce tracks:

* Open the Session that contains the tracks or regions you wish to
bounce.
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* Bring the Track window to the front by choosing the Tracks com-
mand on the Windows menu.

* Switch to Range mode by clicking on the mode button:

for]

* Drag to select the destination range for your bounced track(s). Your
screen should look something like this:

SurregiScape: Tracks

Important: When you bounce in DECK 11, all four/eight playback tracks are
always included in the bounce. For this reason, it really doesn't
matter upon which track you choose to select the range. Because of
this, you can use the shortcut of selecting the destination range instead
of the source range. This will return you to the Track window after the
bounce is complete, and require only that you choose the Paste At
command to finish the bounce and paste the new audio at the correct
point in time. Remember, you will want to select two destination
tracks if you are bouncing to stereo clipboard.

* Choose the Bounce All to Mono Clipboard or Bounce All to Stereo
Clipboard command on the Process menu to execute the bounce.
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This progress dialog will appear:

Mizing...

When the bounce is complete, you will be returned to the Track
window, and your originally-selected range will still be selected.

* Choose the Paste At command on the Edit menu to paste the
newly-bounced region at the correct place in time. The Track window
should now look something like this:

B SREEEREES, surreaiScope: Tracks B2
bR L0 3 v

MRy FTET a s 500 30,00

0.30:00
1y
= —ii3
A 1
1378 froe B B &

Important: You have now completed the bounce. This new region contains a mix

of all of the audio that was set to play in the selected range. All
volume levels, pan settings and automation envelopes are used to
create the bounced file, so it will sound exactly like the original source
tracks. You are now free to delete the regions that were used to create
the bounce. (In the case of this example, that would be the regions on
tracks 1 and 2.} Or, you can simply move the tracks used as source for
the bounce down to the Work Track area, where they will not play
back. This is the best option, because it allows you to go back to your
original source tracks if you desire.

SN S ——
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Hint: Bounce always bounces all of the play tracks in the selected time range,
regardless of which track contains the selection. If you want to make
sure that certain tracks are not used as source for a bounce, mute
those tracks. Mute and solo are taken into account when you bounce
to the clipboard. Also, set the automation status pop-up to play to
include automation.

Virtual Mixing

A major advantage in using a Macintosh digital workstation is that
you are not hindered by the limitations of the analog world. Analog
mixers are physically limited to the number of tracks that can be
played. DECK II does not do its mixing in real-time, so there is no
limit to the amount of audio it can mix (other than hard disk space).
Although you can only hear four tracks play at a time, if you master
the process of creating work tracks and moving playlists, you can
create an infinitely layered mix.

To use Virtual Mixing:

* Choose the Virtual Mix command form the Process menu. a

Whenever you choose a Bounce or Mix command, DECK II will then
mix work tracks as well as play tracks into the new file.

* Record your tracks as usual. Add the necessary automation to the
new tracks.

* When you have filled up the play tracks, create work tracks by
selecting the New Track command from the Process menu. Enter
four in the dialog box.

You will now have four new Work Tracks that will serve as destination
tracks for the playlists you have just recorded.

* Move the playlists to the Work Tracks. Use the playlist name pop-
up to select Playlist 1 on the first work track, Playlist 2 on the second,
etc. The process of moving playlists and using work tracks is
explained at length in Chapter 5.
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Hint: If you are planning to record many tracks, it is a good idea to rename
the playlists. Using DECK II's default naming system (Playlist 1,
Playlist 2, Playlist 3, etc.) will get confusing with many tracks. To
rename a playlist, command-click on the playlist name. Type in the
new name in the resulting dialog.

* Select New Playlist from the Playlist name pop-up on each of the
play tracks.

* Repeat the above steps until you have recorded all of your material.
When you are finished recording and editing, continue on to the next
step, Final Mastering to a Mono or Stereo Disk File.

Important: Using virtual mixing will quickly use up hard disk space. If your hard
disk space is limited, you may be best served by bouncing tracks and
compacting your Session. In either case, be sure you leave enough
hard disk space for the final Mix to Disk process. You should allow
about 10 MB per minute for the final mix.

Final Mastering to a Mono or Stereo Disk File

The last step in a recording project is generally the mastering process.
During mastering, a final stereo mixdown of the recording is created.
This stereo version is the “master,” from which all distributed copies
will be made. For this reason, the master must be the best possible
copy of the final mix.

This chapter has taken you through the different steps in the synchro-
nization, automation and mixing processes. Once your final mix is
automated to your satisfaction, you are ready for the digital mastering
process. In this process you will use DECK 11 to create a mono or
stereo Sound Designer II, Audio Interchange (AIFF), or Sound Re-
source soundfile on your hard disk. This soundfile will be an exact
digital copy of the mixdown from which it is created, including all
processing, level and pan settings and automation.

2
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Remember, however, that there are some planning steps you will need
to take before creating a digital master. If your Session plays back a
synchronized MIDI file from OSC's METRO sequencer, the MIDI
tracks will obviously not be included in a digital master until they
have been digitally recorded. The easiest way to do this is a two step
process: When all of your DECK II audio tracks are automated and
ready for mastering, turn on the Virtual Mix command on the Process
menu. Use the process described above in the Virtual Mixing section
to free two play tracks. If you are limited by disk space, use the
Process menu’s Bounce All to Stereo Clipboard command to bounce
the four play tracks to a final stereo image, then paste those bounced
regions on tracks 1 and 2 (for example). Finally, mix your MIDI file
into a stereo image at your mixing board, and record it in stereo onto
the two remaining DECK tracks (tracks 3 and 4, for example). You
now have your original audio and MIDI tracks in stereo audio form.
Add any extra mixer automation you might need, and you're ready for
the mastering.

To create a digital hard disk master of a Session:

* Open the Session you wish to master. a

Make sure that it plays back exactly as you wish the final mix file to
sound, because the master will be an exact copy of the Session as you
hear it. If you are using Virtual Mixing, be sure to audition each
playlist in a play track before mixing. The Virtual Mix will NOT
sound exactly like the Session, as it adds data to the mix from the
work tracks, which cannot be heard.

* Choose the Track command on the Windows menu to open the
Track window.

* If you want to mix only a portion of the Session to disk, select the
range you wish to mix before you choose the Mix to Disk command.

Remember, all four playback tracks (and work tracks, if virtual mixing
is enabled) are mixed to disk, even if you only select a range (or
regions) on a single track. To remove tracks from the mix, mute those
tracks. Be sure to select play on the automation status pop-up to mix
the automation.
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¢ If you want to mix the entire Session to disk, make sure that no
audio range or region is selected.

You can use the Deselect command on the Edit menu to make sure that
no audio is currently selected. Note that you can also choose the Select
All command before you mix to disk to make sure that the entire
Session file is mixed down.

* Choose the Mix to Disk command on the Process menu. This dialog
appears:
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Sample Rate: full Session «
Bit Depth:
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* Type in the name you wish for your master soundfile.

This will always default to the name of the Session followed by
“Mix.” Itis probably a good idea to use this naming scheme, be-
cause it associates the master and the source Session, and prevents
the possibility of replacing an important existing file.

* Select the destination folder for the master by using the standard
selector box.

¢ Use the pop-up menus to choose the Format, Sample Rate, Bit
Depth, and Number of Channels for your mix file.

51—

DECK If



The following options are available:

Format: Use this pop-up menu to choose the type of file you wish to
create. The most common high-resolution file type is the Sound
Designer II format. This is the native format used by DECK II, and it
is supported by a great number of audio programs. If you are creating
16-bit stereo masters for CD mastering, this is generally the format of
choice. The Audio Interchange File Format (AIFF) is another popular
high-resolution audio format. There is no difference if quality of
portability between Sound Designer II files and AIFF files. AIFF files
are better for cross-platform file exchange, and were designed with this
purpose in mind. AIFF files do not support the concept of audio
regions, and cannot be used for direct audio recording in DECK II or
Sound Designer II. For this reason, Sound Designer II files are gener-
ally suggested. Sound Resource files are Apple-standard format
audio files which have the highest level of 'desktop integration.' 8-bit
sound resource files are the standard used by your Macintosh system,
and they can be played back through the Mac speaker directly from
the desktop simply by double-clicking. Such 8-bit sound resources are

also easily integrated into programs such as Macromedia's Director, or
Adobe’s Premier.

Sample Rate: Use this pop-up to select the sample rate you wish to
have for your final audio master file. Generally speaking, higher
sample rates are better because they offer higher fidelity. However,
they also require more disk space. For the highest-fidelity results, set
this pop-up to Full Session. This will mix down your audio at 44.1
kHz (or 48 kHz, depending on the sample rate of the Session). Setting
this pop-up to 1/2 Session will mix down and resample audio to 22.05
kHz (24 kHz). The 1/4 Session will mix down and resample audio to
11.025 kHz (12 kHz). The lower the rate, the noisier the audio, so
choose the lower rates with care.

Hint: If you are mixing down a sound resource file with $-bit sound for

desktop playback, the 1/2 Session setting will produce very good
results.
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Bit Depth: Use this pop-up menu to choose the audio bit-depth you
wish for your audio master file when the audio is mixed. You may
choose between 8-bit and 16-bit. Generally you will use the 8-bit
format for playback from the desktop via the Mac speaker. (This
format also requires less disk space and plays back more efficiently.) If
you wish to create a true high-fidelity master, always choose 16-bit.

Number of Channels: Use this pop-up to choose whether you wish to
create a mono or stereo master file. When you create a mono file, all
stereo pan settings and automation is ignored.

Important: Apple’s Sound Manager is capable of enhancing the playback capabili-
ties of most Macintoshes. Forthcoming versions of the Apple Sound
Manager will allow playback of 16-bit stereo AIFF or sound resource
files directly from the Mac speaker (only 8 of the bits actually play).
This new software, in tandem with your audio hardware
manufacturer's output drivers, may make it possible to create and
exchange movies containing 16-bit stereo files as the standard format.
At the time this software was released, these enhancements are not vet
available. 8-bit mono is still the most universal format for desktop
audio and 16-bit stereo is always used in for high-fidelity mixes.
Consult Apple and your audio hardware manufacturer for the most
recent information.

* When you are ready, click on the Save button to create the digital
mix file.

During the mixing process, you will see a progress dialog that shows
you what is happening. After a minute or two the Track window will
reappear, and the mastering process will be complete. When you quit
or switch out of DECK II you will find a soundfile in the selected
format located in your chosen destination folder. It will be an exact
copy of the Session from which it came.

Important: DECK I uses the exact same set of routines to create a mix file that it

uses to play back the source tracks. For this reason, you can be abso-
lutely sure that the mix file will be a true copy of the Session's audio.
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Once you have created a digital master of your Session, you are free to
transfer it to a portable medium for duplication. If you are an Audio-
media II, Sound Tools II or Pro Tools owner, you can transfer the
master digitally to a DAT recorder. Then you can use the DAT cassette
as a master for pressing CDs or albums. You can also data-back up the
master files (or source files) to DAT using Digidesign’s DAT/a pro-
gram, or organize them for direct CD mastering using Digidesign's
MasterList program. These are the highest-fidelity methods for
backup and duplication, because there are no analog steps after the
original tracks are recorded. If you are an original Audiomedia owner or
AV user, you can rent time on a Sound Tools II or Pro Tools system for
digital DAT transfer, or you can use Audiomedia or AV machine to
play back your master for audio recording (to DAT or cassette). The
latter is still a very high-fidelity alternative, because there is only 1
analog step after the original tracks are recorded. The MediaTime and
NuMedia cards offer consumer optical digital output.

Mastering Your Final QuickTime Movie

If you are using DECK 1I as a QuickTime audio post-production tool, d

then the last step in your process is quite similar to the final audio
mastering process described in the previous section. The main differ-
ence is that you are creating a finished file (or files) that consist of
desktop playable picture, as well as sound. The process of mixing
down a final QuickTime movie (with audio) from the current Session
is very simple, and only requires a single step.

To create a final QuickTime movie with Session audio:

* Open the Session that contains the audio and movie you wish to mix
down.

Make sure that the Session and its movie play back exactly as you
wish the final product to look and sound. The exported movie will
be an exact copy of the Session as you see and hear it.

¢ Choose the Export Movie command on the QuickTime menu. This
dialog appears.:
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The Export Movie dialog allows you to create new QuickTime movies
that contain or references 8- or 16-bit mono or stereo audio inter-
change file format (AIFF) audio tracks at a variety of sample rates.
The exported movie contains all of the edited and audio with automa-
tion moves included. You can think of the Export Movie command as
a Mix-to-disk command for picture and sound. Itis usually the last
step in the QuickTime audio post-production process, and the result
can be played back on any Macintosh.

* Choose a destination folder and type in a name for the movie.

* Set your preferences for the format of the movie you wish to create.
The following options are available:

Make movie self-contained: This option creates an entirely new, self-
contained movie. The self-contained movie will consist of a single
QuickTime (Movie Player) document that contains all picture and
sound. According to QuickTime specifications, the sound and picture
are mixed together, creating a movie that is fully transportable and
plays efficiently (quickly). Note that a self contained movie will take a
while for DECK II to create, because it requires an extra step (‘flatten-
ing’) which can be time consuming. Remember, a self-contained movie
will generally be quite a large document.
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Hint: Make a movie self-contained when you want to create a single docu-
ment for delivery. If you are simply performing test edits and
mixdowns, do not make the movie self-contained. When the movie is
not self-contained, a new, extremely small (typically around 30K)
movie document is created. Like a DECK II Session, this document
simply references the source sound and picture files. The Movie Info
command in Apple's QuickTime Movie Player can always be used to
determine which audio and picture files are used by a movie that is not
self-contained.

Add audio to movie: This option determines whether the audio from
the current DECK Session will be mixed, converted and added to the
finished movie. You will generally want to have this option turned on.
When it is turned off, a 'silent movie' document is created.

Audio Format: Use this pop-up menu to choose the audio bit-depth
you wish for your audio mixdown file when the audio is mixed and
the movie is exported. You may choose between 8-bit mono, 8-bit

stereo, 16-bit mono or 16-bit stereo. Generally you will use the 8-bit

mono format for playback from the desktop via the Mac speaker. (This a

format also requires less disk space and plays back more efficiently.) If
you wish to create a high-fidelity master, choose 16-bit stereo. An
AIFF soundfile is always created, unless you chose ‘Make movie self-
contained,' in which case the audio is placed directly into the movie
picture data.

Important: Apple's Sound Manager is capable of enhancing the playback capabili-

ties of most Macintoshes. Forthcoming versions of the Apple Sound
Manager will allow playback of 16-bit stereo AIFF files directly from

- the Mac speaker (only 8 of the bits actually play). This new software,
in tandem with your audio hardware manufacturer's output drivers,
may make it possible to create and exchange movies containing 16-bit
stereo files as the standard format. At the time this software was
released, these enhancements are not yet available, and 8-bit mono is
still the most universal format for QuickTime audio. Consult Apple
and audio hardware manufacturer for the most recent information.
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Sample Rate: Use this pop-up to select the sample rate you wish to
have for your final QuickTime movie audio. Generally speaking,
higher sample rates are better because they offer higher fidelity.
However, they also require more disk space. For the highest-fidelity
results, set this pop-up to Full Session. This will mix down your
audio at 44.1 kHz (or 48 kHz, depending on the sample rate of the
Session). Setting this pop-up to 1/2 Session will mix down and
resample audio to 22.05 kHz (24 kHz). The 1/4 Session will mix down
and resample audio to 11.025 kHz (12 kHz). The lower the rate, the
noisier the audio, so choose the lower rates with care.

Hint: If you are mixing down a QuickTime movie with 8-bit sound for
desktop playback, the 1/2 Session setting will produce very good
results,

* Click on the Save button to export the movie.

After a short while, you will be returned to the DECK II Track win-
dow, and you will find your new QuickTime movie in the destination
folder you specified. '

Note: Remember, only one QuickTime movie may be opened at any time. To
close the current movie, use the Dispose Movie command. This will
allow you to import a different movie.

Editing Audio Regions in Sound Designer Il

If you own Digidesign NuBus cards, you can use Digidesign’s destruc-
tive visual sample editor, Sound Designer II to edit all DECK audio
regions and tracks. DECK Il is designed to allow you to run Sound
Designer IT and DECK at the same time, and DECK even offers a
command that automatically switches you into Sound Designer Il and
selects the audio region you had selected in DECK. Once you have
opened an audio file in Sound Designer II, you can make any destruc-
tive changes you desire, including “click and pop’ repair, destructive
parametric and graphic EQ, dynamics processing, and even noise
reduction.

L
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To set Sound Designer II as your sound editor:

* Choose a the General command on the File menu's Preferences
submenu. This dialog appears:

[:] Hutostap at end of Session

[E Always save regions when Session is saved
(] Rewrite region list

[ Stop audio playback if the drive is too slow

[] Change region start times with BPM change

[<] Loop audition

Update speed during plagback (1-10): [1_|
SMPTE Preroll Time: |5.000 'Seconds
Sound Editor signature: $d2a [Setr |

Transport key equivalents
ATZ | Rewind | Stop | Play FF
<> <N <2 <3 <+
(set) | ey | (sev) | Fev) | (e

l 0K I [ " Cancel i

* Click on the Set button to the right of "Sound Editor signature.” This
dialog appears:

|£3 Sound Designer 11 PT™ 2.5 v | — Rudio/Video

3 SDII Plug-lns 20 [ Eject
2 SO11 Sample Rates

* Use this dialog to locate your copy of Sound Designer I1.

* Select Sound Designer II and click on the Open button.
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After a moment you will be returned to the General preferences dialog.
You will now see "SD2a" set as the sound editor signature. You have
now set up Sound Designer II as your sound editor. Note that you can
choose any sound editing program as your sound editor using this
same process.

To edit a DECK I audio region in Sound Designer 11 automatically:

* Make sure you have selected Sound Designer II as your sound editor
using the process described above.

* Choose the Track command on the Windows menu to bring the
Track window to the front.

* Click on the edit mode button to switch to Object mode:

* Click to select the audio region you wish to edit in Sound Designer
IL. It should look like this:

{4}

® Choose the Launch Editor command on the Process menu.

You will immediately be launched into Sound Designer IT and the file

that contains the selected region will be opened with the regions

highlighted in black. You can now perform any edit you desire, and o
when you save the change and switch back to DECK, the changed

soundfile will play back.
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WARNING: Edit your audio regions with care if you plan to play them from DECK
again. If you destructively delete a waveform range or change the
length of the file, you will change the overall timing of the DECK
playlist(s), and your Track window arrangement may be permanently
altered.

Note: If you install an Sound Designer II EQ or dynamics setting for play-
back, that EQ will not appear for playback in DECK II.

Note: When you change a waveform in Sound Designer II, remember that
the DECK Il waveform will not visually reflect the change until the
next time the Session file is opened. Rest assured, however, that DECK
II will always play back the changed audio data.

This concludes the Synchronization, Mixing and Mastering chapter of

this manual. For more information about specific DECK IT windows,
command and options, see the Reference chapter.
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Introduction

This chapter of the DECK Il manual is devoted to explaining all of
DECK II's windows, screen controls and indicators, and each of the
menu commands found on DECK II's seven menus. If you have a
specific question about a DECK IT window, command, control, or
function, this chapter is for you. If you are curious about a specific
task, or you want to learn about DECK II in general, then you should
read through the previous chapters of this manual.

The DECK Il Windows

All of DECK IIs recording, mixing, automation, and mapping func-
tions are available from the DECK II Mixer and Track windows. The
Mixer window is quite similar to original DECK's portastudio inter-
face. You can use the Mixer window to accomplish all basic audio
tasks, including recording, overdubbing, synchronizing, mixing, and

automating. If you simply wish to use DECK II as a 4-track
portastudio, then this window and the Transport window are the only

windows you will need.

The DECK II Track window really represents the true power of DECK
IL. Tt contains the tools that turn DECK II into a full-featured digital
audio workstation. You can use the Track window to accomplish most
of the functions that are available from the Mixer window, but in
addition you an view and edit your audio waveform data. The Track
window contains tools that allow you to record, cut, slice, slip, spot,
bounce, place and automate any audio file or region. It is important to
note that Track window edits are non-destructive, so no edit ever
destroys data, and all edits can be undone. If you intend to use DECK
Il to record and edit audio, or to place and synchronize effects, music,
or dialog, the Track window will be your tool.

DECK I also offers a Transport window that you can use to control
audio playback and recording, a MIDI window that you can use to
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import a standard MIDI file to hear it play back with your Session, a
Library window which allows you to easily view your source material,
and a QuickTime window, which allows you to load and play a
QuickTime movie in sync with your digital audio. These windows are

quite simple, and they are also explained in this chapter.

The Mixer Window

Although the DECK II Mixer window generally looks and acts like a
portable four-track recorder, it is much more powerful, and in some
ways it is also more complex. Because DECK ITis a hard disk recorder,
and it offers full digital processing and mixdown automation, it cannot
mimic analog recorders in every way. Read through this section to
understand the different Mixer window controls and commands.

Then proceed to the previous chapters of this manual, for in-depth
information about using those controls and commands.

This is the DECK II Mixer window:
Track NL@ber Mixer Module

o

1

TSRS SpundScape: Mixer

Track Input Selector ‘m | m
Track Automation Pop-up :
Track Output Pan Selector ———— MISEIE, S Av ot
Track Pan Fader — s
25 B Track Solo Button
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//' Track Record-gnable Button
Track Volume Fader
e - |
Track Playlist Selection Pop-up P11 Hwlin T owiis - =
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Track VU Meter  Track Clip Light
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Track Number: DECK IT's mixer has four track modules — one for each
of the four playback tracks. This label at the top of each mixer module
tells you which track you are looking at.

Hint: Remember, DECK II lets you work with an infinite number of audio
tracks, but only the top four will play. You can move any tracks to
these top four tracks using the Track Playlist Selection pop-up (ex-
plained below) or by dragging them in the Track window.

Track Input Selector: This numeric selector allows you to choose
which of the audio inputs on your hardware will supply signal to the
current track for recording. To set this number, just click and drag on
the selector. Upward or leftward motion will increase the number,
while downward or rightward motion will decrease it.

Important: Each enabled record track must be set to a unique input. Multiple
tracks cannot record from the same input.

Hint: As with all selectors in DECK 11, you can hold down the command key
and click on this number. This allows you to edit the value as text by

typing from the keyboard. a
Track Automation Pop-up: The track automation pop-up brings up a

menu that looks like this:

off

Play

Record Uslume
Record Pan
Record All
Erase Uolume
Erase Pan
Erase Al

Track Automation pop-up
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You will use this pop-up to record, play back, and erase real-time
volume and pan automation on this track. (If you wish to draw
automation envelopes for volume and pan, see the Track window,
explained later in this chapter.) The Track Automation pop-up offers

these choices:
Off: Mute all automation on this track.
Play: Play all automation on this track.
Record Volume: Enable real-time volume automation recording on this track.
Record Pan: Enable real-time pan automation recording on this track.
Record All: Enable real-time volume and pan automation recording on this track.
Erase Volume: Erase all volume automation on this track.
Erase Pan: Erase all pan automation on this track.
Erase All: Erase all automation on this track.

Use these settings to enable automation recording, or to erase existing
automation data. Automation moves can be generated by moving the
faders, or by clicking on DECK II's Mixer State buttons in the Trans-
port window. Remember, automation recording is quite similar to
audio recording. You will need to click on the Transport window's
Record and Play buttons to record actual automation moves, and all
loop and punch-in functions apply to automation as well as audio. For
more information about recording and editing automation see Chap-
ters 5 and 6 of this manual.

Hint: If you are recording real-time automation moves, it is possible to use
the mouse, but the mouse only allows you to adjust one control at a
time. You will achieve much better results if you use a MIDI fader
controller (such as J. L. Cooper's FaderMaster) to control your DECK II
track faders. For more information, see the MIDI Map Faders com-
mand on the Options menu.

Important: DECK II records your fader motions at MIDI resolution, however
during playback these values are interpolated up to 24-bit resolution
(over 16 million values between 0dB attenuation and full attenuation).
Although your DECK II screen faders may appear to move in a jumpy’
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fashion, be assured that this is only your Mac screen updating. Audio
always takes precedence and is always adjusted in a smooth manner.

s Track Output Pan Selectors: These selectors allow you to choose the

' output pair through which the track's audio will play. The left-hand
number represents the left output channel and the right-hand number
represents the right output channel. The pan fader allows you to place
and move the track’s audio smoothly between these two outputs. To
set the Pan Selectors, just click and drag on the selector. Upward or
leftward motion will increase the number, while downward or right-
ward motion will decrease it.

Important: The output pan settings cannot be changed on Audiomedia or
MediaTime cards, because these cards have only two outputs.

— Track Pan Fader: This control allows you to adjust the placement of

% the track's audio in the stereo field. By moving the fader left and right,
you will hear the track’s audio move in a corresponding fashion within
the stereo image. Remember, this only functions correctly if you have
routed your audio card or interface's outputs to the left and right
channels of an amplification system.

you are simply playing back a track of audio, the track volume fader
controls the overall volume level of the track. When the fader is all the
way up, the track is at its loudest. When it is all the way down, the
track will be silent. When you have the track record-enabled (with
the track Rec button highlighted), the track volume fader controls the
monitor level of the input signal. Remember, the monitor level setting
does not change the actual level of the track's recording, it only adjusts
the listening level of that signal.

Important: Sound Tools IT and Pro Tools systems have no input level setting. You
have to adjust the level of the source signal to change the actual
recording level of the signal. The Audiomedia and MediaTime cards
have a software input level setting, which you can adjust using the
Input Level submenu on the Options menu.
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Hint: Whenever you move a fader in DECK II, you will see that fader's value
displayed in the Transport window's value indicator box. If you want
to enter a specific level for a DECK II fader, hold down the command
key and click on that fader. A dialog will appear, allowing you to
enter the exact value you desire.

Hint: If you turn a track all the way up and it still seems to be too quiet
compared to your other tracks, try selecting that track in the Track
window and choosing the Normalize command. This will increase the
overall volume of the track to its maximum. For more information, see
the Destructive Effects submenu on the Process menu.

sola]  Track Solo Button: Click on a track’s solo button when you want to
hear that track alone. Click it again to hear all tracks. Note that
multiple tracks may be soloed simultaneously, and that track solo
always takes precedence over track mute. (In other words, a track that
is both muted and soloed will play back.)

mute] Track Mute Button: Click on a track's mute button when you want to
turn off that track's playback. Click it again to turn the track back on.
Note that multiple tracks may be muted simultancously, and that track
solo always takes precedence over track mute.

Track Record Enable Button: Use a track’s Rec button to record-
enable that track. You cannot record audio onto a track unless this
button is highlighted. When you click on this button, you will imme-
diately be able to hear the audio that is coming in the input selected in
the track's input selector. Increase the incoming signal level at the
source (or, for Audiomedia/MediaTime cards, you can use the Option
menu's Input Level command) until the track VU meter shows a
healthy signal level. You can use the track volume fader to adjust the
monitor level of the incoming signal, but remember this does not
change the level of the recorded signal. Once you have a healthy level,
you can record the incoming signal by clicking on the Transport
window’s Record and Play buttons.

Hint: Remember that the track volume fader controls both the level of the
track’s existing audio and the monitor level of the incoming signal.
When the track Rec button is highlighted, you are adjusting the
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monitor level of the incoming signal. When it is not highlighted, you
are adjusting the level of the track's existing audio. Switch back and
forth to match monitor levels on punch-in recording passes.

Track VU Meter: A track's VU meter serves two purposes. When the
track is not record-enabled, the meter shows you the amplitude
(volume) level of the audio signal on that track. Remember that the
VU levels are shown pre-fader, which means that VU level indicates
the amplitude of the track regardless of the track’s fader setting. This
allows you to see where you have signal, even if that signal is muted
or fully attenuated. When the track is record-enabled, the meter
shows you the amplitude (volume) level of the incoming audio signal
present at the selected audio input. In this case, the track VU meter
serves a very important purpose. You must use it to adjust the incom-
ing signal to the highest possible level without clipping. If the signal is
too high, the Track Clip Light will turn on. Click on the Clip Light to
turn it off, then adjust your signal. One of the keys to successful digital
recording is careful adjustment of the input signal. Too low a signal
will result in a noisy recording (poor signal-to-noise ratio). Too high a
signal will clip, causing digital distortion.

Track Playlist Selection pop-up: Use this pop-up to select which or a

your playlists is cued to play on the track module. To do this, simply
click and hold on this pop-up, and then drag to the desired playlist
and let go of the mouse. The selected playlist will be moved to the
current track module, and the previously-loaded playlist will be
swapped to occupy its old place. Note that automation data is associ-
ated with the track position, and will remain on the track with the
newly selected playlist.

The Track Window

The DECK II Track window is the portion of the program that truly
differentiates DECK from an analog portastudio. The Track window
offers a host of tools for recording, editing, defining, slipping and
otherwise manipulating audio. Most of DECK II's Track window edits
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are non-destructive. This means that your edits never erase existing
audio, and they can always be undone. Because DECK II uses the
concept of 'playlists’ to organize audio playback, the Track window
offers a number of other important benefits. The playlist architecture
allows you to copy and paste any audio without requiring that the
audio data be duplicated. For example, if you have a two-bar drum
riff, and you paste 1000 copies of it onto a DECK II track, those copies
will occupy almost no hard disk space. DECK II accomplishes this by
playing the same audio data over and over again. This means that you
can create very long, evolved compositions and arrangements in
DECK II even with a minimum of disk space - and this is only one of
the many benefits afforded by the new Track window.

This is what the DECK II Track window looks like:

Display Mode Buttons ~ View Adjust Buttons  Edit Mode Button Tempo Controls  Data Indicator Boxes

N -

] Waveform Area

Track Control Area £

b | B 3
! | X ~ Serall Bars
Drive Status ~ Automation Envelope  Audio Region  Selected Range  Fade/Crossfade

o— @ @ @
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Display Control Area: This area of the Track window contains all of
the controls you will use to adjust the track display, change edit
modes, and alter the Session's tempo. The specific functions of the
buttons, selectors and indicators in this area of the window are ex-
plained over the next few pages.

Display Mode Buttons: The DECK II Track window contains three
display mode buttons. These buttons toggle certain general waveform
display characteristics on and off. Here is a list of these buttons, and
explanations of what they do:

——  Track Size Button: This button toggles all tracks in the track window

E between three display sizes. The tall display can comfortably show
two tracks on a 13"/14" monitor. This display is useful for locating
zero points in your audio. The medium display can show six tracks
and is useful for most of your editing tasks. The short display can
show up to 24 tracks at once, which is particularly useful for editing
complex material.

Waveform Draw Button: This button toggles the drawing of wave-
forms on and off. When the waveforms are turned off, all audio

you are arranging existing audio entities, because it greatly decreases

regions are drawn as simple filled boxes. This is can be quite helpful if a

screen redraw time and 'unclutters' the display.

Hint: When you have waveform drawing turned off, DECK II will not take
any time to create waveform overviews after record ing, so general

operations will often execute more quickly.

Track Text Button: This button toggles the drawing of region name
text on and off. When the region names are turned off, all audio
regions are drawn with no labels. This is can be useful if you are
editing region lengths based on waveform envelopes, because it
'unclutters’ the display and makes it easier to concentrate on waveform
data.

el ol Bz View Adjust Buttons: The Track window offers five types of view
%;% 00355 adjustment buttons. You will use these buttons to adjust the way that
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the waveforms are displayed in the waveform area. Generally, these
buttons adjust the amount of time you see horizontally in the wave-
form area. In many ways they are the most important buttons in the
Track window, because you will need to use them to navigate around
your audio regions and soundfiles. Here is a list of these buttons, and
explanations of what they do:

Contract Display Button (Zoom Out): Click once on this icon to adjust
Q I the display to show more time. You can think of this as a 'demagnify’
tool that will show you more of your entire Session.

Shortcut: Hold down the command key and click on this icon to zoom all the
way out and view the complete Session. Hold down the Option key
and click here to zoom out 2X and hold down the Option and Shift
keys to zoom out 4x.

DA Expand Display Button (Zoom In): Click once on this icon to adjust
.\¢ the display to show less time. You can think of this as a magnifying

glass that will zoom in at the left side of the display to show you
greater waveform detail. You will often want to zoom in using this
tool when you wish to make subtle evaluations and edits.

Shortcut: Hold down the command key and click on this icon to zoom all the
way in to the sample/subframe level. Hold down the Option key and
click here to zoom in 2X and hold down the Option and Shift keys to
zoom in 4x.

i1 Fit Selection Icon: This icon automatically expands or contracts the
* 1 display so that the current selection fills the screen. This is true
whether the selection is a region or a waveform range. This tool makes
it possible to view rapidly any specific audio range, region, transition
or event.

Shortcut: Press the "Z" key on your keyboard with the mouse button still down
after making a selection in the Track Window. This will automatically
zoom the selection to fill the screen.

Hint: You can use the Selection Tools commands on the Options menu to

st
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snap the display to various selection-based positions without changing
the zoom level (display resolution).

Shortcut: The Axis Resolution pop-up is also a very useful tool for adjusting the
waveform display to specific zoom levels. It is explained later in this
chapter.

Waveform Expand/Contract Buttons: Use these buttons to manipulate
+ the vertical display resolution of the waveforms. The up arrow

M expands the waveform display for viewing audio recorded at low

levels, or for finding the zero points of a waveform. The down button

returns the display to normal resolution.

Shortcut: The "[" and "]" keys can be used instead of the up and down arrow
buttons.

_11 21 View Memory Buttons: DECK II offers four separate view memories
é] 4] which you can use to store the current state of the Track window's
' waveform area. Each view memory saves the current view resolution,
position, and selected range or insertion point. To record the current
view into one of the view memories, just hold down the command key

click on that view memory button at any time. The view memories are

and click on that view memory number. To recall the stored view, just a

particularly useful for storing waveform views that you plan to use
often, or locations and resolutions of problem areas. They also make it
possible to store a number of potential loops for later recall.

Edit Mode Button: Use the Edit mode button to switch between
Object Select (Hand) and Range Select (Waveform) mode. Object
Select allows you select, cut, copy, paste, redefine, process and other-
wise manipulate entire audio regions as units. It is most useful for
arrangement. Range Select mode allows you to select waveform
ranges within any audio region. It is most useful for editing of compo-
nents before arrangement begins (creation of loops, etc.). Click on this
button to switch between modes.

Shortcut: Use the tilde key (°) to switch between Object and Range Select modes.
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Tempo Controls: DECK II's tempo controls do not change the speed
of audio playback. These controls allow you to set the base tempo and
time signature that will be used by DECK to display and edit audio in
Beat mode. These settings make it possible to set up Beat mode to
snap edits and selections to the desired bar and beat lengths of posi-
tions. If you are using METRO as your sequencer, the tempo setting
will automatically be set by METRO, and any changes made to the
tempo will be reflected in METRO.

Data Indicator Boxes: The Track window data indicator boxes show

Z1.03.000
0026 01:944 you the pertinent information about the current mouse position or

0027 01.040 selection. Whenever the Track window is active, this box displays the

HD0.CE current time (under the hot-spot of the cursor), and the start time, end
time and duration of the selected object or range. All times are indi-
cated in the selected axis units. (For more information, see the Axis
Units pop-up.)

Hint: Since the ‘current’ time shown in the data indicator box is the time
directly under the cursor, you can place (spot) a specific point in any
region to the exact frame or beat by grabbing the desired region at the
hit-point of the waveform and dragging the region until the current
time indicates the frame or beat you want. This spotting method
makes it possible to spot sound by points other than region start and
end points, without requiring a special spot mode.

Axis Units Pop-up: This pop-up menu allows you to select the time
units by which you will be editing. The selected time units appear at
on the horizontal axis directly above the waveform area of the win-
dow. You may choose between the following units: Sample, Second,
SMPTE and Beat. Sample displays the sample number in relation to
the start of the Session (there are 44,100 or 48,000 samples per second,
depending on your Session sample rate). Second displays all times in
wall-clock time. SMPTE displays all times by SMPTE timecode frame,
which is useful for synchronization to picture or external tape devices.
(See the SMPTE Format submenu on the Options menu to select your
SMPTE frame format.) Beat is generally used for music composition,
and is particularly useful when you are using DECK II in sync with a
MIDI sequencer.

G—
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Axis Resolution Pop-up: This pop-up allows you to snap the wave-
form display to a number of different view resolutions. The available
resolutions are always natural subunits of the master axis units. (For
example, Second offers Minute, Second, Centisecond, Millisecond, and
Sample as its resolutions.) When you choose one of these resolutions,
the waveform display is immediately adjusted so that you may work
at the selected zoom level. Since the selected range is never deselected
when the axis resolution is changed, you can easily change resolutions
to zoom in for fine edits of waveform ranges selected while you are
zoomed out. For example, you can select a waveform range at the
minute resolution, and switch to the millisecond resolution to make
fine-adjust the size of the range. Note that the waveform display can
be adjusted to a great number of resolutions. You can always use the
Axis Resolution pop-up to make sure you are the view resolution is set
to usable units. This will assure you that DECK II's smart grid will
snap to your desired units (if you have it turned on).

Hint: Remember you can use the Selection Tools submenu on the Options
menu to pop the waveform display to show specific areas (the start or
end of the current selection, for example) with a single command,
regardless of the view resolution.

m Snap to Grid icon: This icon allows you to turn DECK II's grid on and q

off. DECK II's grid is a 'smart grid.” That means that the grid units
auto-adjust to match the current axis resolution. For example, when
the axis resolution is set to bars, the grid is one bar. When it is set to
quarter notes, the grid is one quarter note. The grid is particularly
useful for music or sound arrangement according to specific tempo.

Time Axis: This area of the waveform display indicates the time frame
of the waveforms in the waveform area. The time axis is always
shown in the units selected on the Axis Units pop-up, and the axis is
constantly adjusted as the magnification level (view resolution) is
changed.

Tk U B DI e T

Track Control Area: You will use this area to control the automation,
playback and recording of playlists on an individual track. The
specific functions of the buttons, selectors and indicators in this area of
the window are explained over the next few pages.
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Track Label/Drag Area: This area of each track in the track window

l- lists the number of the current track. Remember, only tracks 1-4 will
play. All other tracks are work tracks. To move any track to another
track position, select the track by clicking in this area. Once the track is
highlighted, you can then click and drag it up or down to its new
position. This is one way to select which tracks will play.

Hint: You may wish to view the tracks in short mode (using the Track Size
button) when you are moving them from track position to track
position. This allows you to view more tracks at one time.

Track Playlist Pop-up: This area shows you the name of the track
(playlist) that is currently loaded in the indicated track position. You
may change the playlist on a track by pressing down on the pop-up
and selecting a new playlist. You may also change the name of the
current playlist by command-clicking in this area.

Track Input Selector Pop-up: This pop-up menu allows you to choose
which of the audio inputs on your hardware will supply signal to the
current track for recording. Think of this control as a software
patchbay that lets you select the input from which you will be record-
ing. To set the input number, just click and drag on the pop-up menu,
and let go of the mouse when the correct input is selected.

i8fM] Track Mute and Solo Buttons: Click on a track’s solo button when
you want to hear that track alone. Click it again to hear all tracks.
Note that multiple tracks may be soloed simultaneously, and that track
solo always takes precedence over track mute. (In other words, a track
that is both muted and soloed will play back.) Click on a track's mute
button when you want to turn off that track's playback. Click it again
to hear turn the track back on. Note that multiple tracks may be muted
simultaneously, and that track solo always takes precedence over track
mute.

Bl Track Record Enable Button: Use a track’s Rec button to record-

. enable that track. You cannot record audio onto a track unless this
button is highlighted. When you click on this button, you will imme-
diately be able to hear the audio that is coming in the input selected in
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the track’s input selector. Increase the incoming signal level at the
source (or, for AV machines and Audiomedia/MediaTime cards, you
can use the Option menu's Input Level command) until the Mixer
window’s track VU meter shows a healthy signal level. You can use
the track volume fader to adjust the monitor level of the incoming
signal, but remember this does not change the level of the recorded
signal. Once you have a healthy level, you can record the incoming
signal by clicking on the Transport window's Record and Play buttons.

Hint: When you are recording audio, you will need to open the Mixer
window to set levels and view incoming signal VU meters. For more
information, see the Mixer window information earlier in the chapter.

Track Level and Pan Indicators: Use these indicators to monitor level
and pan values while editing automation. The indicators also appear
in the Transport window.

Track Automation View Pop-up: This pop-up menu allows you to
view, create and edit automation envelopes in the waveform area of
the Track window. When this pop-up is set to None, then the track
shows and edits only waveform information. When Pan is selected, a

lope is shown, up represents left-channel placement and down repre-

pan envelope is shown (if pan automation exists). When a pan enve- a

sents right-channel placement. When Volume is selected, a volume
envelope is shown (if volume automation exists). When a volume
envelope is shown, up represents increase in volume and down
represents decrease in volume. When you are editing automation
envelopes, you may perform most editing commands such as cut,
copy, and paste as well as many of the editing shortcuts listed at the
end of this chapter. Object (hand) mode allows you create and adjust
one or more individual breakpoints, and Range (waveform) mode
allows you to edit envelope ranges.

Shortcut: Hold down the Option key while selecting an automation view to set
all tracks to the same view.

Hint: To create new automation brea kpoints /envelopes, select Object (hand)
mode and set the track to view the correct automation type. Then hold
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down the command key and click anywhere on the waveform to create
an automation point. Continue command clicking to create more
points, or click and drag on points to move them. To delete existing
points, hold down the option key and click on a point. You may also
delete points by selecting a group of points in Object mode or an
envelope range in Range mode, and pressing the delete key.

Track Automation Status Pop-up: The track automation status pop-
up functions in exactly the same fashion as the one explained at length
under the Mixer window earlier in this chapter. For information about
real-time recording of fader motion, see that section of the manual.
When you are editing automation envelopes in the Track window, this
pop-up is most useful for turning automation on or off by track, and
for erasing all of the automation on a track. This pop-up must be set to
"Play” during the mixing process to ensure that your automation data
is calculated into the new file.

Shortcut: Hold down the Option key while selecting the automation status to set
all four tracks to the same status.

Important: DECK II generates fader motions at 24-bit resolution (over 16 million
possible values between 0dB attenuation and full attenuation). Al-
though your DECK II screen faders may appear to move in a jumpy’
fashion, be assured that this is only your Mac screen updating. Audio
always takes precedence and is always adjusted in a smooth manner.

Work Tracks: DECK Il allows you to play back four tracks of audio at
any time, but the Track window lets you create an unlimited number
of work tracks. A Work Track functions just like a Play Track except
that you cannot hear audio played back from a Work Track. This
allows you to use the Work Tracks to create a "Virtual Mix." When you
have the Virtual Mix command enabled, DECK II will mix Work
Tracks as well as Play Tracks. When using this feature, be sure to have
your automation set to "Play” and to mute Work Tracks that you don't
want mixed, as you cannot hear the entire Session before you perform
a Virtual Mix.

To set a work track to play, just select it by touching the track Label /
Drag Area and then dragging the work track up into one of the top
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four positions. You can also accomplish this by using the Track
Playlist Selection pop-up to select the work track playlist you wish
move to a play track.

Waveform Area: This area of the window contains the actual tracks of
audio data which you record or add (place). To the right of each
track's control area is the actual waveform data that makes up that
track’s playlist.

: Selected Range: The currently selected range is always highlighted so
» : : itis easy to see. This is the waveform range that will be used for any
_ " selected edits (such as cut, or paste). You can recognize a waveform

range selection, because it shows no thick outline or region definition
tabs. Select a range by switching to Range (waveform) mode and
dragging the cursor over any waveform area on one or more tracks.
Use the shift key to extend or contract your selection to a new point.
Waveform selection is very useful for testing out potential regions and
loops, and for selecting audio to be deleted from the Session.

: Selected Object: Selected objects (regions) look different than selected
M waveform ranges. A selected object has a thick black outline, and four

copy them, change their size, or process them. Use the shift key to
select multiple regions. You may select non-contiguous regions, even
if they are on different tracks. Object selection is particularly useful for
arrangement and spotting tasks, because it simplifies the process of
selecting and moving multiple regions.

region is selected in Object mode. All regions selected as objects will
have these definition tabs. Use these tabs to change the defined length
of the region by dragging them to the left or right. Remember that an
audio region is like a window into an audio file. By dragging the
region definition tabs, you are actually revealing or covering up other
waveform data in the source audio file. For this reason, you can never
make an audio region larger than it was originally at the time it was
created.
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Shortcut: Holding down the Option key while resizing a region will constrain
the size to the next region boundary. Also, you can "trim" multiple
regions at the same time by selecting a group of regions and using the
region definition tab on one region to resize all selected regions.

Fade/Crossfade Symbol: DECK II offers a variety of audio fades and
crossfades. A fade is the process of increasing a region’s volume from
zero to full (fade in) or from full to zero (fade out). A crossfade is the
process of fading out one region while you smoothly fade in the next
region. The simplest way to create a fade or crossfade is to select the
start or end of the waveform range that should be faded (or select
across the boundary between two touching regions for a crossfade),
and then choose the Process menu's Fade Selection command. For
more information, see the section on fades and crossfades in the Visual
Waveform Editing chapter (Chapter 5) of this manual.

Important: A crossfade often requires that there is audio data before the beginning
or after the end of the selected region. DECK II will warn you if there
is no data available, and will allow you to continue.

Automation Envelope: An automation envelope looks like a very
simple thick line that travels horizontally on top of an existing wave-
form or space in the waveform area. The waveform display is grayed
out, as you cannot edit automation and audio at the same time. DECK
Il offers two types of editable automation envelopes on each track: a
volume envelope and a pan envelope. All breakpoints on any enve-
lope can be edited simply by clicking and dragging on those points.
For more information, see the automation information in the Synchro-
nizing, Mixing and Mastering chapter of this manual.

Duok frack &

Shortcut: Click on an automation envelope in Object mode while holding the
control key down to bring up a dialog which allows you to enter a
precise level or pan setting

I izMEfree | Free Drive Space Indicator: This indicator shows you the amount of
unused drive space on the hard disk that contains the current Session.
Remember, you can usually free up more drive space by choosing the
Compact Session command on the File menu. Remember, however,
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that Compact Session is a destructive process. Make sure you under-
stand what it does before you use it.

Track Window Scroll Bars: The vertical scroll bar will scroll to show
you each of your tracks. The horizontal scroll bar scrolls the wave-
forms along the time axis. Command-clicking on the horizontal scroll
bar moves the waveforms a half page. You can scroll the Track
window to the current Transport counter time by Command-clicking
in the Transport's Time Counter. The Track window will also scroll to
the current time after playback if you have the Scroll after Play prefer-
ence turned on.

Track Window Key Commands: Many of the powerful editing
features in the DECK II Track window are available only from com-
mand keys. By using command keys, DECK makes it possible to
execute and modify all kinds of edits without requiring a number of
different modes. Here is a list of the key commands, and what they
do:

Key Command Audio Editing Automation Editing
Shift+Drag When dragging regions, constrain the In Object mode, constrains
region to its start time. This is very movement horizontally.
useful for editing regions and keeping
them in phase with their original
positions.

Control+Drag When dragging regions, hold down the  In Object mode, constrains
control key before you let go of the movement vertically.
mouse to slide all regions after the
current region later in time by exactly
the length of the current region (shove).
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Option+drag

Command+drag

Arrow Keys

Shift+arrow keys

Command+
arrow keys

Command+
Option+ arrow
keys

When dragging regions, hold down the
option key before you let go of the
mouse to drag a copy of the current

region and leave the original in its place.

When dragging regions, hold down the
command key before you let go of the
mouse to 'stick’ the region onto the end
of the previous region on the track
(shuffle).

In Object mode, these keys shift the
current selection in the direction of the
arrow by one region. In Range mode,
these keys shift the current selection in
the direction of the arrow by one grid
unif.

In Range mode, hold down the shift key
and press the right or left arrow button
to expand the selected range later or
carlier by one grid unit.

Physically move the selected object or
range left or right one unit, up or down
one track.

Creat a copy of the selected object or
range left or right one unit, up or down
one track.

In Object mode, these keys
shift the current selection in
the direction of the arrow by
one envemope. In Range
mode, these keys shift the
current selection in the
direction of the arrow by one
grid unit.

In Range mode, hold down
the shift key and press the
right or left arrow button to
expand the selected range
later or earlier by one grid
unit.

Physically move the selected
envelope(s) or range left or
right one unit.

@ GmmEMREEL
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Command+ Physically move the selected object or
Control+ arrow range left or right one unit, up or down

keys one track AND push all later regins on
the destination track later by yhe length
of the region or range.

+ key Nudge the selected range or region later  Nudge the selected range or
by one grid unit. (You may set the region later by one grid unit.

nudge time using the Set Nudge Time
command on the Options menu)

- key Nudge the selected range or region Nudge the selected range or
earlier by one grid unit. region earlier by one grid
unit.
Command-+click Adds new automation
envelope.
Control+ Adds new automation
Command+click envelope with same vertical
value as the previous one.
General
~ key Switch between Object and Range mode
ckey Enter current selection start and end times in Transport window begin

and end time fields and turn looping on.

s key + mouse Scrubs individual track. Cursor arrow indicates direction of scrub.
down in track

Option +skey + Scrubs all tracks. Cursor arrow indicates direction of scrub.
mouse down in

track

Shift + s key + Scrubs individual track within the range of the current selection. Cursor
mouse downin  arrow indicates direction of scrub.

track
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Shift +a key In Range Mode, extends selection to nearest region boundary to the

+click mouse click.
mouse down Automatically zooms current selection to fit window.
+z key

The Transport Window

The Transport window is the window you will use to control most
aspects of playback, including scrub-from-disk loop /rehearse mode,
automated punch in, pitch control, autolocation times and the storage
of mixer states (snapshots). The Transport does not have to be the
active (frontmost) window for the Transport buttons to function.

This is the DECK II Transport window:

Master Tape' Counter Slide Locator
<3 A

Control Value Indicator
Status Indicator

Transport Controls (

Punch Mode Button
Loop Mode Button

Begin and End Time Counters  Pitch Control ~ Autolocation Buttons Mixer State Buttons

Note: The Transport window has three possible sizes. Click on the window's
zoom box to adjust its size.

Master “Tape” Counter: The DECK II master ‘tape’ counter is a time

indicator that serves two purposes. It shows you your current position
in the Session, and it allows you to click and drag on it in order to

.
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scrub audio playback in either direction for exact location (for auto-
mated punch-in/punch-out marking, for example). When you first
start up DECK 11, the default time units are set to SMPTE frame (29.97
fps non-drop). To choose a different time unit (such as seconds, or
beats), use the Axis Units Pop-up in the Track window. If you wish to
set the Session start time to a non-zero value, see the SMPTE Start Time
command on the Options menu.

Shortcut: Command-click on the Master Tape Counter to automatically scroll the
Track window to the Master Tape time. The Track window will
automatically scroll after playback stops if you have the Scroll after
Play preference turned on (see the General preferences in the File
menu section of this manual for more information.)

Transport Buttons: The transport buttons themselves offer no sur-
prises. They function very similarly to those on an analog tape deck.
The buttons are, from right to left, return-to-zero, rewind, stop, play,
fast forward, and record. These buttons function as you would expect,
however you should note that rewind-to-zero occurs instantaneously,
and that rewind and fast forward function more like an audio CD
player — they ‘chunk-skip” ahead or back in the audio without increas-

ing or decreasing the pitch of the audio source. a
It is also important to realize that the normal function of the record

button is a ‘non-destructive’ (constructive) record. This means that the
punching in of new audio over old will not erase the original audio.
This is a safer recording method, and it allows you to go back to a
previous version if you don't like a punch-in.

Shortcut: Key equivalents for the transport buttons are selected in the General
Preferences dialog (see the Preferences command on the File menu).
Hold down the shift key and hit the space bar (default key equivalent
for play) to begin playing from the last counter position, not the
current one.

Note: For information about external control of the transport buttons, see
MIDI Map Mode, in the Chapter 4 of this manual. Also see the MIDI
Map Faders command on the Option menu, explained later in this
chapter.
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Slide Locator: The slide locator offers you an easy way to locate
quickly to any part of the current Session. Click and drag on the
horizontal slider to move around in the recording. As you drag the
slider, the tape counter is updated to show you the current time.
When you let go, you will be ready to begin playback or recording
from that point.

The slide locator is useful for general movement around the current
Session, but the autolocation buttons, explained later in this chapter,
provide a quicker and more accurate method for exact time location.

Punch Mode Button: The punch mode button toggles DECK 11 record
functions into punch mode. When DECK II is in punch mode, the
‘begin’ counter sets the punch-in point and the ‘end’ counter sets the
punch-out point. When punch mode is on, all recording will occur
only between the punch-in point and punch-out point. No other audio
will be recorded. This is very useful if you wish to replace only a small
section of a track you have already recorded. (For more information
about automated punch-in/punch-out, see Chapter 4 of this manual.)

DECK II's punch mode is constructive. This means that new
‘punched-in’ audio is automatically playlisted into its position without
erasing the old audio. Although this requires more disk space, it
allows you to return to the original version instantly, if you do not like
the results of the punch in. Remember, you can always recover any
wasted hard disk space using the Compact Session command on the
File menu.

Loop (Rehearse) Mode Button: The loop (rehearse) mode button
s toggles DECK II playback functions into loop (rehearse) mode. When

DECK Il is in loop (rehearse) mode, the ‘begin’ counter sets the loop
start point and the ‘end’ counter sets the loop end point. When loop
mode is turned on, the loop range alone (from begin to end) will play
back (or record) repeatedly . No other part of the Session’s audio will
be played. This is very useful if you wish to rehearse a section of your
recording over and over until you are satisfied. (For more information
about loop/rehearse, see Chapter 4.)

¢ ——
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Begin and End Time Counters: The begin and end time counters
indicate the times that will be used by the loop (rehearse) and punch
functions. These counters may be set in five ways: 1) You can seta
selection in the Track window, then press the "C" key on your key-
board. This method will automatically enable looping. 2) The begin
and end buttons may be clicked during playback to pick up the current
counter time. 3) The counters may be clicked and dragged left or right
to scrub their values with audio, or command dragged to scrub their
values without audio. 4) You may hold down the command key and
click on the counters to enter precise times directly. 5) You can use the
Set Punch Time From command on the Selection Tools submenu
(Options menu) to set the begin and end times automatically from the
current Track window selection.

Hint: Hold down the command key and click on the Begin or End button to
move that time up into the Transport window's main counter.

l o i Status Indicator: The status indicator is a simple text field that DECK
e IT uses to alert you to certain situations. For example, when DECK 1 is

set to slave to timecode, the status indicator will contain the phrase

“Stand by..." If you are ever unsure what is required of you at a

waiting for something, make sure to check this indicator. It will often

particular stage of DECK II production, or if DECK II seems to be a

contain an explanation of the current status.

% ~4%9 S14db % Control Value Indicator: The control value indicator is a simple text

field that always displays the value of the mixer control you are
currently moving. This value is displayed in real time as the control is
adjusted, and the value is always displayed in the applicable units or
in percent of a range of units.

e =1 Location Times: The location time buttons are counter memories that
{"===%] allow you to store up to 200 times for immediate recall and location.

Ji=ss The current counter time information can be stored as an autolocation
g}ﬁ_ time by holding down the command key and clicking on the autoloca-
52 tion arrow that should locate to that time. Clicking on that autoloca-
Tnpn tion arrow at any time will immediately locate to the stored time for
playback or recording. Option-clicking on the arrow will delete the
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store time. Use the pop-up associated with an arrow to change the
time for that arrow to another stored location. You can name a loca-
tion time by Command-clicking on this pop-up.

Hint: During playback, press the enter key on your Macintosh keyboard to
store autolocation points automatically.

Autolocation times are stored as a part of the Session file, and will
always remain with the Session in which they were created until they
are replaced or reset.

Mixer States: The mixer state buttons are automation states that allow
you to take a "snapshot" of the current mixer setting for later recall. To
_ record a mixer state, set the Mixer window level and pan controls to
i the desired state, then hold down the command key and click on one
g — of the Mixer State arrows. To recall a mixer state, simply press the
arrow key. To delete a mixer state, hold down the option key, and
click on the desired arrow. You can name a Mixer State by Command-

clicking on the pop-up associated with a mixer state button.

L5 s o
B

Mixer States are stored as a part of the Session file, and will always
remain with the Session in which they were created until they are
replaced or reset. For more information on using mixer states, see
Chapter Six.

Pitch Control Fader: The pitch control fader will be familiar to most
people who have operated a multi-track tape deck. It allows you to
adjust the audio playback speed by small amounts in order to compen-
sate for pitch and time conflicts. Essentially itis a tape speed control
knob that allows you to slow down playback speed continuously from
normal speed to a near stop (-98%).

Digital disk-based pitch control is accomplished using real-time
sample rate conversion, so some audio distortion may result from
extreme settings.

Note: You may also set the Session playback rate using the Pulldown com-
mand on the Options menu.

R e G
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The MIDI Window

The MIDI window allows you to import standard MIDI files into
DECK II. These files will play back in synch with DECK II whenever
the Session is played.

This is the DECK II MIDI Window:

File Indicator —— : - Import Button
Subscribe Button ; oS i ~— Mute All Button

MIDI Thru Track — — s — MIDI Thru Switch
MIDI Thru Port — —: = - Track Channel
Track Name — 4+— Track Mute Button

TrackPot —— - ———o g, — Track Solo Button

Syn String

B wied ™1 File Indicator: The file indicator is a simple text field which shows you
the name of the current MIDI file.

Import Button: Clicking on this button brings up a dialog box asking
you to select a MIDI file to import into the Session. You may change
the current MIDI file by pressing the import button. If you select a
new MIDI file, all current MIDI data will be erased.

Important: DECK IT only supports the importation of Standard MIDI files as
defined by the International MIDI Association specification version 1.0.

Subscribe: Click on this button to subscribe to your Standard MIDI
file. With the subscribe function on, whenever DECK 11 is switched
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from the background to the current application, it will look at the
current Standard MIDI file to see if it has been changed. If the modifi-
cation time is more recent than when you first imported the file, DECK
II will automatically re-import the file. This function allows you to
edit your MIDI file and have the changes be reflected in your Session.

Important: For the subscribe function to work properly, you must re-export your
file into Standard MIDI format using the same name.

Mute All: Activating this button mutes all MIDI tracks. This com-
mand takes precedence over solo and mute buttons on individual
MIDI tracks.

i Thiru MIDI Thru Track: The first track in the MIDI Window is the MIDI
Thru track.

MIDI Thru Port: Deck II will use the default port you selected in the
MIDI preferences as the port through which outgoing MIDI data is
sent. You can change the port by clicking on the port and selecting a
new port using the pop-up menu of available ports.

Bff § MIDI Thru Switch: Click on this button to turn the MIDI Thru trck on
and off. When the switch is on, DECK II will send any MIDI data
coming into the system out the MIDI Thru port.

Track Name: The track name is a simple text field. You may rename
Kick the track by pressing the command key and clicking on the desired

track.

Track Port Indicator: Clicking in this area will show a pop-up menu.
Depending on the MIDI operating system you are using, this pop-up
will show different items. If you are using OMS, the pop-up will
display a list of your OMS instruments. If you are using Apple’s MIDI
Manager the pop-up displays the following list of ports: modem,
printer, aux 1, aux 2. If you are using DECK II's internal MIDI setup,
this area will display the ports you chose in the MIDI Setup available
in the Options menu.

o
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Track Channel Indicator: This area indicates the channel through

m which the MIDI data is played. You may change the channel by
clicking in the channel area and dragging up or down to the desired
channel number. A dash (-) indicates that MIDI data will be played
through the channels indicated in the original file.

Track Solo and Mute buttons: These buttons function like the buttons
in the Track and Mixer windows. Click on a track’s solo button when
you want to hear that track alone. Click on it again to hear all tracks.
Note that multiple tracks may be soloed simultaneously, and that track
solo always takes precedence over track mute. Click on a track’s mute
button when you want to turn off that track’s playback. Click it again
to turn the track’s playback on.

The Library Window

The DECK II Library Window offers you an easy way to organize your
source material for quick pasting into the Track window. This is the
DECK II Library window:

et P

v Crunch Bass Riff
v Door Slam
v Weazel Broath

> FroStore Sesshng f -
M Vosee Take 2 Progtore Seeciinz psk

P tar Serape Proftore Sozzinng| -
S Water Kegbosr d ProGhore Sessinn ,
“\v  Glass mEye i ProStere Sesrione bt

7, BarneyBlod ProStere Sessions|

-\ Ur\?o_vrevkiff S ProStore Seszionz |
N Groave Riff & FroStore Sessions .2.
[\ Baokng Vew & broftore Sezziens 2

The first column shows you the names of the regions you have placed
in the Session using the Add Audio command. The second column
shows you the length of the region, and the third column shows you
the location on your hard drive of the associated audio file. You may
paste a region into the Track window using one of two methods. The
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simplest method is to click and hold on the desired region. The cursor
will change to an arrow. Move the mouse into the Track window, and
let go of the mouse button over the desired location. You can spot
audio quite accurately using this method by observing the current time
in the data indicator boxes. You may also copy and paste from this
window into the Track window.

Hint: If you are importing large quantities of material, use the Add Audio
dialog to import all of it. Then use the Library window to spot the
regions accurately, rather than pasting them directly into the Track
window.

The Library window will only show regions that vou have imported
into DECK TI. If you want to see all regions in your Session in this
window, select the Update from Session command from the Library
Operations Submenu in the Session menu. For more information on
Library Operations, see the Session menu section of this manual.

The QuickTime Window

The DECK II QuickTime window displays the currently loaded
QuickTime movie, and automatically plays the movie back from its
source drive whenever the Session is played. The QuickTime window
will also display live video with supported hardware. All QuickTime
movies are loaded using the Import Movie command on the
QuickTime menu, and only one movie may be loaded at any time. If
the original movie contains sound, you have the option of bringing
that sound into DECK TI for editing, or leaving the original sound in
the movie for playback through your Macintosh speaker. When you
have finished using DECK II to add and edit sound for your
QuickTime movie, you can create a new movie that contains a master
version of your Session audio using the Export Movie command on the
QuickTime menu.

e -
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This is the DECK II QuickTime window:

The QuickTime Window

The QuickTime window contains no special controls. Playback of the
movie is accomplished using the transport keys in the Transport
window. All other QuickTime-specific and Live Video functions are
available on DECK II's QuickTime menu.

The DECK Il Menus

The DECK II menus contain commands you will use for file mainte-
nance, destructive editing, track bouncing, mastering, synchronization

section of the Reference chapter lists and explains each of the menu

setup, waveform editing and general program configuration. This a

commands you will find in DECK II. Remember, the Reference
chapter of this manual is designed to help you find quick, general
information about DECK II controls, indicators, and commands. If you
have a specific task in mind, or if you want to learn more about a
particular DECK II function, see the Using chapters (Chapters 4, 5 and
6) of this manual.

The Apple Menu

The Apple menu is a common menu that is present in every Macin-
tosh application. It contains a list of the items you have in your Apple
Menu Items folder in your System folder. The command at the top of
the menu is generally the only command that relates to the program
that is currently running. Here is a list of the commands you will find
on the menu, and a description of each:
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The About DECK Il command

The About DECK II command opens DECK II's “about’ dialog. The
about dialog tells you what program is running, and offers a bit of
information about that program. To get rid of the about dialog, click
the mouse anywhere on the screen, or hit any key.

The Apple Menu Items List

Below the About DECK Il command you will find a list of the docu-
ments and applications you have in your Apple Menu Items folder.
These items function in DECK II just as they function in any other
application.

The File Menu

The File menu is one of the most important of the DECK II menus. It
contains all of the commands you will use to create, open, import,
load, and maintain the different files created by DECK II. Here is a list
of the commands you will find on the File menu, and a description of
each:

The New command

The New Session command creates a new empty Session from scratch.
When you choose the New Session command, this dialog appears:

I@ Sessions ¥ I o ProStore
! Eievt |

'D "

L1 ARA Sang List

03 Burstlay | Desktop
0 Dino-boy —
0 eins [(New )
O Weight

——
Name new session Cancel

[wailing wan ]

Sesslon sample rate: @ 44100 kHz
O 48000 kHz

S >—nreo
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Use the New Session dialog to select the destination folder for the
Session, and the Session type, and name the Session. A Normal
Session creates monophonic Sound Designer IT soundfiles in a folder
called "Session Audio Files" in the same folder as the Session docu-
ment. The recorded soundfiles consist of linear 16-bit samples taken at
a rate of 44.1 kHz or 48 kHz, depending on your selection when you
originally create the Session.

The Open command

The Open Session command brings this standard Mac open dialog
onto your screen:

—ﬂ Wasling Wall ¥ | “aProstore
L Liect
L1 Walling Wall audio files > =
O Wailing Wall cross-fodes . lesktop

———

|__toncer |

et ‘ Open ]

Use this dialog to select the DECK II Session you wish to open for a

playback, recording, or editing. A few moments after you click on the
Open button, the Session will appear in the DECK II windows.

The Close command

The Close Session command closes the current Session, thereby
making the DECK II windows disappear. If you wish to keep your
changes, you should always save your work before closing a Session.
However, if you forget to save before closing, DECK II will prompt
you to save or discard your changes.

The Save command

The Save Session command saves all of the changes that have been
made to the Session since the last save. This includes all audio edits,
automation, MIDI map, and QuickTime changes. If you have the
Always Save Regions when Session is Saved preference set (in the

Chapter 8: DECK Il Reference ﬁ



General preferences under the Preferences submenu on the File menu),
then saving the Session will automatically save all region definitions to
their associated sound files.

The Save a Copy as command

The Save a Copy as command allows you to create and save a copy of
the currently open Session under a new name. This procedure will
only copy the Session document, and not the associated audio file and
cross-fade folders. When you choose the Save a Copy command, the
standard Mac save dialog appears.

Use the save dialog to choose a destination for your new Session, and
name the Session. The new Session will be an exact copy of the current
Session, and will play back the same audio track files from disk. When
you are done executing the command, you will be returned to the
original Session. Use the Open command to open the new copy.

Important: Remember, when two Session files share the same audio files, any
destructive audio edits (Normalize, invert, etc.) will always appear in
BOTH. For this reason, it is often wise to execute destructive edits on a
copy using the Make a Copy button in the Destructive Effects dialog.

The Revert command

The Revert command disregards all changes made to the current
Session and opens the last-saved version of the Session. Use this
command when you make an unwanted or accidental change to your
Session, and you want to go back to the previous version.

The Add Audio to Clipboard command

This is one of the most important commands in DECK I1. It allows you
to select any soundfile or set of soundfiles on any mounted hard disk,
and add those soundfiles to the Clipboard and the Regions window for
Pasting onto any track in the Track window. When you choose the
Add Audio to Clipboard command, this dialog appears:

e .

DECK Il



I e

(= Samples ¥ I = ProStore  Regions in

D Harma

D HarmonicPhrase
D HeineGate
DHIOQ2

0 HIBLOCK!1

O hornHité

D liyAimb

Show:[ZSD I (ISD 11 X AIFF Show: [<) Regions Loops

Sample Rate: 44100 Qpess Region Length: 1.61sec
Channels: 1
Bit Depth: 16

Comments:

*Fe HarmonicPhrase
*Re= all

Desklop

Cancel

ol

Current Playlist
HarmonicPhrase

i
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format. Thes will use extra disk

space, and may take 3 moment .

Use the file selector box to find the soundfile you want. When you
select a soundfile, you will see the pertinent information about it,
including the sample rate, number of channels and bit depth. DECK I
supports mono and stereo 8- and 16-bit Sound Designer, Sound
Designer II, and AIFF soundfiles. If you select a soundfile that is not
supported, you will see a message stating "This soundfile cannot be
converted" in the comments area. DECK II does not yet allow you to
add soundfiles with sample rates other than 11, 22, 44.1 or 48 kHz.

Important: QuickTime movies that contain audio at most sample rates can be
imported using the Import Movie command on the QuickTime menu
(although the best results will be achieved when the QuickTime audio
is at 22050 Hz or 11025 Hz). This command makes it possible to being
QuickTime movie audio directly into the DECK II Track window:.

Once you select a soundfile in the left-hand selector list, you will see a
list of the audio regions and loops that are in that soundfile. An audio
region marked with a *Fe represents the entire soundfile. Regions
marked with *Re are simple audio regions, and those marked with
®Le are loops (AIFF files only). You can audition any file, region or
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loop by selecting it and clicking on the dialog’s Play button. To add a
region, just select it and click on the dialog's Add Region button. This
will add the selected region to the Current Playlist in the lower right
hand corner of the dialog.

Note: At any time you can remove items from the current playlist by select-
ing them and clicking on the Remove button.

Once you have selected the files, regions and loops you wish to add,
click on the Done button. This will add all of the items in the current
playlist to the Macintosh Clipboard for pasting into DECK II's Track
window. Remember, all files, regions or loops which are not mono or
do not match the current Session’s sample rate and bit depth will be
converted to match. This may take some time and disk space, because
DECK 1I is making copies of this data.

After a moment you will be returned to the DECK II Track window.
To place the newly added sounds, click anywhere in the Track
window waveform area and choose one of the Paste commands. The
regions will be pasted into the track window at that point.

Important: If you are adding stereo or more-channel regions, make sure that your
insertion point or selection range covers two or more channels. Then
when you paste, all regions that contained more than one channel will
be pasted into the Track window with all of their channels in phase.

Note: ; When DECK II adds audio to the Clipboard, it is just adding tiny
pieces of information that point to large files on the hard disk(s). For
this reason, adding audio via the Clipboard will not take very long,
and requires very little memory.

Hint: If plan to add audio to your Session from many sound files, use the
Add Audio command to add all of them at once. When you return to
the Session, use the library window to select audio to paste into the
track window.

The Add SND to Clipboard command
This command allows you to select any sound resource on any

mounted hard disk, and add that sound resource to the Clipboard for
Pasting onto any track in the Track window. When you choose the

- e
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Add an snd command, the standard file dialog appears. Once you
have located the sound resource you wish to add, click on the Open
button. This will add the sound resource to the Macintosh Clipboard
for pasting into DECK II's Track window. Sound resources will be
converted to match the current Session's sample rate and bit depth.
This may take some time and disk space, because DECK II is making
copies of this data.

After a moment you will be returned to the DECK I Track window.
To place the newly added sound resource, click anywhere in the Track
window waveform area and choose one of the Paste commands. The
region will be pasted into the Track window at that point.

The Add SDII Playlist to Clipboard command

This command allows those with Digidesign hardware to edit playlists
using Sound Designer II software and easily import their work into a
DECK II Session. When you choose the Add SDII Playlist to Clipboard
command, a standard file dialog appears. Find the playlist and choose
open. Pasting a Sound Designer playlist into the Track window is
done in the same manner as pasting any other audio.

The Load Audio File command a
This command remains in DECK I from original DECK, and is here

out of convenience for original DECK owners. Generally, you will be
much better served by adding audio directly to the Track window
using the Add Audio to Clipboard command. For those wishing to
use the Load Audio File command as a shortcut: it allows you to load
an existing audio soundfile directly onto DECK II track 1, 2, 3, or 4.
The Load Audio File command brings up this dialog:

=) Samples ¥ | o ProStore
0 boass?... [ tiect
2 DoublePop B l‘ j

O DoublePoptiower) 4 ( Desktop

0 DouniePop(MoreLow!
O ExThumbiiow)

- (Concer ]
0 Harm3 .
D Horma 3 Open
toodon track: [ 1 v
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Only monophonic Sound Designer II soundfiles may be loaded using
the Load Audio File command. For other file formats, see the File
menu’s Add Audio to Clipboard command.

Note: The Load Audio File command can be very helpful for users of original
DECK 1.0x. This command allows you to load tracks from your DECK
1.0x Sessions directly onto tracks in DECK IL. You may also import an
entire DECK 1.0x Session into a new DECK I session using the Import
Session command on the Session Menu.

The Compact Audio File command
The compact audio file command is a tool you can use to get rid of

unused audio data in a soundfile. When you choose this command,
you get this file selector dialog:

ﬁ-lil Pants Session audio ... ¥ = ProStore

D Mix File 296124 =i N ——
0 Min File 296124 right E
| D track 2 Wavestation 1 Desktop ]

Jl

——

Hendle length: ! 2.000 seconds

This is how an audio file is compacted: DECK II looks at the list of
audio regions and loops in that audio file. It then looks through the
audio data in the file, and finds all audio data that is not used in any
region. After the unused audio has been found, it is permanently
deleted from the drive, and all region definitions are updated. The
Handle Size setting allows you to keep a little bit of extra audio data
before every region start and after every region end, which will be
useful in the future if you plan to crossfade the regions. You will
probably want to set your handle size to at least 2 seconds for this
purpose.

The product of the compaction process is generally an increase in the
available hard disk space. To compact an audio file, just select that file,
enter a handle size and click on the Compact button. If you wish to

-
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compact all of the audio files associated with the current Session, use
the Compact Session command on the Session menu.

Note: If you use the entire soundfile in any Session, you will find that there is
no unused audio data to delete. In such a case, Compact Audio File
may not increase your available disk space.

Important: The Always Save Regions when Session is Saved and Rewrite
Regions preferences in the DECK II General Preferences have strong
effects on the compaction process. Make sure to read about those
preferences before you compact audio files or Sessions.

The Import MIDI File command
The Import MIDI File command allows you to import MIDI files into
your Session without opening the MIDI window. When vou choose
this command, a standard file selection dialog appears. After you
choose a file to import, DECK II will open the MIDI Window in your
Session. For more information on DECK II's MIDI functions, see the
MIDI Window section.

Note: DECK II's MIDI Preferences are preset to split channels when import-
off.
The Dispose MIDI File command

Choose this command to delete the current MIDI file from your
session. If you do not have a MIDI file in your session, this command
will be gray.

The Page Setup command

This command remains gray in DECK II. It will be used for controlling
the printing of DECK II Track Sheets.

The Print command

This command remains gray in DECK II. It will be used for controlling
the printing of DECK II Track Sheets.
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The Preferences Submenu

DECK II's Preferences submenu offers access to five basic user-
configurable preference dialogs, and one default setup command:

General...

Memory & Storage...
Levels...

Slave Settings...

MIDI...

Save Settings As Template

Use these preferences to configure DECK II to your individual work-
ing style. These preferences are explained over the next few pages.

The General Preferences

When you select the General preferences, this dialog appears:

T GeneTel S ]

Autostop at end of Session

[ Always save regions whon Session is saved
(] Rewrite region list

[X) $top audio playback if the drive is too slow

[JChange region start times with BPM change

[<] Loop audition

& Scroll after play

Update speed during playback (1-10): 25 l

SMPTE Preroll Time: !2,000 ISeconds
Sound Edilor signature: Sd2a [Set |

Transport key equivalents
RT1Z | Rewind | Stop | Play | Ff
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Use this dialog to set the following characteristics for DECK II:

Autostop at end of Session: This preference lets you select whether
DECK II should automatically stop playback when the end of the
current Session’s longest track is reached. Playback stops when the
last sample of the last region is played.

Always save regions when Session is saved: This preference should
generally be turned on. It makes sure that all audio regions you have
created or edited are saved at the same time the Session is saved. If
you turn this preference off, the audio regions you create will be local
to the Session only, and will not be available for use within other
programs such as Pro Tools or Sound Designer I until you select the
File menu's Export Session Regions command.

Rewrite regions list: This preference allows you to select exactly what
happens when regions are saved out to their source soundfiles. When
you have this preference turned off, current Session regions are added
to their source soundfile. Regions with the same name replace their
older versions, but no existing soundfile regions are deleted. This means
that deleting a region from the current Session will not delete it from
its source soundfile, thereby retaining all of the regions you have ever
created. When you have this preference turned on, current Session

existing soundfile regions are deleted and replaced by the current regions.

regions replace all regions in their source soundfile. In this case, all a

This means that the current Session's regions are the only regions that
will remain in the source soundfiles. Use this option with care. If all of
the soundfiles in the current Session are used only by that Session, this
command will keep those soundfiles in perfect sync with the Session.
This will make the sure that the Compact Session command will yield
the best results by making sure that no extraneous regions remain in
the source soundfiles.

Stop audio playback if the drive is too slow: This preference allows
you to set how carefully DECK II checks to see if your drive is too
slow. If you attempt to play four tracks from a very slow drive, DECK
may not be able to play them without a small 'hack' or 'skip' in play-
back. Often this skip is so subtle, you will not be able to hear it. When
this preference is turned on, DECK II will put up a warning dialog and
immediately stop playback any time disk performance might cause a
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playback skip. When this preference is turned off, DECK II will
continue to play back, even if a slight skip is possible.

Hint: If you are mixing live directly to DAT or a mastering medium, then
turn this on. It guarantees that audio playback will be supervised and
stopped before any skip might occur. If you are simply editing sound
and you plan to mix to disk, then leave this preference turned off.
Almost all skips will not be audible, and even if vou do hear one, it
will not appear in the master file that results from a mix-to-disk.

Change audio times when changing tempos: This preference applies
only to edits made in the track window when you are in Beat mode.
When this preference is turned on, any change to the tempo in the
track window will move all audio regions to adjust their start times to
the new bar/beat boundaries. This is useful if you are using DECK II
as a 'virtual drum machine,” with individual sounds that should shift
with a tempo change. When this preference is turned off, any change
to the tempo in the track window will not move any audio regions. In
this mode, no tempo change will ever change the placement of an
audio entity. This is useful if you are using DECK II to arrange
segments of audio that have their own internal rhythms, or if you are
doing synchronization work, and want to make sure that audio times
always remain unchanged.

Loop audition: When this preference is on, the Audition Selection
command on the Process menu will automatically loop any selected
range during playback. When the preference is off, Audition Selection
will only play back the selection a single time.

Scroll After Play: When this preference is turned on, DECK II will
automatically scroll the Track window to the point at which playback
stopped. You can use this function to easily find the waveforms you
just played.

Update speed during playback: This preference allows you to set
how much time is available for other programs to update in the
background behind DECK I audio playback. A setting of '1' allows
the background program to update as often as possible. This setting
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makes it easier to see screen activity in background programs. A
setting of '10" prevents background programs from updating during
playback, allowing DECK II to monopolize your display. This setting
does not affect the performance of the background program at all. It
only affects screen drawing. A setting of '5' is suggested. If you are
running METRO in the background, you may want to set this to '1' to
make it easier to see what's happening in the sequencer's windows
during DECK playback.

SMPTE Preroll time: This setting applies only if you are recording or
playing audio while on-line and synchronized to SMPTE timecode. In
such cases, the preroll time is the time you allot to DECK II to lock-up
and begin playback. The number of seconds you choose is the time
between the first received SMPTE frame value and the start of DECK I
playback. The default setting is 5 seconds. If you have a fast Macin-
tosh and fast hard disks, you can set this to a lower number (2 seconds,
for example) for faster lock-up times. If you have a slow Mac, slow
drives, or problems locking up to SMPTE, try setting this value to 6 or
8 seconds. (In almost all configurations, 5 seconds will suffice.)

Sound editor signature: This preference applies only to the Launch

wish o use a dedicated two-track destructive editor to further edit

Editor command on the Process menu. It is designed for users who a

their DECK II audio regions (Sound Designer II or Alchemy, for
example). This is the Macintosh signature of the program you wish to
launch as your waveform editor. To choose the program you wish to
use as your an external edilor, click on the Set button, and use the
resulting Open dialog to select the program you desire. When you
click on the open button, the editors signature will appear. From that
point on, when you select a waveform region in the Track window and
choose the Launch Editor command on the Process menu, vou will be
launched into your audio editor, and the correct soundfile will appear
with the applicable range selected.

Transport key equivalents: These boxes indicate the Macintosh
keyboard keys that will operate your DECK II tape transports. Any
keys that type a visible character can be used as a tape transport key.
(Keys such as return and clear cannot be used.) Once you set these
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equivalents, the DECK II tape transports buttons can be controlled
directly from the Mac keyboard. To set a key equivalent, click on the
applicable Set button. Then press the key you desire for that function.

Note: Only one function may be used per key. During the setting process, if
you attempt to type a key that is already assigned to another function
(or if you click on a key that is not valid), you will hear a warning
beep. You must click on a valid key before you will be allowed to
continue.

The Memory & Storage Preferences

When you select the Memory & Storage preferences, the following
dialog appears:

SIS Memory & Storage sormase
Pre-allocate entire record drive:

O Never

@ RAlways

O when recarding 2 or more tracks

Disk buffer size: |_192 Ikbyles

Mau. play tracks: |4

Rutomation butfer: [3072 events
MIDI butfer: [20000 |events

Con) Qa;m

Use this dialog to set the following characteristics for DECK II:

Pre-allocate entire record drive: This preference controls disk pre-
allocation, depending on how many tracks are being recorded. By
preallocating, or pre-reserving hard disk space before recording, you
speed up the recording process by decreasing the amount of time your
Mac uses to seek for unused disk space. Disk space that is preallocated
is known to your Mac, and therefore it does not need to be found.

Note that, although pre-allocation does improve performance, it will
slightly increase the delay before recording begins. To turn off pre-
allocation, just choose the Never option.
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Pre-allocation is generally only needed when you record 3 or 4 tracks
simultaneously (depending on your Mac and drive). An old Mac II
(68020) with a slow drive will probably best be served by a setting of
Always, in which case remaining drive space is all pre-allocated
whenever you are recording. If you are experiencing "Disk too slow"
messages during recording on a fast Mac/hard disk combination, try
setting this preference to "When recording 2 or more tracks.” This will
only pre-allocate the drive only when you are asking your Macintosh
to work hard.

Disk buffer size: DECK II accomplishes its recording and playback
tasks by swapping hard disk audio data through RAM and out to your
audio outputs. The chunks of audio data that are placed in RAM
reside in disk buffer. When you have a small disk buffer (128K or
less), DECK can load and manipulate these buffers quite quickly, so
program response may seem smoother, but more pressure is put on
the performance of the hard disk. When you have a large disk buffer
(512K or more), it may take DECK longer to load the buffers from disk,
but those 'loadings’ can occur less often, so less performance is re-
quired from the drive. If you have a fast Mac and a fast drive, leave
this setting at 192K. This should allow generally smooth operation. If
you have a slower Mac, or especially a slower drive (an erasable
optical drive, for example), increase these buffers until your playback
performance increases. It is not surprising, with extremely slow
drives, to use a disk buffer setting of 1024K.

Important: As explained, your disk buffer is stored in RAM. If you increase the
size of your disk buffer, you should also increase the amount of RAM
you allocate to DECK II. This is accomplished by selecting the DECK
ITicon in the Finder, and choosing the Get Info command on the File
menu. Use the resulting window to increase the preferred RAM
allocation by at least four times as much as the increase you entered in
the disk buffer size. (Remember, there are four disk buffers — one for
each play track.)

Max. play tracks: Use this seting to select the default number of
playback tracks for DECK II Sessions. You can decrease this number
if you wish to use fewer playback tracks (to save RAM by decreasing
the number of allocated buffers, for example), but you cannot increase
the number of tracks above your system's limitations.
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Automation buffer: This setting is the number of automation events
allocated to your Session. The default setting is 3225, and this is not
very much. If you are using basic automation envelopes for simple
level and pan changes, this setting should suffice. If you are creating
complex automation envelopes, or using large amounts of real-time
fader automation recording, then you may wish to increase this
allocated amount. Remember, if you increase it by a large amount,
you should also increase the amount of memory allocated to DECK II
(as explained in the previous paragraph).

MIDI buffer: This setting is the number of MIDI events allocated to
your Session. The default setting is 5120, and this should suffice for
small files. If you have long MIDI files, or have many tracks, then you
may wish to increase this allocated amount. Remember, if you in-
crease it by a large amount, you should also increase the amount of
memory allocated to DECK IL

The Levels Preferences

When you select the Levels preferences, the following dialog appears:

Lepels i@ =
Audition Uolume:|-9.01 |aB|724 |- 1023)
Audition Outputs: @ 162 O 354

Clip Light Treshold:[0.00 | dB

(< Only compact files that will free disk space
[J 0Only compact files that free (15 |percent

(] Only compact files that free |0.000 |MB

o

Use this dialog to set the following characteristics for DECK II:

-
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Audition Volume: Use this setting to change the level of audition
volume. You may choose either a dB value, or a number between 0
and 1023.

Audition Outputs: Use this setting to switch the audition outputs
between pan pairs 1&2 or 3&4. You may change this setting only if
you are using the Sound Tools II or ProTools hardware.

Clip Light Threshhold: The clip light turns on if the incoming signal
is above the Clip Light Threshhold. The default setting is 0.00dB; use
this setting to lower it. Remember, audio recorded with the clip light
on may be distorted.

Only compact files that will free disk space: This preference and
those associated with it control how much disk space the Compact File
and Compact Session commands will free up for you. The Compact
command writes each region into a new file and eliminates any data
that is not used in the original file. However, if you have many
regions that overlap in a file, the compaction process will not save you
any disk space; it may even take up more. We recommend that you
leave this setting turned on.

Only compact files that will free __ percent: Like the above prefer-
ence, this preference further constrains the compact command. Simply
choose a percentage and the compact command will not work below
that amount.

Only compact files that will free  MB: Like the above preference,
this preference constrains the compact command. Simply choose a
number and the compact command will not work unless it frees that
much disk space.

The Slave Settings Preferences

When you select the Slave Settings preferences, this dialog appears:

_ SewrSctteqs o

Carrent Slowe: METAN™ 2.4

[ ®uen Slave Bocements
C2 0wit Slane mnon Suntting
[ Save Slove's Document wihen Saving

P
D &=
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Use this dialog to set the following characteristics for DECK II:

Current slave: This indicator shows the name of the program that is
running as a time-linked slave to DECK II on your Macintosh. This
will generally be a sequencer, such as OSC's METRO, but it can be any
background-compatible program that understands DECK II's timing
architecture. If you have a program that is incompatible with this
slaving architecture, contact OSC and the program's manufacturer.
OSC supplies the technology necessary for this architecture free of
charge to any interested party.

Hint: You do not need to set this slave setting. The slave software automati-
cally makes itself known to DECK 1T via AppleEvents. All you have to
do is start up the slave program one time with DECK II running in the
background. If the program is slave-compatible, its name will then
appear in this indicator.

Open slave documents: This check box lets you choose whether
DECK 1I should always start up the slave application and open the
associated document whenever a DECK Session is opened. When you
are running METRO with DECK II, for example, DECK II keeps track
of what MIDI file is open in METRO and associates that MIDI file with
the current DECK Session file. When you have 'Open slave docu-
ments' checked in this dialog, opening a DECK II Session will auto-
matically open the associated MIDI file in METRO in the background.
This gives you an easy way to keep all of your associated files linked
together, and makes it possible to open DECK I, the DECK 1I Session,
METRO, and the associated METRO MIDI file simply by double-
clicking on the DECK II Session document.

Hint: Both DECK II and METRO offer the ability to open the other applica-
tion and its associated document. Turn on this function in one pro-
gram OR the other, not in both. Choose which program is the one you
generally use first in the composition or tracking process, and config-
ure that program to open documents in the other application.

Quit slave when quitting: This check box lets you set DECK II to
force the slave application to quit when you quick DECK IL. Thisis a
simple time-saving function, and is particularly useful if you are using
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the slave in a 'transparent’ way, and you don't want to be reminded
that the slave is even running.

Save slave's document when saving: This check box allows you to
choose whether DECK II should automatically save the slave
program's document any time the current DECK II Session is saved.
This preference is useful, because it helps make sure that DECK
Session versions always stay in sync with slave application documents
(METRO MIDI files, for example).

The MIDI Preferences

When you select the MIDI preferences, this dialog appears:

Split channels on incoming MIDI files
Default output port: | Wavestati... v |

Timecode output port: | ADAT Input w |

)

Use this dialog to set the following characteristics for DECK II: a

Split channels on incoming MIDI files: When this preference is on,
DECK II will split the channels when you import a MIDI file. This is
useful when you are importing Type 0 MIDI files, which store all track

data in one channel.

Default Output Port: This pop-up lists your MIDI ports and uses the
first one on the list as the default output port. To change the port,
simply select a different port using the pop-up menu.

Timecode Output Port: This pop-up controls through which port

outgoing MIDI Timecode is sent. To change the port, simply select a
different port using the pop-up menu.
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The Save Settings as Template Preference

When you choose this command, DECK II will take a "snapshot" of the
current location of all open windows. Whenever you create a new
Session, DECK 1I will automatically open only those windows, and
they will be in the same location.

The Quit command

The Quit command closes the current Session, and quits DECK IL. If
choose the Quit command, but you have not saved your changes, then
DECK II will ask you if you want to save them. If you click on the
Don’t Save button, all of the changes that you have made since your last
save will be discarded.

The Edit Menu

The Edit menu is an important part of most applications, and it is
really central to DECK II Track window functions. In some ways you
can think of the DECK II Track window as a word processor for sound
~ it allows you to organize and place sound into a finished structure
for presenting that sound. Most of your edits consist of placing
components (soundfile regions), copying and /or pasting those compo-
nents. The Edit menu contains all of the command you will use to
make these kind of manipulations. Here is a list of the different Edit
menu commands, and a short explanation of each:

The Undo command

Undo allows you to reverse the effect of the last edit operation per-
formed. Undo is extremely useful if you perform an edit operation
and don't like the result. To reverse the edit, choose Undo and DECK
IT will revert to the state prior to performing the edit operation. You
can also 'undo an undo,’ thereby returning to the edited form.

Undo only reverses the most recently performed action. This is
because most edit operations, such as cut or copy, are placed in the
Edit buffer until the next operation is performed. Undo retrieves only
the most recent edit operation from the Edit buffer.

R
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Some operations cannot be undone. In such cases the Undo command
will be grayed and unavailable. DECK II will always warn you if you
are executing a process that cannot be undone (certain destructive
effects, for example). Be sure to consider carefully before performing
‘non-undoable’ operations. You may also want to save your file before
executing dangerous edits. This will allow you to use the Revert
command (File menu) to revert to the most recently saved state of the
file.

The Cut command

Cut removes selected data from its original location and places it on
the Macintosh Clipboard for Pasting (or for deletion). Using another
edit operation, such as Paste At or Paste After, retrieves this data from
the Clipboard. If you perform an edit operation that does not retrieve
this data, such as another Cut, the Clipboard data will be deleted and
lost. The result of only one edit operation at a time may be contained
on the Clipboard.

Cut removes data; it does not affect time. When you cut waveform
data, a space is left where the data was located. If you want to cut out

earlier, use the Remove command.

waveform data and ‘close the hole' by sliding later waveform data a

The Copy command

Copy makes a duplicate of selected data and places that duplicate data
on the Clipboard. Using another edit operation, such as Paste After,
retrieves this data from the Clipboard and places it at the destination
location (selected range or insertion point). The originally selected
data is unaltered.

Important: Cut and copy do not really place the actual waveform data onto the
Mac Clipboard. That amount of data would generally not fit on the
Clipboard, and would require a very long time to be processed. In
fact, DECK II only places 'pointers’ on the Clipboard, and those
pointers point at the source audio data on the drive. For this reason,
you can execute audio edits very quickly, regardless of the size of the
edit, or the amount of memory your Mac contains.
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The Clear command

The Clear command removes the selected data without placing it on
the Macintosh Clipboard. This command makes it possible to copy a
waveform region, clear a different region, and then Paste the originally
copied region. (If you had used Cut to clear the waveform data, the
originally copied range would have been lost.)

Hint: The Delete key on your Macintosh keyboard performs the same
function as the Clear command.

The Paste At command

The Paste At command takes the contents of the Clipboard and places
then at the insertion point or selected range. If a waveform range or
region is selected, the Paste At command will replace that selection
with the Clipboard contents. If the Clipboard contents are longer than
the selected destination range or region, then the entire Clipboard will
be pasted, potentially covering up audio regions after the paste point.
If you want to constrain the paste not to exceed the size of the selected
range or region, see the Replace command on the Edit menu.

Important: If you are copying regions from more than one track, than you will
need to select more than one destination track for any Paste command.
Selection a single destination track will paste only the first copied
track.

The Paste After command

The Paste After command takes the contents of the Clipboard and
places then after the insertion point or selected range. If a waveform
range or region is selected, the Paste After command will put the entire
Clipboard contents after that range or region. Use Paste After to
perform copy-and-duplicate edits, by copying the waveform range or
region, and executing multiple Paste After commands.

Hint: You can use the Multiple Paste After command to automate this
process.

2 ——————————————
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Hint: Remember that you can perform many important arrangement edits
using drag features or the arrow keys in tandem with the command,
option and control keys. Experimentation with these key combina-
tions will help you develop more efficient editing methods. See the
Track window section at the beginning of this chapter for more infor-
mation.

The Multiple Paste After command

The Multiple Paste After command allows you to pastes the contents
of the Clipboard multiple times after a given point. This command
brings up a following dialog which asks you to choose the number of
copies of the current data you wish to paste. DECK II will paste them
after the last insertion point.

The Replace command

The Replace command takes the contents of the Clipboard and re-

places the currently selected range or region with those contents. If the

Clipboard contents are longer than the selected destination range or

region, then only that portion of the Clipboard that fits into the se-

lected range will be pasted. If the Clipboard contents are shorter than

the selected destination range or region, then the Clipboard contents a
will replace the entire selected range or region, potentially creating an

area of silence at the end of the destination range or region.

The Slice command

The Slice command performs an in-place separation of the selected
waveform Range, thereby making a region of that range. Slice is only
available in Range mode. To slice a waveform range, simply select
that range and choose the Slice command. This will create a stand-
alone waveform region which you can use for arrangement purposes.
Remember, DECK II offers an even faster way to slice a region for
arrangement purposes. You can always just select the waveform range
you desire, then just click and hold the mouse on the selected range,
and drag that range (or option-drag a copy) to the new destination.
This tear-off solution is often much faster than the Slice command
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when you are doing basic arrangement, however the Slice command is
very useful if you wish to define a new region without moving that
region.

Hint: You can also use the slice command when only an insertion point is
present. This allows you to create a boundary, thereby generating two
regions (the region before the boundary and the region after the
boundary).

The Insert At command

The Insert At command performs the same basic functions as the Paste
At command, except it pushes all of the waveform data after the
insertion point later by the length of the Clipboard contents. The
Insert At command never replaces waveform data. If a waveform
range or region is selected, the Insert At command will simply insert
beginning at the range or region's start point and push all subsequent
regions later in time. The selected range or region will not be deleted.

Important: If you are copying regions from more than one track, than you will
need to select more than one destination track for any Insert command.
Selection a single destination track will insert only the first copied
track.

The Insert After command

The Insert After command performs the same basic functions as the
Paste After command, except it pushes all of the waveform data after
the insertion point later by the length of the Clipboard contents. Like
the Insert At command, the Insert After command never replaces
waveform data. If a waveform range or region is selected, the Insert
After command will simply insert beginning at the range or region'’s
end point and push all subsequent regions later in time. The selected
range or region will not be deleted.

Hint: Remember that you can perform many important arrangement edits

using drag features or the arrow keys in tandem with the command,
option and control keys. (The control key performs Insert functions).

—
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Experimentation with these key combinations will help you develop
more efficient editing methods. See the Track window section at the
beginning of this chapter for more information.

The Insert Time command

This command brings up this dialog box:

Bar  Beat Tick
stort Time [o H:] 1 |

Bar  Beat TJick

tnamme [15 [ |[1 ]

This dialog lets you insert empty time on any track or tracks. To insert
time, select the waveform region or range after which you wish to
create empty space, then choose the Insert Time command. If you
want to insert time on multiple tracks, select regions or ranges on
multiple tracks. When the dialog appears, the start time will default to
the time immediately after the end of the selected range of region. You
can then type in a desired end time, or edit the start and end times to a
your liking. When you are ready, click OK. Empty space will be
inserted as you specified on the tracks that were selected when you
chose the Insert Time command. No waveform data is ever deleted —
empty time is simply inserted. If you enter a start time that is in the
middle of existing regions, those regions will be split into new regions
to make room for the empty time.

The Remove command

The Remove command functions in a fashion similar to the Clear
command, except Remove deletes the actual time associated with the
selected region or range, causing all later regions on the selected
track(s) to slide earlier in time. Use the remove command to prevent
the creation of empty time on a track (or tracks) and close the gap
created by a deletion automatically.
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The Select All command

This command selects all of the waveform data in the current track or
tracks. If you are in Range mode, the data is selected as a range. If you
are in Object mode, the regions are selected as objects. When you want
to select all on a single track, click put an insertion point on that track,
or select a range or region on the track, then choose the Select All
command. When you want to select all on more than one track, click
put an insertion point on those tracks, or select a range or regions on
those track, then choose the Select All command. To un-select the
current selection, choose the Deselect command on the Edit menu.

The Deselect command

This command automatically un-selects all ranges or regions, leaving
you with no selection or insertion point in the Track window.

The Rename command

This command allows you to rename the current soundfile region or
selected track. To rename a soundfile region, just select that region in
the Track window and choose the Rename command. Use the ensuing
dialog to enter the new name, then click on OK. To rename a track
playlist, just select that play track or work track by clicking in the track
name area at the left-hand side of the Track window. Then choose the
Rename command. Use the ensuing dialog to enter the new playlist
name, then click on OK.

Hint: You can rename track playlists, mixer states, and location times in the
mixer window and transport window by holding down the option key
and clicking on the specific playlist, mixer state, or location time pop-
up. This allows you to rename the item currently displayed on that
pop-up-

The Process Menu

The Process menu contains all of the DECK II commands you will use
to create new tracks and process audio constructively or destructively.
It gives you access to fades and crossfades, normalization and other
effects, and lets you control the track bouncing and mixing functions.

O
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Here is a list of the commands you will find on the Process menu, and
a description of each:

The New Track command

This command creates any number of empty tracks in the Track
window. The New Track command brings up a dialog in which you
enter the number of new tracks you need. You may always add more.
If there are already four or more audio tracks in the Track window,
this command creates a new empty work track(s). Use this command
to create a destination track for recording, or for pasting in audio data
from the Clipboard.

Hint: If you have added audio regions to the Clipboard using the Add
Audio to Clipboard command on the File menu, you can auto-create
new tracks in the Track window simply by choosing the Paste At or
Paste After command with no insertion point or selected range.

The Bounce All to Mono Clipboard command
This is a very important command for DECK II Track window users.

more tracks to disk, in order to combine them for playback on a single

The Bounce to Mono Clipboard command allows you to remix one or a

track. The command automatically bounces the currently selected
range to the Clipboard, including all automation events and cross-
fades. Bounce to Mono Clipboard always mixes all four play tracks,
so if you want to remove certain tracks from the mix, use the mute
button to mute those tracks. When you choose Bounce to Mono
Clipboard, all pan information on the play tracks is ignored, and a
mono soundfile is the result. To place the newly mixed Sound De-
signer Il mono file on a track, select the destination (with an insertion
point or range) and choose any Paste or Insert command.

Bounce to Mono Clipboard and Bounce to Stereo Clipboard are key
functions for hard disk recording. They allow you to create submixed
tracks without deleting the original source tracks. By doing this, you
can build up a complex mix without throwing away your source, and
you can always go back and remix any submix.
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Hint: Once you have bounced multiple tracks to mono or stereo and pasted
in the resulting files, move the original source tracks to DECK I work
tracks, and create new empty tracks. Use these new empty tracks to
record or arrange more audio. By following this process, you can
create mixes that are hundreds of tracks deep without any analog
signal degradation. Remember, you may also mix Work tracks when
the Virtual Mix command is enabled.

Hint: If you are bouncing only portion of the current Session to the clip-
board, select the empty destination track(s) to specify the range to be
bounced. DECK II always bounces the four playback tracks, so by
using this method, you return to the Track window after the bounce
with the correct, phase accurate range selected. Then just choose the
Paste At command to paste the bounce file in-phase with its source
tracks. Note that this also works if you select a destination range on a
DECK I work track.

The Bounce All to Stereo Clipboard command

The Bounce to Stereo Clipboard command functions in the same
fashion as the Bounce to Mono Clipboard command, except it creates a
stereo mix file and places it on the Clipboard. This mix file reflects the
currently selected range, including all automation events and cross-
fades. Bounce to Stereo Clipboard always mixes all four play tracks,
so if you want to remove certain tracks from the mix, use the mute
button to mute those tracks. When you choose Bounce to Stereo
Clipboard, all pan and volume information on the play tracks is used,
and two mono soundfiles are the result. To place the newly mixed
Sound Designer Il mono files on tracks, select the destination tracks
(you must set an insertion point or range across two tracks) and
choose any Paste or Insert command. For some applicable hints, see
the previous explanation of Bounce to Mono Clipboard.

Hint: Bouncing to the Clipboard is very useful for creating submixes internal
to your DECK II Session. You will always bounce tracks when you are
attempting to collapse multiple tracks to make room for new tracks
(for overdubbing purposes). If you are done with your DECK II
Session, and you want to create a master mix file on your hard disk,
see the Mix to Disk command on the Process menu.

e ———— L

DECK I



The Mix to Disk command

The Mix to Disk process creates a final mono or stereo Sound Designer
I, ATFF or Sound Resource soundfile that exactly reflects the way the
Session sounds when it plays back (there is one exception to this rule--
see the Virtual Mix command below.) All level and pan settings, and
automated changes are made as the file is mastered. Choosing the Mix
to Disk command brings up this dialog:

I@ sEssions v | o ProStore

I BurstDay @
3 Dino-boy : 5
O eins
O waltling Wall

£ Weight [(New (]
O Yeninko — L

Mix to file | Cancel )
[Mu-sick Concrete Mis | [ Sove )

Format: [ Sound Designer |1 +
Sample Rate: | Full Session v

Bit Depth: [ 16 v!
Number of Channels: Stereo vl q

To execute the mix, choose the type of file you desire. You can choose
between Sound Designer II, Audio Interchange File Format (AIFF), or
Sound Resource. These three file types cover a broad range of compat-
ibility. You should try to maintain the highest sample rate and bit
depth, and the stereo image for best results. If you are mixing for
multimedia, you may need to mix your file in 8-bit format at a lower
sample rate (half session = 22 kHz and quarter session = 11 kHz for
44.1 kHz Sessions). Before mixing your file to disk, make sure to check
which format is required for playback.

Hint: Generally, if you are creating an audio master file for CD pressing or
sync-to-picture, you should select Sound Designer II, Full Session
sample rate, 16-bit and Stereo as your mix file format.
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When you have typed in a name for your master, and chosen a type
and destination, click on the OK button. The mastering process will
take a few minutes (depending on the length of the recording). After it
is complete, you will find your master soundfile in the folder you
designated.

Important: It is always better to use the Mix to Disk command to create your
audio master file instead of mastering directly to DAT. Mixing to a
random access medium (your hard disk), guarantees that your final
mix file will be an exact copy or your Session data. You can then back
this copy up to streaming tape, optical disk or DAT data backup for
optimum results. DAT audio recorders are sequential recorders, and
they use error correction schemes to compensate for data integrity
problems. Unlike a hard disk, a DAT recorder doesn't verify that your
data is undamaged, and it cannot rewind and re-retrieve data if it
encounters a data transmission problem.

The Virtual Mix command

This command controls which tracks DECK II will mix when you
choose the Bounce or Mix to Disk command. When this command is
off, DECK II will mix only the four or eight active Play tracks. This
will create a mix that sounds exactly the same as when you play the
session. However, when this command is on, DECK II will also mix
whatever is on the Work tracks. Because DECK II's automation
follows the playlist, this allows you to create a more complex mix.

The Fade Selection command

This command is only available when you have a waveform range
selected. Use this command to: 1) fade in the beginning of a wave-
form range, 2) fade out the end of a waveform range, or 3) crossfade
between two waveform ranges. All fades and crossfades are built
constructively, which means that the original audio data remains
unchanged. To remove a fade or crossfade, just select the range that
contains the fade and choose the Delete Fade command on the Process
menu.
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To fade in the beginning or fade out the end of a region: Select the
range that you wish to fade in. It should look something like this:

Then choose the Fade Selection command. After a few moments, your
waveform will reappear, looking something like this:

When you play this region back, you will now hear it fade in slowly to
full volume. You can execute this type of fadeon a single region, or
any group of regions. Remember, fades are made constructively, so

your original data has not been changed. Use this same method to

fade out the end of a region or regions. q

To crossfade between two adjacent regions: Select the range that you
wish to crossfade. It should look something like this:

Then choose the Fade Selection command. After a few moments, your
waveform will reappear, looking something like this:
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When you play these regions back, you will now hear the first region
fade out while the next region fades in, thereby creating a smooth
transition. You can execute this type of fade on a single pair of re-
gions, or any group of region boundaries. Remember, fades are made
constructively, so your original data has not been changed. For more
information about fades and crossfades, see the Visual Waveform
Editing chapter of this manual.

Important: The curve that is used by the Fade Selection command is set using the
Set Default Fade command on the Process menu. By setting the
default fade curves and using the Fade Selection command, you can
avoid setting the fade curves every time you create a fade or crossfade.
If you want to set the fade out and fade in curves every time you
execute a fade, use the Custom Fade command instead of the Fade
Selection command.

Important: Crossfades require that there is waveform data on your hard disk after
the end of region 1 (the fade out area) and before the beginning of
region 2 (the fade in area). If you have no data in these areas of the
source soundfile, DECK II will warn you, but it will allow you to
attempt to build the crossfade using whatever data is available.

The Set Default Fade command

This command lets you set the DECK II default fade curves and
default fade times. It brings up the following dialog:

Crossfade Out Shapes: Before Splice:

DY NN e

Crossfade In Shapes:

260 mS

I— f- / // _J J After Splice:
] Come)
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Use this dialog to default fade out and fade in curves, and the default
fade times associated with these curves. The following curves are
available:

Fade Out Shapes

=

This curve keeps Region 1 at full volume throughout the crossfade and
then immediately fades it out at the very end of the selection.

S

This curve fades out Region 1 relatively slowly, keeping the amplitude
fairly high. Towards the end of the crossfade, the amplitude drops off
sharply.

\

5

slightly lower than the previous envelope. This curve is the same as
the “equal power” curve found in Sound Designer II.

y

This envelope fades out Region 1 with a linear fade curve. It creates a
smooth, even fade out. It is the default curve.

This curve fades out Region 1 slightly faster, with the amplitude a

%

N

This curve fades out the amplitude of Region 1 relatively quickly at the
beginning of the crossfade.

X

This curve drops the amplitude of Region 1 even more quickly at the
beginning of the crossfade.
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ek

This envelope silences Region 1 at the beginning of the crossfade.

Fade In Shapes

=

This curve brings up Region 2 at full volume immediately at the very
beginning of the crossfade and keeps it there throughout the crossfade.

=

This curve fades in Region 2 quickly in the beginning, reaching full
amplitude fairly early in the crossfade.

//"

This curve fades in Region 2 at a moderately fast rate with slightly
lower overall amplitude.

.

This curve fades in Region 2 with a linear fade curve. Itis slightly
slower, with an even amplitude throughout the crossfade. This is the
default envelope.

ot

This curve fades in Region 2 slowly at the beginning of the crossfade.
|

=

This curve fades in Region 2 even more slowly than the previous
curve.
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=

This curve silences Region 2 until the end of the crossfade.

The default fade times only apply to instances where you are fading
and/or crossfading multiple regions in a large selection. This function
allows you to select hundreds of regions and region boundaries, and
execute fades on all regions at once. Use the Custom fade command if
you want to enter manually precise fade times other than the default
values.

Hint: The default fade times are also used whenever you select a waveform
range or boundary and choose the Default Fade command. The
Default Fade command always executes the fade or crossfade using
the default fade times, regardless of the selected range. This is a useful
tool, because it lets you generate very short fades and crossfades
without requiring you to zoom way into the display to select the
extremely short waveform ranges.

The Default Fade command

The Default Fade command executes fades in, fades out, and cross-
fades on all of the waveform regions and region boundaries that are
selected. The fades and crossfades are all created using the fade curves
and fade times set in the Set Default Fade dialog box. Based on the
selection, Default Fade will create: 1) a fade in at the start of any
region with empty space before it, 2) a fade out at the end of any
region with empty space after it, and 3) a crossfade between any two
regions that touch. Default Fade is also very useful for creating very
short fades and crossfades, without requiring that you zoom all the
way in to select the tiny range. For example, if you want to create a 10
ms crossfade between two regions, you can set the default fade times
to 5 ms before and 5 ms after. Then, the tiny crossfade will be created
any lime you select a waveform range that crosses the boundary
between two regions, regardless of the size of the selected range.

Hint: If you select a single region in Object mode and choose the Default
Fade command, the default fade in and fade out will both be executed
on the region.
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The Custom Fade command

The Custom Fade command functions in exactly the same fashion as
the Fade Selection command, with one major difference. The custom
Fade command always brings up a dialog similar to this:

Crossfade Out Shapes: Before Splice:

Crossrade In Shapes:

e T | Ll
L\ e = After Splice:
(o )

Use this dialog to select the fade out shape and fade in shape for the
desired fade or crossfade. The indicated times are the ranges (in
milliseconds) of the selection. You should use the Custom Fade dialog
any time you are creating a specialized fade or crossfade, and you
don't want to use your selected default shapes.

Important: If you are using the Custom Fade command to create a fade in or a
fade out, you will only see one set of fade shape icons.

Hint: You can use the Custom Fade command to execute custom fades and
crossfades on multiple selected regions. This allows you to create
specialized fades and crossfades and generate them without changing
DECK IT's default fade settings.

Hint: Crossfades are created in memory, so if DECK II tells you that there is
not enough memory to generate a fade, you can increase the size of
DECK II's memory partition (using the Get Info command in the
Finder), and try the fade again. If you are having trouble generating
extremely long fades or crossfades due to memory limitations, try
using DECK II's volume automation envelopes. These require no extra
RAM, and can generate 24-bit fades of any length.

il
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The Delete Fade command

Use this command to delete any existing fade or crossfade. To delete a
fade, simply select the waveform range or region that contains the
fade, and choose the Delete Fade command. To delete multiple fades
and crossfades in a single step, select all of the regions that contain the
fades and choose the Delete Fade command.

The Destructive Effects submenu

The destructive effects submenu contains all of the digital signal
processing (DSP) functions that can be executed on waveform regions
in the DECK II Track window. If you have purchased third party
plug-ins for use with your DECK II workstation, they will appear here.
In order to use these functions, you will need to select one or more
regions in Object (hand) mode or select a range in Range (waveform)
mode. Note that, although these processes are called "destructive,”
they can be used either constructively or destructively.

Whenever you execute any of OSC's destructive processes except
duplicate on this submenu, this dialog appears:

This process will permanentiy alter disk data.
Do you want to continue?

l» 0K | [ cencel | [Make o copy

If you wish to process the actual source data, click OK. This process
cannot be undone, so use it with care. If you wish to create a new,
processed copy of the source data, click on the Make a Copy button.
This is the suggested method, because it always maintains the source
data in original form. This can be particularly important if you are
processing an audio region that is used multiple times in the Session.
If you process the actual file, instead of making a copy, all instances of
that source file will be changed. For this reason, always process
original soundfile regions with care.
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The Normalize command

The Normalize command allows you to adjust the level of an audio
range or region(s) so that it peaks at 100% of the available amplitude
(volume) without clipping or distorting. This is one of the most useful
functions for editors of digital audio, because it squeezes the most
volume out of your digital audio. If you apply this effect to a group of
regions, DECK II will find the peak in each region and adjust each
region accordingly.

The Group Normalize command

The Group Normalize command functions in the same manner as the
normalize command, except that it is applied to a group of regions.
This function will search for the peak in a group of selected regions
and apply one gain to all regions. Use this command for true stereo or
quad normalization, or to normalize an entire edited track.

The Invert command

The Invert command turns the waveform 'upside-down’ (phase
inversion), which doesn't change the way it sounds, but can be very
important for certain sound design tasks.

The Reverse command

The Reverse command allows you to create a backwards version of
any selected range or region(s). When you select any of these three
commands, the standard processing dialog appears.

When you are ready to process the range or region(s), click on the OK

button (to process the original) or on the Make a Copy button (to create
processed copies, leaving the originals intact).
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The Duplicate command

The Duplicate command physically duplicates the audio data of any
selected range or region(s). The new audio files can be found in your
Session's audio files folder. The selected region or regions will then
access the data from this folder and not the original source.

For more information about the destructive effects, see Destructive
Signal Processing at the end of this chapter.

The Region Info command

The Region Info command shows you information about a selected

region. You must select the region in Object mode. When you choose
the Region Info command, the following dialog appears:

Ttk BT 0 £ ow ai
S ¥ 4

Name: L—_——.

File: menrcnmi;g:nesktop
F older:SurrealScape:SurrealScape audio files:Misk

File 734219
He Min Sec Fr
stort: [0 o e [0 |( Capture start )
0 0

tnd: 0 3
Dur: © o 31 o
| Show File | | Lounch Ftlim ﬁudllmﬂ [ Loop Audition
(Eencer)

The dialog shows you the region's name, followed by the location on
your hard drive of the associated audio file. You may rename regions
in this dialog box. Below the file location, the region’s start, end, and
duration times appear. You may change the start time of the selected
region by typing the new time in the start time fields. If you press the
Capture Start button, the new start time will be the current SMPTE
time.
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Pressing the Show File button will switch DECK II to the background,
and highlight the audio file associated with the region on the desktop.
The Launch Editor button will switch DECK II to the background, and
then open your chosen sound editing program with the audio file
associated with the selected region. The selected region will be high-
lighted in the sound editing program. The Audition button will play
the selected region. If you have the Loop Audition box checked,
pressing the Audition button will loop the selected region.

Hint: Double-clicking on any region in the Track window while in object
mode will open up the Region Info window for that region.

The Audition Selection command

The Audition Selection command plays back only the selected range or
regions, automatically muting all unselected audio. You can use this
command to listen to specific portions of your Session to evaluate them
for editing or arrangement purposes. Remember, Audition can be
used on one or more tracks at the same time.

Shortcut: Don't forget about the Loop audition setting in the General preferences
(on the File menu's Preferences submenu). When this option is turned
on, the selected range or regions always loop automatically when
auditioned. This is an excellent way to test out loops for composition
or ambience-building purposes.

The Launch Editor command

This command automatically starts up the sound editing program you
selected using the Set button in the General preferences (on the File
menu's Preferences submenu). If you have a waveform range or
region selected, the soundfile that contains that region will be opened
and the region will be selected automatically in the sound editing
program. This function is intended primarily for users of Sound
Designer Il who wish to access some of that programs two-track
destructive signal processing, but it will work with other programs.
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The Automation Thin command

Use this command to delete extraneous automation data. If you are
using the Mixer window or an external device to record automation
events, many more envelopes appear than if you use the Track win-
dow to add automation events. You will find it easier to edit the data
you have recorded after using this command. To use this command,
first select either volume or pan from the Automation View pop-up of
the track you wish to edit (you must be in the Track window.) Select
the data you wish to edit, then choose the Automation Thin command.
DECK 1T will find straight lines in the data and delete the intervening
envelopes. This is a non-destructive process which you may Undo.

The Strip Silence command

This command functions like a non-destructive gate. When you have
audio selected in the Track window, the Strip Silence command will
auto-create regions from a selected range by non-destructively deleting
silent areas based on parameters you choose in the following dialog:

Gate Parameters

noise threshold a
128 frame size (samples)

release size {samples)

@ Uefault Ualusa

ey N o

Audio that is at a level above the Noise Threshold will appear in new
regions. Areas of audio below the Noise Threshold for a duration
equal to the Frame Size will be non-destructively deleted. The Noise
Threshold can be any number between 0 (no volume) and 1023 (full
volume). The Frame Size indicates the number of samples in each
‘window’ DECK II uses to calculate whether audio is signal or noise.
If you choose too small a frame size, you may end up with more
regions than you desire. The Release Size tells DECK IT how many
samples to include at the beginning and end of audio it has deter-
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mined to be signal. The Release Size ensures that the beginning and
end signal is included in each new region. Both Frame Size and
Release Size are in samples, to allow highly accurate editing.

The Options Menu

The Options menu contains all of the commands you will need to
configure MIDI input and output, configure SMPTE setup, enable
basic automation recording and playback, and manipulate general
features of the Track window display. Here is a list of the commands
you will find on the Options menu, and a description of each:

The MIDI Setup command

If you are using DECK II without the Open Music System (OMS)
installed, this command brings up the following dialog:

Please configure the serial ports:
I Modem Port [] Printer Port
Speed:; Speed:
O 0.5 MHz 0.5 MB2
@ 1.0 MHz ® 1.0 Mz
() 2.0 MKz O 2.0 M2
O Fast O Fast
(® Generic @ beneric
CMIDI Time Plece O ML Nirne Precs
() Studio 5 O Stedig 5
[cancer | || ox ||

Use this dialog to configure DECK II for your MIDI setup. DECK II's
MIDI functions allow you to synchronize your Session to MIDI Time
Code (the computer translation of SMPTE time code) or play back a
MIDI file with the Session. If you are using DECK II's MIDI capabili-
ties, use this dialog to configure DECK so that it understands which
port your MIDI interface is connected to, and to select the type and
characteristics of the MIDI interface you are using. For more informa-
tion about these capabilities, see the Synchronization and MIDI
Window sections of this manual, and the individual owner's manual(s)
for your MIDI interface(s).
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If you are using DECK II with the Open Music System (OMS) in-
stalled, this command brings up the following dialog:

OMS MIDI Setup

Compatibility: Use Serial Ports:
O Use pple MU0 Manager () Modem
@ Only OMS Applications O Printer

) Allow Non-0MS Applications

Only OMS Applications

ORIS apolieatione can continwg 1 send ard recetre MD] when they ere not
atiye, SMhough only are OMS weplication can 6 timing (use the MODI Manager
1o synchronioe mulliph wpteations)

In this case, your MIDI setup has been configured via OMS. You can
see and change this configuration using the OMS Setup application
that comes with the OMS software package. Generally speaking, you
should configure DECK OMS compatibility to accept Only OMS
Applications, and you should avoid Apple’s MIDI Manager. The
MIDI Manager is notoriously slow, and will noticeabl y degrade

DECK's performance. a
Hint: If you are running OSC’s METRO sequencer on your Macintosh in

sync with DECK, make sure to set OMS to allow Only OMS Applica-
tions. This will improve the speed and smoothness of the switch
between the two programs during playback.

The SMPTE Format submenu

Use the SMPTE Format pop-up menu to select the SMPTE format you
wish to receive and send when DECK 11 is synchronizing. (DECK II
attempts to determine incoming time code format automatically, but
you should always set it anyway to prevent time base problems.) You
may choose between any of the following formats: 24 Frame (film), 25
Frame (PAL/SECAM video), 29.97 Frame (NTSC color video), 29.97
Drop-frame (NTSC wall clock color video), 30 Frame, and 30 Drop-
frame.
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24 frame is for most film applications, 25 frame is for PAL/SECAM
video, 29.97 is for NTSC color video, 29.97 drop is for wall-clock
accurate broadcast NTSC color video, and 30 frame/30-drop frame are
misnomer formats that were originally used for black and white video,
but are now generally used only for time stamping synchronization in
audio-only applications (and, cleverly, for various film-to-tape
pulldown/pullup compensations).

Hint: If you are working in NTSC video, and someone sends you a video
tape striped with 30 frame code on the address track, you can safely
assume that the time code is actually 29.97 frame time base. This mix
up is a leftover from the early days of time code.
The SMPTE Start Time command

The SMPTE Start Time command brings up this dialog:

Hr Min Sec Fr Sub

o] o |[o l[ﬁtﬁ_]m
! 0K "Cnncel]

You will use the SMPTE Start Time dialog to offset DECK II's master
tape counter by a specific number of SMPTE frames. You can think of
this time as the current Session’s zero time. If you then set DECK II to
synchronize playback, the Session will begin to play when the SMPTE
Start Time frame is received. For more information, see the synchroni-
zation section of this manual.

You can also use the Capture button in the SMPTE Start Time dialog to
lift the current SMPTE frame from tape directly into the dialog. Re-
member, however, that capture functions are often not accurate if you
are using longitudinal time code (LTC), because this timecode cannot
be read at slow shuttle speeds.

e
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Hint: If you are using vertical interval time code (VITC), the capture button
will always lift the correct SMPTE frame address, even when your
video deck is crawling or on a still-frame.

The SMPTE Online command

This command puts the current Session online, which means it is ready
to synchronize to incoming SMPTE time code. To lock playback to
incoming code, just select this command and press the Play button in
DECK IT's Transport window. This puts DECK II in standby mode. As
soon as time code is detected, DECK II will begin to play back at the
correct frame.

Important: Remember, you will need a tape source with SMPTE time code on one
track, and a SMPTE-to-MIDI time code converter /Mac MIDI interface
in order to synchronize to SMPTE. (Mark of the Unicorn's MIDI
TimePiece or Opcode’s Studio 5, are examples MIDI interfaces with
SMPTE-to MTC capabilities.) For more information, see the synchroni-
zation section of this manual.

Hint: To record audio while online, just record-enable a track, select the
SMPTE Online command, and press Record and Play buttons in DECK
II's Transport window. This puts DECK I in record-standby mode.
As soon as time code is detected, DECK II will begin recording, and a
DECK will automatically place the recorded audio at the correct time.

The Trigger Sync command

DECK II offers two types of synchronization. DECK's native mode is
called ‘continuous resync,’ and is generally the more desirable of the
two modes. When Trigger Sync is turned off, DECK 11 is in continu-
ous resync mode. In this mode, DECK IT watches all incoming SMPTE
frames to determine if the speed of your source playback unit is
correct. When DECK determines that the SMPTE playback source is
slowing down or speeding up, DECK will alter the playback sample
rate in real-time in order to compensate for the speed changes. When
this happens, you may hear DECK audio playback slow down or
speed up. This mode guarantees that your Session's digital audio will
remain tightly synced to the SMPTE source.
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When Trigger Sync is turned on, the Session's playback sample rate
will not be altered during playback. DECK II will still sync to the
incoming SMPTE frame, and chase /lock correctly, but no playback
speed adjustments will be made. Trigger Sync is designed specifically
for users who know that their SMPTE source is absolutely time-locked.
For video professionals, use Trigger Sync if you run your SMPTE
source video deck with house sync (a black burst hooked to a video
input). For audio professionals, use Trigger Sync if you run digital
multitracks, or timecoded DAT as your SMPTE source, or if you have a
multitrack audio recorder that is hooked to house sync.

Hint: Real-time sample rate conversion can degrade the general quality of
the audio that is played back. For this reason, the best results are
achieved when you run DECK II with Trigger Sync turned on, and
your SMPTE source locked to house sync.

Hint: If you have a Pro Tools or Sound Tools II system, you also have the
ability to augment your system with Digidesign's SMPTE Slave Driver
or Video Slave Driver. If you use either of these devices, make sure to
configure your hardware for Internal Mode (using the Option menu's
Hardware Configuration command), and turn on Trigger Sync.

The Pulldown command
You can change the current Session's master playback sample rate by

choosing the Pulldown command. When you choose this command,
the following dialog appears:

Session Playback Rate Settings

Session Nominal Rate: 44100 Hz
Playback rate: 44100 | Hz

(Puli-down] [ Reset | [ Pull-up |
|
SI Y
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The Session Nominal Rate is the playback rate you chose when you
created your Session. You may change the Playback Rate by typing a
new value in this field. Increases in sample rate raise pitch and
decrease Session duration. Decreases in sample rate decrease pitch
and increase Session duration.

The Pull-down button automatically lowers the Playback Rate to a rate
useful when editing audio to video transfers of film when you intend
to go back to film (mag or other) for the final result. The Reset
button changes the Playback Rate to the Session Nominal Rate. The
Pull-up button automatically raises the Playback Rate to a useful rate
for laying back your edited audio to mag film (or to DAT for transfer
to mag film). This is a very specialized command useful in NTSC
countries, and here is an oversimplified explanation of the scenarios in
which you might use it. If this doesn’t make sense to you, just forget
you ever read it:

If you are rebuilding audio tracks to video telecine transfers of film
by going back to the original location Nagra 1/4" tapes, digitize all
audio from the 1/4" tapes at the 44.1 or 48 kHz rate. Then set the
sample rate to Pull-down, and edit the sound to picture. When laying

Reset the pulldown rate. This will yield results that are time-correct

back the finished audio to DAT for transfer to mag (or direct to mag), a

for film, and is the preferred method for preserving audio quality.

If you have built audio tracks to video telecine transfers of film
using audio files and effects from your sound libraries or hard disk
(which are not location sound), then you can edit all audio tapes at the
44.1 or 48 kHz rate. When laying back the finished audio to DAT for
transfer to mag (or direct to mag), choose the Pull-up option in the
pulldown dialog. This will yield results that are time-correct for film.

Hint: You can also use the Pulldown command to stretch or squeeze audio.
For instance, if you need to fill a 30-second spot, but only have 24
seconds of audio, and your Session Nominal Rate is 44100 Hz, you can
use the following equation to stretch the 24 seconds into thirty: (24+30)
= (X+44100). Thus if you enter 35280 (X) into the Playback Rate, DECK
1T will stretch your audio to the desired length. Be warned, however,
radical sample rate adjustments will not sound very good.
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The Automation submenu

The track Automation submenu looks like this:

Mute Al
Play Al
Record Rl

Erase All

You will use this submenu to set global values to mute, play, record,
or erase volume and pan automation on all tracks. (To learn about
recording real-time automation, see the Mixer window information
earlier in this chapter, and the MIDI Map Faders command on the
Options menu. To learn more about drawing automation envelopes
for volume and pan, see the Track window, explained earlier in this
chapter.) The Automation submenu offers these choices:

Mute All: Mute volume and pan automation playback on all tracks.

Play All: Set volume and pan automation playback on all tracks to play.
Record All: Enable volume and pan automation recording on all tracks.
Erase All: Erase all recorded and drawn volume and pan automation.

Use these setting to enable recording and adjust playback of automa-
tion on all tracks. For more information about recording and editing
automation see Chapters 5 and 6 of this manual.

The MIDI Map Faders command

This command allows you to map any MIDI controller (a modulation
wheel, or J.L. Cooper FaderMaster, for example) directly to DECK II
Mixer Window volume and pan faders. This mapping process is quite
simple, and requires no text entry. Here's how it works:

To map a DECK II Mixer window fader to an external controller, just
choose the MIDI Map Faders command. All of your faders will
highlight green, to show you they are ready for mapping. Next, touch
the fader or faders you wish to control. It (or they) will turn yellow to
indicate they are ready for MIDI input. Now move the controller that

O

DECK If



should control the selected yellow faders. These faders turn red to
indicate they are mapped. To begin moving the faders from an
external controller, just choose the MIDI Map Faders command to exit
MIDI map mode.

Hint: You can follow the same directions to change or turn off mapping of
individual Mixer window faders.

Important: You cannot use this function unless you have a Macintosh MIDI
interface and a MIDI controller of some kind. DECK II does not
directly support the J.L.Cooper CS-10.

The Mute MIDI Map command

This command temporarily stops your external controllers from
moving DECK II faders in the Mixer window. It only functions if you
have already mapped external controllers to faders using the MIDI
Map Faders command. To turn external control back on, just choose
the Mute MIDI Map command again.

The State Transition Time command

The State Transition Time command allows you to select a fixed a

automation fade time that will automatically be used whenever you
record or play mixer automation using DECK II's Mixer States (located
in the Transport window). When you choose the State Transition Time
command, this dialog appears:

Hr Min  Sec Fr  Sub
FIE IR
) e

Use this dialog to enter the duration of the fade you wish to occur
between the time you click on a Mixer State arrow, and the moment
that the new mixer state arrives on the screen. DECK 11 automatically
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fades to the new mixer state over this duration. Remember, these
fades are recorded if you are recording automation.

The Selection Tools Submenu

This submenu contains a number of specialized tools that help you
manipulate the Track window display, and move times and selection
ranges between Track window and the Transport window. These
commands are only available when the Track window is the active
window. The Selection Tools submenu looks like this:

Position At Beginning I
Position At End €]
Position To Fit

Set Punch Time From &\
Set From Punch Time

Set Selection...

Here are brief explanations of the different commands on this menu:

Position at Beginning: This command automatically scrolls the Track
window to show you the beginning of the currently selected range or
region. This is a very useful command when you are zoomed in very
close, and you want to adjust region start time(s) without zooming out
to find the region start.

Position at End: This command automatically scrolls the Track
window to show you the end of the currently selected range or region.
This is a very useful command when you are zoomed in very close,
and you want to adjust region end time(s) without zooming out to find
the region start.

Position to Fit: This command performs the same function as the Fit
Selection icon. It automatically expands or contracts the display so
that the current selection fills the screen. This is true whether the
selection is a region or a waveform range. This command makes it
possible to view rapidly any specific audio range, region, transition or
event.

———
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Set Punch Time from: This command automatically moves the start
time of the current Track window selection to the begin counter and
the end time of the current Track window selection to the end counter
in the DECK II Transport window. Use this command when you want
to select a waveform range or region for sample-accurate punch-in
recording or loop mode playback.

Hint: Any time you have a waveform range or region selected, you can press
the 'C’' key on your Macintosh keyboard to set a cue loop automati-
cally. This automatically transfers the range or region’s begin and end
times to the Transport window and turns on Loop mode. Option + C
turns off loop mode.

Set from Punch Time: This command performs a function that is the
inverse of the Set Punch Time from command. It automatically reads
the start time and end times from the Transport window and selects
that range in the Track window. The range is selected on any track
that currently has a selected range or insertion point. Remember, you
can move and expand the selection using the Macintosh keyboard's
arrow keys and shift+arrow keys, respectively.

Set Selection: This command brings up the following dialog box: a

3 Bar Beat Tick
Start Time D D D

Bar Beat Tick

enamime (9 |[1_ [T ]
(Cancel )

Use this dialog to enter the start and end times of the range you wish
to select, then click OK. The range is selected on any track that cur-
rently has a selected range or insertion point. Remember, you can
move and expand the selection using the Macintosh keyboard's arrow
keys and shift+arrow keys, respectively.
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The Snap to Grid command

This command turns DECK II's Track window grid on and off. When
the grid is on, all range selections and range and region dragging will
be constrained (stick to) the Track window grid. DECK II's Track
window grid is a smart grid, in that it always adjusts to match the
current units. If you are viewing waveforms by SMPTE frame, the grid
will snap edits to frame. If you are viewing waveforms by quarter
note, the grid will snap edits to quarter note. To turn off the grid,
select this command a second time. Remember, the Macintosh
keyboard's arrow key edits (as well as shift+arrow, command+arrow,
etc.) all conform to the grid when the grid is on.

Hint: You can also turn the grid on and off using the Grid Setling icon, to the
left of the Axis Units pop-up in the Track window.

The Set Grid Interval command

It is possible to manipulate the display resolution to a variety of
different levels. If the Axis Resolution pop-up to the right of the Axis
Units pop-up in the Track window does not offer you the grid units
you desire, you may choose your own display resolution using the Set
Grid Interval command. Choosing this command brings up the
following dialog:

Hour Min. Se

r. Subfr.

3 o

Enter the Grid Interval you desire. You may use the current SMPTE
time by pressing the capture button.

The Set Nudge Time command

When you use the Command-+arrow keys on a selected object or range
in the Track window, DECK II physically moves the selected object or
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range left one unit, right one unit, up one track or down one track.
You can change the nudge units in the Set Nudge Time dialog:

Hour M™in. Sec. Fr. Subfr.

I.U_:HO jo_|[o Im

m‘ Cancel I

Enter the Nudge Time you desire. You may use the current SMPTE
time by pressing the capture button.

The Hardware Configuration command

This command brings up the Hardware Configuration dialog, which
looks like this:

S5 ST Hordware Configuration =

=4

Dig‘nalFormal:] S/POIF vl

[ Miz tniput én

Use this dialog to choose the Macintosh NuBus card you wish DECK II
to use, and to configure the settings of that card. The Audio Card pop-
up will show you all of the audio cards currently installed in your
Mac.

AV Users: The Audio Card pop-up will display "AT&T Internal DSP."” All other
commands in this dialog will be grayed out. If you have a NuBus card
installed you may choose to use it instead of your internal AV capabili-
ties.
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When you choose an audio card, you can use the other controls in the
dialog to configure that card. Here are explanations of those controls:

Sync Mode: Set this menu to Digital if you are recording digitally via
the S/PDIF or AES/EBU digital inputs on your audio card. Otherwise
set this to Internal.

Input Type: Set this menu to Digital if you wish to record from the S/
PDIF or AES/EBU digital inputs on your audio card. Remember,
when you do this, DECK IT's inputs 1 and 2 will be taken from your
digital inputs. When you are doing analog recording, set this to
Analog.

Digital Format: Use this menu to choose your digital input/output
format. Note that the Audiomedia II card only supports S/PDIF.

Mic Input On: This check box is only available when if you have an
original Audiomedia card. That card has a built-in microphone
preamp instead of digital input and output. When you turn this check
box on, your original Audiomedia card will automatically mix its
microphone input into inputs 1 and 2. Remember, Audiomedia and
Audiomedia II cards have software input level adjustment. See the
Input Level submenu form more information.

The Input Level submenu

If you own a Pro Tools or Sound Tools II system or a NuMedia card,
this submenu is not available to you. All other hardware systems allow
you to set the input level of the incoming signal. Use this submenu to
adjust the input level for recording. Make sure that you watch the
input VU meters on your Mixer window record track as you adjust this
level, and attempt to set the input recording level as high as possible
(without clipping). If the level is too high, the clip light will turn on. If
you have a Sound Tools IT or Pro Tools system or a NuMedia card, you
will need to adjust the level of your input signal at its source.
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The Session Menu

This menu contains commands available to you to perform on the
entire session. Here is a list of the commands you will find on the
Session menu, and a description of each:

The Session Info command

The Session Info command brings up this dialog:

Free RAM: 2381kB
Free disk space: 23MB
Sample Rate: 44100
kree automation events: 5275
Free MIDI events: 5119

Files In session:
Inenreoming:ﬂnta:nudio:Beats:congus ity

ok ]

The Session Info dialog tells you how much free RAM you have, how
much free disk space there is on the drive that contains the Session,
and lists the Session’'s sample rate and total of free automation events.
Below this basic information, you will find a list of all the soundfiles
used in the current Session. You can use this list to track down a file
by selecting that file and clicking on the Show File button. This will
automatically switch you to the Finder, open the folder that contains
the file, and select that file. You can rename a file by selecting that file
and clicking on the Rename File button.
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The Session End Time command

The Session End Time command brings up the following dialog:

Hour Min. Sec. Fr. Subfr.

ol o |[13 [[o_J[o ]

Use this dialog to change the end time for your Session. This com-
mand is useful when the Autostop at end of Session preference is
turned on. Instead of stopping when the last sample of your Session is
detected, DECK II will stop at the new end time.

|lfapture|

The Compact Session command

The Compact Session command automatically compacts all of the
audio files in the Session's Audio Files folder which are used in the
current Session. Use this command to get rid of unused audio data
(junk takes or unused solos, for example) in all soundfiles associated
with the Session.

This is how audio files are compacted: DECK II looks at the list of
audio regions and loops in each audio file. It then looks through the
audio data in each file, and finds all audio data that is not used in any
region. After the unused audio has been found, it is permanently
deleted from the drive, and all region definitions are updated.

Important: Compaction is a destructive process, so make sure you understand
what you're doing before you use it! It is particularly important that
you understand the Always Save Regions when Session is Saved and
Rewrite Regions preferences in the DECK II General Preferences
dialog. These preferences have strong effects on the compaction
process. Make sure to read about those preferences before you
compact audio files or Sessions.

Important: Compact Session only compacts audio files located in the current
Session’s Audio Files folder. It will not compact audio files located
elsewhere on the drive, or on other drives. This safety valve has been
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built into DECK 11 to prevent the accidental compaction of soundfiles
in a central sound effects library, or of soundfiles used in multiple
Sessions. Make sure you always keep sound library files and shared
soundfiles in a folders outside of the current Session's Audio Files
folder.

The product of the compaction process is generally an increase in the
available hard disk space. To compact a session, choose the Compact
Session command. When you choose this command, you get this
Handle dialog:

Enter handle time:

12:000 Seconds

The Handle Size setting allows you to keep a little bit of extra audio

data before every region start and after every region end, which will be

useful in the future if you plan to crossfade the regions. You will

probably want to set your handle size to at least 2 seconds for this

purpose. To compact the Session, enter your handle size and click on a
the OK button. The compaction process may take a few minutes.

Note: If you use entire soundfiles your Session, you will find that there is no
unused audio data to delete from those files. In such cases, compac-
tion may not increase your available disk space. For more information
on using the Compact function to free disk space, see the Levels
preference section of this manual.

The Export Session Regions command

The Export Session Regions command immediately saves all regions
defined in the current Session into their source soundfiles. When you
install DECK I, the program is set to save all regions to their source
soundfiles whenever you save the current Session. This is a good basic
configuration, because it assures you that your regions will always be
saved. You may also choose at any time to save the regions out to their
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soundfiles, even though the Session has not been saved. That is the
purpose of the Export Session Regions command. You might do this,
for example, if you have defined an interesting region of audio, but
you don't wish to keep it in the current Session. In such a case you can
use the Export Session Regions command to save the region, and then
delete the region from the Session. Even though the region is not
present in the Session, you will find that it has been saved into its
source soundfile.

The Import Session command

This command is here for the convenience of original DECK owners.
After you create a new Session, use this command to import an origi-
nal DECK Session. Choosing this command brings up a standard file
dialog. Use this dialog to select the original DECK Session you wish to
import.

The Library Operations Submenu

The Library Operations Submenu offers commands used in the Library
window. Here is a list of the commands available on this submenu,
with explanations of each:

The Sort By Name and Sort By Size commands

The Sort By Name command will sort all regions in the Library win-
dow by name. The Sort By Size command will sort all regions by size.

The Update from Session command

The Library window will only display regions which have been
imported into the session. If you would like regions you have created
to appear in the Library window, choose the Update from Session
command.

The Find File command

This command is available when you have a region selected in the

Library window. It automatically switches you out to the Finder and
highlights the audio file that contains the selected region.
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The Windows Menu

This menu contains a list of the windows that are available in DECK II.
Choose the name of a window to open that window or bring that
window to the front. Note that the QuickTime window can only be
opened if you have already imported a QuickTime movie. (For more
information see the Import Movie command on the QuickTime menu).

Hint: When you are recording audio, DECK 1T does not create your wave-
form overviews until you open the Track window. Since the creation
of overviews may take a few moments, you should open the Track
window only when you are ready to view and edit the audio wave-
forms.

The Close Window command
This command closes the currently active DECK I window. To open

the window again, choose the name of that window on the Windows
menu.

The QuickTime Menu

This menu contains all of the commands you will need to open, close,
edit and export (mixdown) QuickTime movies in DECK TI, as well as
configure live video. Here is a list of the commands available on this
menu, with explanations of each:

The Import Movie command
Use this command to import a QuickTime movie for synchronized

playback with audio tracks. When you choose the Import Movie
command, this dialog appears:
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|2 DECK 11 Demo + ] —Prostore

|3 DECK 1l Demo audio files | [ fjact |

0io0g

‘ [ Desktop

()

Preview

(2] Show Preview Mowie Audio Handling:
() Put audio on cliphoard
(O Put audio in new work track(s)
@ Leave audio in movie

To import a QuickTime movie, use the file selector area to find and
highlight the movie you want. If you have the Show preview option
checked, you will see the poster frame of that movie. If the selected
movie has no poster frame, click on the Create button to create a
preview frame. Once you have selected a movie, you should choose
what you want to do with that movie's existing audio (if there is any).
You must select one of the following options:

Put audio on clipboard: This option is a conversion option. It auto-
matically removes the source audio from the QuickTime movie and
converts it to 16-bit monophonic Sound Designer II file(s). These files
are created in the Session's audio files folder, and then placed on your
Macintosh Clipboard for pasting into any track in the Track window.
To guarantee that the Clipboard file will sync to the imported movie,
you will need to drag or paste it so that it starts at the Session zero
time.

Hint: Remember, if the source audio was stereo, you will need to select two
tracks when you paste the audio.

Put audio in new work track(s): This option is a conversion option. It
automatically removes the source audio from the QuickTime movie
and converts it to 16-bit monophonic Sound Designer II files. These
files are created in the Session's audio files folder, and then placed onto
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two new playlists on work tracks at the bottom of the Track window.
To play back these tracks, click on the track name area(s) to select the
track, then drag the track up to one of the play tracks. (You can also
use the playlist pop-up at the bottom of any track in the Mixer window
to move these new playlists up to playback tracks.) Choose this option
to make sure that the original QuickTime audio will be included in any
16-bit stereo mixdowns and in exported QuickTime movies.

Leave audio in movie: This option performs no file conversion. The
original audio remains in its source form, and is still associated with its
QuickTime picture. This audio will play back along with all DECK IT
16-bit tracks when you play back the Session. Note, however, that this
audio left in its movie will generally play back through your Macin-
tosh speaker or audio output. Choose this option if you wish to use
the original QuickTime audio as guide audio only. When you leave
your audio in the movie, you will get an extra track of playback, but
that track will be erased when you Export your finished QuickTime
movie with its new audio.

The Export Movie command

of the QuickTime movie you are editing in the current Session. The

You will use the Export Movie command to create master mixdowns a

Export Movie command allows you to create new QuickTime movies
that contain or reference 8- or 16-bit mono or stereo audio interchange
file format (AIFF) audio tracks at a variety of sample rates. The
exported movie contains all of the edited and audio with automation
moves included. You can think of the Export Movie command as a
Mix-to-disk command for picture and sound. Itis usually the last step
in the QuickTime audio post-production process, and the result can be
played back on any Macintosh. When you choose the Export Movie
command, the following dialog appears:
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[6! Sessions v I

O BurstDay

[ Dino-boy

O Ueins

O Wwailing Wall
£ Weight

[ Yeninko

Save as:
|Final Movie w/sound

[<) Make moute seif-contained

[] Add audio to movie
Audio Format: | 8 Bit Mono v

Sample Rate: 1/2 Session v

To export your QuickTime movie, choose a destination folder and type
in a name for the movie. Then set your preferences for the format of
the movie you wish to create. The following options are available:

Make movie self-contained: This option creates an entirely new, self-
contained movie. The self-contained movie will consist of a single
QuickTime (Movie Player) document that contains all picture and
sound. According to QuickTime specifications, the sound and picture
are mixed together, creating a movie that is fully transportable and
plays efficiently (quickly). Note that a self contained movie will take a
while for DECK II to create, because it requires an extra step ('flatten-
ing’) which can be time consuming. Remember, a self-contained movie
will generally be quite a large document.

Hint: Make a movie self-contained when you want to create a single docu-
ment for delivery. If you are simply performing test edits and
mixdowns, do not make the movie self-contained. When the movie is
not self-contained, a new, extremely small (typically around 30K)
movie document is created. Like a DECK II Session, this document
simply references the source sound and picture files. The Movie Info
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command in Apple's QuickTime Movie Player can always be used to
determine which audio and picture files are used by a movie that is not
self-contained.

Add audio to movie: This option determines whether the audio from
the current DECK Session will be mixed, converted and added to the
finished movie. You will generally want to have this option turned on.
When it is turned off, a 'silent movie’ document is created.

Audio Format: Use this pop-up menu to choose the audio bit-depth
you wish for your audio mixdown file when the audio is mixed and
the movie is exported. You may choose between 8-bit mono, 8-bit
stereo, 16-bit mono or 16-bit stereo. Generally you will use the 8-bit
mono format for playback from the desktop via the Mac speaker. (This
format also requires less disk space and plays back more efficiently.) If
you wish to create a high-fidelity master, choose 16-bit stereo. An
AIFF soundfile is always created, unless you chose 'Make movie self-
contained,' in which case the audio is placed directly into the movie

picture data. a

Important: Apple’s Sound Manager is capable of enhancing the playback capabili-
ties of most Macintoshes. Forthcoming versions of the Apple Sound
Manager will allow playback of 16-bit stereo AIFF files directly from
the Mac speaker (only 8 of the bits actually play). This new software,
in tandem with Digidesign output drivers, may make it possible to
create and exchange movies containing 16-bit stereo files as the stan-
dard format. At the time this software was released, these enhance-
ments are not yet available, and 8-bit mono is still the most universal
format for QuickTime audio. Consult Apple and Digidesign for the
most recent information.

Sample Rate: Use this pop-up to select the sample rate you wish to
have for your final QuickTime movie audio. Generally speaking,
higher sample rates are better because they offer higher fidelity.
However, they also require more disk space. For the highest-fidelity
results, set this pop-up to Full Session. This will mix down your
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audio at 44.1 kHz (or 48 kHz, depending on the sample rate of the
Session). Setting this pop-up to 1/2 Session will mix down and
resample audio to 22.05 kHz. The 1/4 Session will mix down and
resample audio to 11.025 kHz. The lower the rate, the noisier the
audio, so choose the lower rates with care.

Hint: If you are mixing down a QuickTime movie with 8-bit sound for
desktop playback, the 1/2 Session setting will produce very good
results.

When you have chosen your options, click on the Save button to export
the movie. Remember, only one QuickTime movie may be opened at
any time. To close the current movie, use the Dispose Movie com-
mand.

The Dispose Movie command

This command closes the current Session's QuickTime movie, which
you loaded using the Import Movie command on the QuickTime
menu. DECK II only allows you to have one QuickTime movie open at
any time. Use this command to clear the Session’'s QuickTime movie
$0 you can import a different movie.
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The Get Movie Info command

The Get Movie Info command brings up this dialog:

S ——e et Mogle Info ™

Createg:
Modified:
Frame Hate:
¥ ot Irames:
Length:

Tue, Jun 15, 1993, 3:59 PM
Sot, Jun 10, 1003 5:08 PM
16.67 fps

502

0 br, 3 min, 1.20 sec

Filex in Mowie:

ProStore:Movie rnMer:ripner Head Picture
FroStore:Movic Folder:f hpper Head Budia

Show File |

The Get Movie Info dialog contains information about the creation
and modification dates, frame rate, frame count and duration of the
QuickTime movie that is loaded into the current Session. Below this
basic information, you will find a list of all the QuickTime files and
soundfiles used in the current movie. You can use this list to track
down a file by selecting that file and clicking on the Show File button.
This will automatically switch you to the Finder, open the folder that

contains the file, and select that file.
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The Sound command

This command toggles QuickTime desktop audio playback on and off.
It is only available if the QuickTime movie was imported with the
‘Leave audio in movie’ option selected. This allows you to hear all of
the 16-bit audio tracks within DECK II play back along with the 8-bit
audio in the source QuickTime movie. Remember, the QuickTime
audio will come from your Mac speaker or CPU audio output. You
can adjust the volume of this playback using the Sound control panel
in your System Folder's Control Panels folder.

The Copy Frame command

This command copies the current frame of the Session's QuickTime
movie to the Macintosh Clipboard. You can then paste the frame into
the Scrapbook or into any compatible Macintosh program (Microsoft
Word or Adobe PhotoShop, for example). Note that the copied frame
is always the one you see in the QuickTime window when you choose
the Copy Frame command. The frame is always copied at the size you
see.

Note: You can also use the Copy Frame command to copy the current frame
of Live Video to the Macintosh Clipboard. For more information on
Live Video, see below.

The Set Poster command

This command allows you to set and save the current QuickTime
movie's poster frame. The poster frame is the frame that is used by
different Macintosh programs (as well as the operating system) as a
symbol of the movie. For example, the icons of self-contained
QuickTime movies that appear on the Mac desktop are tine versions of
the poster frame. (The poster frame is also used as the preview frame
when programs like DECK I show QuickTime movies for importing
or opening.) To set the poster frame, scrub or play the current Sessions
QuickTime movie until you see the frame you want. Then choose the
Set Poster command.
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The Chase Positioning command

This command automatically scrolls the QuickTime movie whenever
you move regions or drag region boundaries in the DECK II Track
window. The QuickTime movie frame you see will always be the
frame that is at the beginning of the current region. Use this function
during synchronization editing to 'spot’ sound effects, music and
dialog to specific QuickTime movie frames.

The Live Video command

If your computer has video input capabilities (the Macintosh AV
machines or RasterOps MediaTime board, for example) you can
connect source video to your hardware and play live video directly
onto your Mac screen in the QuickTime window. Simply turn the
source video on, then choose the Live Video command. DECK II will
automatically open the QuickTime window to view the Live Video.
DECK II does not yet not record or compress video.

The Configure Live Video command

When you choose this command, DECK 11 will open a dialog similar to
this one:

Saturation: ey,
Brightness: sl
Contrast: com— f—— |
Sharpness: el | |
Black Level: [m————— ' i
White Level: Semmm—| S o 2 e

e Loaih Tacind_s (Eencen) o)
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This dialog is specific to your hardware. For more information about
configuring live video, consult the owner's manual for your specific
hardware.

The Size submenu
This command resizes the QuickTime window. Depending on your

hardware, you may choose from the following size options: Quarter
Size, Half Size, Full Size, Double Size, and Quadruple Size.

DECK II's Destructive Signal Processing

Although DECK II is primarily intended as a real time multitrack
audio recorder and editor, it does offer a number of constructive/
destructive, non-real time processes which will help you in certain
situations. These processes are all available under the Destructive
Effects submenu on the Process menu. Here are short explanations of
how they work:

Normalization

Often, after recording or adding a track or region, you may find that
the overall level seems a bit low, even when it is turned all the way up.
In such a case, you need to increase the track’s volume in order to
bring it to the playback level you desire. If you encounter a case where
a track’s level seems too low, regardless of its monitor setting, you may
wish to normalize that track.

When you ask DECK II to normalize a track or region, this is what
happens: DECK Il searches the entire region (or regions) for the
highest amplitude (volume) peak level. Then DECK II measures the
difference between the highest level and the maximum allowable level.
In the final step, DECK II adjusts the overall level of the selected region
(or regions) so that the highest peak matches exactly the maximum
allowable level. By doing this, you get the most out of the 16-bit
resolution afforded by digital audio recording, and you bring the
overall track level to its maximum without clipping or distorting.
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Remember that a noisy, low-level audio region will not be fixed
miraculously by normalization. Normalizing such a track will create a
noisy, high-level track. Normalization does guarantee that you’ll get
the most out of the 16 available bits of amplitude resolution, but the
best medicine for a poorly-recorded track is re-recording.

Note: Unlike most audio workstation software, DECK II allows you to
execute constructive /destructive effects on multiple regions at once.
When you normalize multiple regions at one time, all regions are
normalized as single units. Each region will be considered indepen-
dent, and will be normalized to its highest possible amplitude. If
instead you wish to apply one gain to a group of selected regions, use
the Group Normalize command.

Reversal

Reversal is a specialty function that performs an edit which is quite
difficult in the analog world. It takes the audio data in the selected
region or regions and flips it around so that the soundfile is back-
wards. DECK II accomplishes this swapping the first and last samples,
then the second and second-from-last, etc. This process does not alter
the fidelity of the source file in any way, and it can be undone simply
by reversing the same region(s) again.

Phase Inversion

This effect turns the selected region or regions 'upside-down, making
the new waveform a mirror image of the original. Phase-inversion is
accomplished by multiplying all samples by -1, thereby making all
positive amplitudes negative and all negative amplitudes positive. An
inverted waveform sounds the same as the original. This is a very
useful function for sound editors who are creating ambience or tonal
forwards-backwards loops. In instances where an audio region is
followed by a backward copy of itself, the phase of the reversed copy
must be inverted to maintain the slope of the waveform and prevent a
‘pop’ at the transition. Like reversal, this process does not alter the
fidelity of the source file in any way, and it can be undone simply by
inverting the same region(s) again.
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Important: All DECK II destructive effects allow you fo execute the process on the
original data or to create a copy of that data and execute the process on
the copy. Itis always a good idea to execute destructive processes on
a copy of the original data. This is true for two reasons. First, by
executing these processes on a copy, you never endangered the source
audio data (normalization, for example, cannot be undone). Second, if
you execute a process on the original region data, all instances of that
region within all Sessions will be changed. Change the original source
data only if this is your desired effect.

This concludes the Reference chapter of the manual. If you are curious
about a specific DECK II recording, mixing, or editing task, see the
earlier chapters of this manual. Otherwise, consult the Index to find
the location of the information you need.
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Fine-tuning and Troubleshooting Your System

Unlike most of the Macintosh programs you run now, DECK I really
pushes your Mac to its performance limits. DECK II is-using your Mac
to do the most it can possibly do, and because of this you will have to
keep certain points in mind. The information listed below may help
you fine-tune your system to keep as fast and efficient as possible. If
you are having trouble recording tracks, due to computer or drive
speed, consider the following:

Drive speed is more important than processor speed. DECK IT will
perform without problem on most Macintosh-family computers. Even
with a Color Classic and a Audiomedia LC card (the slowest combina-
tion), you should be able to record and play all tracks. If you are
having any type of recording problem, it is probably dependent on
your drive (or on some internal software conflict, such as File Sharing,
which should be turned off when you run DECK).

DECK II requires a hard disk that has a minimum average access time
of 27 ms and a sustained throughput of 300 KB/second or more.
Manufacturers are generally most concerned with selling hardware, so
they are often not the best source for the average access time of the
drives. Digidesign has tested a number of hard drives, and deter-
mined which ones work, and which ones don’t. That list is also

before purchasing a hard disk for four track recording.

contained in the appendix of this manual, and you should consult it @

If you already have a hard disk, and it seems to be too slow for record-
ing, try optimizing or reformatting the drive. Often, the reason that
your disk may choke during recording, is that the remaining open disk
areas exist as tiny segments that are spread all over the drive. These
segments take much longer to find, and hence the slow-down. Disk
optimizing software, such as Norton Speed Disk™, search your drive
and rearrange it so your files (and open disk space) are no longer
fragmented. This often speeds up the drive significantly. If this
doesn’t work, remember that it is possible that your disk is too slow. If
it is still under warranty, you may wish to have it benchmarked to
judge if the manufacturer’s information was false. If the drive is not as
fast as claimed, contact the manufacturer directly.
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Throughput is a factor. As far as drive speed is concerned, average
access time is not everything. A high-performance drive needs a good
combination of average access time and throughput speed (in Kbytes
per second). Although there is no magic throughput number, you
should make sure that any drive you are considering for audio pur-
poses compares favorably with the drives recommended by Digi-
design. Really, the best thing you can do when considering a drive is
to test the specific drive with your system before purchase.

Keep the system clean. DECK Il is a program that accomplishes most
of its important tasks in real time. This means that DECK Il is adjust-
ing many facets of the audio as playback occurs. For this reason you
should make absolutely sure that your System is as simple as possible.
You should attempt to avoid INITs and background programs which
are always present, doing something behind the scenes. These pro-
grams may consume valuable processor time, which you need for
DECK II. Specifically, environments such as System 7 File Sharing,
Norton DiskLight, Disk Express II, certain virus-checkers, screen
savers, background data compression utilitues, and background
FAX receivers may cause you a host of speed problems, if you run
them while running DECKII. So, for the best DECK II performance
results, keep your System as simple and clean as possible. Apple's
Extension Manager (available on most BBSs)is an elegant tool for
managing your Extensions. It is highly suggested.

Keep MIDI trimmed down to a minimum, and mute tracks you don’t
need during record: DECK IT is an audio recording and mixing
environment that supports simultaneous MIDI playback and recording
(in background sequencers). As such, DECK II puts full emphasis on
audio. If you are attempting to play back extremely intense amounts
of MIDI while recording DECK II tracks, you may run into speed or
signal degradation problems. Although this will not happen in normal
use situations, you may be able to cause problems if you use the MIDI
manager to split playback of 32 tracks (each of which is sending
hundreds of messages per second). If, for some reason, you wish to
play back such a MIDI file, you may wish to filter controller informa-
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tion, or mute some of the MIDI tracks while recording audio tracks.
You will generally not encounter these problems during playback.

Don’t use the MIDI Manager if you don’t have to: Apple’s MIDI
Manager is extremely useful (in fact, necessary) in certain situations. If
you have a MacProteus, or other non-OMS MIDI tone-generating
NuBus card in your Mac, or if you run non-OMS software in the
background, you will need the MIDI Manager (and its PatchBay) to
route MIDI to the card(s). If do not have one of these cards (or a
similar device), don't use the MIDI manager. The MIDI Manager is very
well designed as a routing and timing tool for MIDI-only applications,
but it degrades the overall performance of real time hard disk record-
ing and playback by 20% to 40%. Although DECK II functions quite
well with the MIDI Manager, you will find that the DECK II interface
works more much smoothly when the MIDI Manager is not installed.

Memory Management Hints:

If you receive Disk Too Slow messages or out of memory errors,
remember:

* Onslow disks, use the Memory and Storage preference on the File
menu's Preferences submenu to increase the disk buffer size. This
will increase overall memory required, but will decrease disk read

frequency and put less strain on your drive.

* For better overall program performance, increase the memory @
partition for DECK I by selecting it in the Finder and choosing the
File menu's Get Info command. Then increase the Preferred

memory to the maximum possible. 6000K or higher will improve
overall performance.

* You can always decrease the amount of RAM required by DECK II
by decreasing the Max. play tracks using the Memory and Storage
preference the File menu's Preferences submenu. Disk buffers are
only allocated for play tracks, so decreasing your play track count
will decrease the number of buffers that will be placed in RAM.
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Troubleshooting Hints:
If you are having problems with DECK I, try the following steps:

* If you get a message stating "Problems Initializing Playback
Engine, Audio hardware may not be supported,” throw away the
"Deck Preferences” file in your System folder's Preferences folder.
Then restart DECK II. A new preferences file will be built auto-
matically.

* If you get "Bad F-line" errors or lockups, make absolutely sure
that your SCSI chain is correctly terminated and that each device
has its own SCSI ID number. To test this, unhook ALL EXTER-
NAL SCSI drives and restart DECK II. If DECK II functions
correctly, then you know that your SCSI chain is causing the
problem. You may want to try an active SCSI terminator, rather
than the standard passive type.

* Try not to run any Extensions and Control Panels that you do not
need. If possible, stay away from screen savers, background virus
checkers, Disk Express IT, Norton DiskLight, reminder utilities,
System 'speed enhancers’ and any 'cute’ shareware programs and
public domain Extensions designed to add functionality of in-
crease system speed. These are often untested on serious
Macintosh systems.

* If you have an 840AV or 660AV Macintosh or a Spectral Innova-

tions NuMedia card, use a standard stereo mini-plug in audio
inputs and outputs. DO NOT use a 3/4" (long) stereo mini-plug in

0
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the input. If you have problems with 'scratchy’ sounding audio,
this is because the mini-plugs are not making solid contact. Try
jiggling them, or better yet, lightly squeeze the mini-plug contact
with a pliers to make it fit more snugly into the housing (obviously
this is NOT recommended by Underwriter's Laboratories).

* If you have an 840AV or 660AV Macintosh or a Spectral Innova-
tions NuMedia card, and you encounter a "System Error -754,"
choose the Sound Control Panel and make sure that the Effects are
turned off, and the sample rate is set to 44.1 or 48 kHz (whatever
the current Session is set to).

* If you have a Spectral Innovations NuMedia card, and you hear
noise (light buzzing) every second or so in the audio while record-
ing and playing back, this is due to electrical interference within
your Macintosh. To remedy it, open your Mac and move the
NuMedia board to a different slot, making sure that it is not
touching (or extremely close to) any drive ribbon cables or power
supply connectors.

Recommended Hard Disks

Most standard Macintosh SCSI hard disk drives that meet the 28 ms

access time performance requirement should work well with the
system. However, Digidesign has found that some manufacturers do

not meet their published specifications, or use inefficient software
drivers that slow down the performance of an otherwise adequate disk
mechanism.

The list of recommended hard disks is always being updated, and
Digidesign can supply you with the current list of recommended
drives. (If you are a registered Digidesign customer, contact Digi-
design at 415-688-0600, between 8:30AM and 5:00PM PST.) “Highly
recommended” models have been tested at Digidesign and found to
work very well with the Audiomedia, Sound Tools II and Pro Tools
systems. “Recommended” drives have been reported by users to work
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properly, but have not been subjected to in house worst-case testing
conditions (for example, highly fragmented disks, multiple devices on
the SCSI bus, etc.).

When choosing a disk drive, remember that it is the brand and model
of the drive mechanism that is important, not the brand name of the
reseller /repackager. For example, a APS 1.2 gigabyte external hard
drive could contain any of three different drive mechanisms. Remem-
ber to check the brand name inside the box, not the one on the outside.

Suggested Reading

Audio in Media, Stanley R. Alten, Wadsworth Publishing Company,
Belmont, California, 1986

Principles of Digital Audio, Ken. C. Pohlman, Howard W. Sams and
Company, Indianapolis, Indiana, 1985

Random Access Audio, David Miles Huber, Digidesign, Menlo Park,
California, 1989

Electronic Musician Magazine, P.O. Box 3714, Escondido, California,
92025

Keyboard Magazine, 20085 Stevens Creek, Cupertino, California, 95014
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A Autolocation 55, 199
Automated punch-in/punch-out 59

About DECK Il command 206 Automation 104, 149

Access time 13, 275

Basics 38
Add Audio to Clipboard com- Envelopes 104
mand 208 Fader grouping 129
Add SND to Clipboard com- Mixer states 149
mand 210 Moving fader 149
Adding audio 65 . Real-time mixer 149
Adding soundfiles 46 ‘ Resolution 178
AES/EBU 41 Scene-by-scene 149

Analog-to-digital converter 26 Smoothness 151

Apple Menu Items List 206 | States vs. snapshots 149
Apple MIDI Driver 126 | Automation envelopes 192
Apple’s MIDI Manager 125 | Croatin g and editing 105
Set,uP.’ e Automation pop-up 177
Arc}'flvmg o Automation Status pop-up 190
Aud%o ffeedback doop 24 ' Automation submenu 252
Audio fle formats 36 Automation Thin command 245

Audio hookup i : Automation View pop-up 189
Audio input and outputjacks 11, 12 AV Users 257

Audio Interchange file format 162 ' Axis Resolution pop-up 187

Audio regions 78 . Axis units 84

Auditioning 90 Axis Units pop-up 85, 186

Redefining 87 s ol m
Resizing 88 B

Spotting to time code 114

Background playback 131
Backup devices 41

Begin and end time counters 199
‘begin->" button 57, 60

Bounce Mono command 231
Bounce Stereo command 232

Audiomedia |

Microphone input 24
Audition Selection command 244
Auditioning 90
Authorizing a hard disk 20
Autocue 91
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Bouncing tracks 54, 109, 158
Basics 33

Instructions 158

Number of tracks 159
Phase-accuracy 110, 159

BPM changes 85
C

Capture button 143
Chase Positioning 118, 271
Clear command 226
Click track 134
Clipboard
Adding audio via 66
Clipping 32
Close command 207
Close Window command 263
Compact Audio File command 212
Compact Session command 112, 260
Handle Size 113
Configure Live Video command 271
Configuring DECK 17
Configuring the hardware 17
Constructive recording 36
Constructive signal processing 272
Continuous resynchronization 140
Control value indicator 199
Controllers
Mapping to 129
Copy command 225
Copy Frame command 270
Crossfade shapes 92

Crossfades 91
Custom fade 99
Default fade 98
Deleting 100
Envelope combinations 95
Note about Handle size 101
Cueing 58, 90
Current time 186
Custom Fade command 240
Customer Service 14
Cut command 225

D

DAT
Mixing to 64

DAT Mastering
Basics 40
Decks 42

Data Indicator boxes 186

DECK II
Basic functions 30
Creating a Session 43
Customer service 14
Hardware Requirements 12
Interface 25
New Features 10
Opening a Session 45
Purpose of Use 11
Recording a track 49
Saving a Session 46
Starting up 43
Updates and support 13
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Using with METRO 131 ‘end->’ button 57, 60

Window 45,175 Erasable optical drives 41
DECK II menus 205 Export Movie command 265
Default Fade command 239 Export Session Regions 261

Default fade times 239
Delete Fade command 241

External mixers 23

Demagnify icon 73 F

Deselect command 230 Fade Selection command 234
Destructive Effects submenu 241 Fade shapes 92

Destructive Signal Processing 102 Fader

Destructive signal processing 272 ' Numeric display 180
Digital audio tape 11 ' Fader automation 149
Digital distortion 32 Basics 38

Digital Format 258 Fader grouping 129

Digital formats 41 .~ Fades 91

Digital-to-analog converter 26 | Fast forward 197

Disk buffers 62 i Feedback loop 24

Disk optimization 275 File Menu 206

"Disk to slow” 279 File Sharing 21, 275

Disk Too Slow messages 62 Final mastering to disk 162
Display resolution 86 ' Instructions 163

Dispose MIDI File command 213 Final stereo mixdown
Dispose Movie command 268 Basics 40

Distortion 32, 200 Fit Selection button 73, 184
Dnvg space 192 | Fragmentation 275
Duplicate 102 Free Drive Space indicator 192
Duplicate command 243 G

E
General Preferences 214

Edit Menu 224 Get Movie Info command 269
Edit Mode button 185 Grid 84, 187

Editing tracks 170 Turning on and off 86
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Group Normalize 102, 273 Keyboard shortcuts 83

Group Normalize command 242 L
e Launch Editor command 244
Handle Size 101 Levels Preferences 220
Handle size 113, 261 Library Window 203
Handycam 141 Live Video command 271
Hardware Configuration 257 Load Audio File command 69, 211
Hardware requirements 12 Location times 55, 199
House sync 140 Storing & recalling 55
I Loop (rehearse) mode 56
Loop button 58
Import MIDI File command 213 . Loop mode 198
Import Movie command 263 M
Import Session command 262
Input level 23 Mac System 276
Audiomedia & MediaTime 53 Macintosh IIfx 12
Monitoring 51 Magnify icon 72
Sound Tools II & Pro Tools 179 Manual
Input Level submenu 258 Chapter outlines 15
Input Signal 32 Directions for using 14
Input Type 258 Map Mode 128
Insert After command 228 MediaTime card 119
Insert At command 228 Memory & Storage Preferences 218
Insert Time command 229 METRO 29, 131
Installing the hardware 17 Metronome 134
Inversion 273 . Mic Input 258
Invert 102 MIDI
Invert command 242 Integrating with audio 49
K Problems 29
Purpose 28
Key commands 82, 193 . MIDI and hard disk audio 28
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MIDI Click 134 Multimedia 11

MIDI Driver 126 Multiple Paste After command 227
MIDI File Mute buttons 180
Concerns 276 . Mute MIDI Map command 253

MIDI Manager 125, 277

MIDI Map Faders command 252 N
MIDI Map Mode 128 New audio files 36
MIDI mapping 128 New command 206
MIDI Preferences 223 New Track command 231
MIDI Setup command 246 Non-destructive recording 36
MIDI Window Drawbacks 37
Windows 201 Regaining disk space 38
MIDI window 175 ' Normalization 103, 272
Mix to Disk command 233 l Normalize command 242
Mixdown 162
Mixing part of a Session 163 0
Mixer automation 149 Object mode 78, 185
Mixer state automation 149  OMS 124, 247
Mixer States 200 ’ Configuring 124
Mixer states 152 ! Non-OMS applications 247
Storing and recalling 153 Online command 249
Transition times 156 Open command 207
Mixer window 44, 175, 176 ‘ .
Track number 177 l RS e
Mixing board 23 P @

Mixing board metaphor 29 "
Mixing to DAT 64 Page Setup command 213

Modifier keys 83 i

3 Paste After command 226
Monitor level 51, 61, 77

; Paste At command 226
MoviePack card 119

: : Patch Bay DA 126
Moving fader automation 149 :
Kovins Lk &0 Phase Inversion 273

& Pitch control knob 200
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Placing audio regions 65
Play button 51, 77
Play tracks 90
Playback degradation 26
Playlist Selection pop-up 181
Playlists

Moving and renaming 69
Position at Beginning 87, 254
Position at End command 87, 254
Position to Fit command 254
Powered speakers 24
Pre-amplifier 32
Pre-roll time 144
Preferences submenu 214
Print command 213
Process Menu 230
ProDECK Sessions 34
Pulldown command 250
Punch mode 198
Punch-in/punch-out 59

Instructions 59
Punch-in/punch-outut

Basics 33

Q

QuickTime Menu 263
QuickTime movie
Mastering a final 167
QuickTime movies 116
Audio formats 117
Full-screen, 30 frame movies 119
Importing 116

Sample rates 118

Self-contained 168
QuickTime window 176, 204
Quit command 224

RAM 13

Requirements 13
Range mode 78, 185
Recommended hard disks 279
Record button 51, 77
Record enable buttons 180
Recording

Basics 31
Recording fader motion 149
Redefining audio regions 87
Region Definition tabs 191
Region Info command 243
Removable platter drives 41
Remove command 229
Rename command 230
Renaming tracks 69
Replace command 227
Return-to-zero button 52
Reversal 102,273
Reverse command 242
Revert command 208
Rewind 197

S

S/PDIF 41
Sample rate 27
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Sampling basics 25
Save a Copy as command 208
Save command 207

Slide locator 198
SMPTE Format submenu 247
SMPTE Online command 249

Save Settings as Template 224 ) SMPTE slave driver 140
Scrubbing playback 57, 60 SMPTE Start Frame command 143
Select All command 230 SMPTE Start Time command 248
Selected object 191 SMPTE time code 139

Selected range 191 SMPTE-to-MTC converter 249

Selection Tools Submenu 254 Snap to Grid command 256
Sequencing } Solo buttons 180

METRO 29 Sound command 270
Service 14 Sound Designer I 170
Session End Time command 260 EQ 173

Session files 34 . Switching to 172
Creating new 43 I Warning about editing 173
Opening, saving and closing 45 Waveform updates 173
Session Info command 259 Sound editor
Session Menu 259 Choosing 171
Set Default Fade command 237 Sound Manager 166
Set from Punch Time command 255 ‘ Sound Tools system 9
Set Grid Interval command 256 Soundfiles
Set Nudge Time command 256 Adding 46
Set Poster command 270 Conversion 210
Set Punch Time from command 255 ’ Formats 165
Set Punch Times From command 58 | Spotting audio regions 114
Set Selection command 255 State Transition Time 156, 253
Setting input level 50 Status indicator 199
Shortcuts 83 | Stereo mixdown

Signal-to-noise ratio 12 Basics 40

Size submenu 272 Stop button 51, 78

Slave Settings Preferences 221 Streaming tape drives 42
Slice command 227 Strip Silence command 245
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Suggested reading 280
Support 13, 14
Sync Mode 258
Synchronization 39, 139
Capture button 143
On recording 140
Pre-roll time 144
Tips and tricks 141
To Video
To QuickTime 39
Synchronizing
QuickTime movies 145
Time code with METRO 143

T

Tape counter 196
Tape generations 26
Technical support 14
Tempo 119
Tempo controls 186
Tempo maps 120
Tempo settings 136
Textlabels 75

Menu 205
Throughput 13, 275
Time axis 187
Time code 139
Time signature 119
Time units

Selecting 84
Track Control Area: 187
Track input selector 177
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Track Input Selector pop-up 188
Track Label/Drag area 188
Track names 188
Track Record Enable button 188
Track size 75
Track VU meters 76
Track window 68, 175, 181

Grid 84

Navigation 72

Recording into 75

Track size 75

Waveform drawing 75
Tracks

Moving and renaming 69
Transport buttons 197
Transport window 44, 175, 196
Trigger Sync command 249
Trigger synchronization 140
Troubleshooting 275

U

Undo command 224
Update speed 63
Updates 13

v

View memories

Storing and recalling 74
View Memory buttons 185
Virtual Mix command 234
Virtual Mixing 33, 161
Virtual tracks 89



Visual automation envelopes 104
Volume faders 179
VU meters 181

W

Waveform

Display modes 183
Waveform drawing 75
Waveform editing 191
Waveform Expand/Contract 185
Waveforms

Selecting and editing 79
Windows 175
Windows Menu 263
Work tracks 89, 190
WORM drives 41
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